
Exploring the Seven Books of Bookshelf
The power of Bookshelf puts the vast information of the following seven reference books at your 
fingertips:
-    The American Heritage Dictionary of the English Language, Third Edition
-    Roget's Thesaurus of English Words and Phrases
-    The Columbia Dictionary of Quotations
-    The Concise Columbia Encyclopedia, Third Edition
-    Hammond Atlas of the World
-    The People's Chronology
-    The World Almanac and Books of Facts 1995
To get the most out of Bookshelf, take a little time to explore each book.

Exploring the Dictionary
Exploring the Thesaurus
Exploring the Quotations Book
Exploring the Encyclopedia
Exploring the Atlas
Exploring the Chronology
Exploring the Almanac



Exploring the Dictionary
The following topics describe the special features and organization of the Dictionary and explain how to 
locate its wealth of information.

About   The American Heritage Dictionary  
Getting Acquainted with the Dictionary
Using the Dictionary



About The American Heritage Dictionary
Copyright

The American Heritage Dictionary of the English Language, Third Edition brings you the richness of 
American English with more than 350,000 entries and meanings written in clear, exact language. In 
addition to over 16,000 new words, this edition of The American Heritage Dictionary includes over 500 
Usage Notes; fascinating Regional Notes; a wealth of cross-referenced Synonym Paragraphs; and a 
helpful Pronunciation Key. This comprehensive dictionary offers expanded historical information in more 
than 400 Word History paragraphs and also includes Indo-European Roots that allow you to trace our 
language back 6000 years to its ancestral origins.
Bookshelf enhances the information provided by The American Heritage Dictionary with audio 
pronunciations of words as well as other audio clips, pictures, animations, and video clips.
The first two topics below provide interesting and useful information about The American Heritage 
Dictionary. The last two topics take a fascinating in-depth look at the history of the English language.

"Introduction" from   The American Heritage Dictionary   by Ann H. Soukhanov, Executive Editor  
             Usage in The American Heritage Dictionary:     The Place of Criticism by Geoffrey Nunberg  

A Natural History of English: Language, Culture, and the American Heritage by Lee Pederson
The Indo-European Origin of English by Calvert Watkins

The following topics provide further information about The American Heritage Dictionary as it appears in 
Bookshelf.

Guide to the Dictionary: Conventions Used to Present and Define Words
Guide to Indo-European Roots: Conventions Used to Present and Define Roots

See also
Getting Acquainted with the Dictionary
Using the Dictionary



Getting Acquainted with the Dictionary
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Dictionary is fun and 
easy. In the Dictionary you locate and display information in the Bookshelf Main window. Each definition in
the Dictionary is called an article. Articles are organized alphabetically and you locate them using the 
Tabbed Lists. Individual articles display in the part of the Main window called the Article window. 

The following topics explain the layout and features of the Bookshelf Dictionary:
Guide to the Dictionary Article Window
Guide to the Tabbed Lists

See also
About   The American Heritage Dictionary  
Using the Dictionary



Guide to the Dictionary Article Window
G  LOSSARY  

The Article window is the part of the Bookshelf Main window where you read an individual Dictionary 
definition, or article. Each article in the Dictionary will have some or all of the following components:

Headword - the word or phrase that is defined. The headword is in bold print and is divided into 
syllables by centered dots. If the headword has multiple meanings, it will be followed by a superscript 
number noting the meaning number (for example, see the word "grave"). Each different meaning has its 
own article.

Audio icon 
 - located to the right of the headword. Click it to hear the word pronounced.

Phonetic pronunciation - appears as colored text in parentheses. Click the pronunciation text to
display the Pronunciation Key. You can click words in the Pronunciation Key to hear them pronounced.

Part-of-Speech labels - appear in italics to the right of the phonetic pronunciation. Part-of-
speech labels may also appear throughout the article where other forms of the word are given.

Definition - the definition(s) of the headword. The definition may include some or all of the 
following: inflections, abbreviations, irregular plurals, senses of the word, phrasal verbs, idioms, 
etymologies, undefined forms of the word, illustrative examples, synonyms, antonyms, Usage Notes, 
Regional Notes, and Word Histories.

Cross-references - hot text in the article that is a different color from the phonetic pronunciation. 
Click cross-references to jump to related articles. 

Media - in addition to audio pronunciation of words, some Dictionary articles have other audio 
clips, pictures, animations, and videos. Audio clips, video clips, and animations have a media controller 
for playing the media. You use the media controller to start, pause, and stop media.
Buttons at the bottom of the Dictionary Article window allow you to Copy information from an article; Print
an article; jump Back to articles you've just looked through; and "page" both backward, <Page, and 
forward, >Page, through articles according to their browse order.

 You can also find Print on the File menu and Copy on the Edit menu of the Menu bar.

See also
Guide to the Dictionary: Conventions Used to Present and Define Words
Guide to Indo-European Roots: Conventions Used to Present and Define Roots
Using the Dictionary
Guide to the Tabbed Lists



Using the Dictionary
G  LOSSARY  

There are several ways to use the Bookshelf Dictionary to locate definitions, or articles. You can work 
directly in the Dictionary by opening it and using the Tabbed Lists. You can also display Dictionary 
definitions for words in any other Bookshelf book. In addition, you can access the Bookshelf Dictionary 
from other Windows applications by using the handy QuickShelf toolbar. Once you've located the 
definition you want, you can use the convenient Pronunciation Key to help you learn correct word 
pronunciations.

The following topics explain how to locate Dictionary articles and use the Dictionary 
Pronunciation Key:

Locating Articles Using the Tabbed Lists
Locating Definitions for Words in Any Bookshelf Article
Using QuickShelf to Access Bookshelf from Other Applications
Opening and Using the Pronunciation Key

See also
About   The American Heritage Dictionary  
Getting Acquainted with the Dictionary



Locating Definitions for Words in Any Bookshelf Article
G  LOSSARY  

You can obtain a definition for any word in any article, no matter which book you're in.
To locate the definition of a word in any Bookshelf article

Double-click the word you want defined.
-Or-
1. Right-click the word.

The shortcut menu opens.
2. On the shortcut menu, click Define.

The definition from the Dictionary displays in a pop-up box.
If the word has more than one definition, the Definition box will have a bar with arrow buttons that tells 
you how many definitions exist. Click the arrows to see additional definitions.

To close the Definition box, do one of the following:
Click the Close button in the upper-left corner of the Definition box.
Click anywhere outside the box.
Press any key.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Opening and Using the Pronunciation Key
G  LOSSARY  

Bookshelf has a Pronunciation Key that you can display from any Dictionary article. Each symbol in the 
Key has one or more words that illustrate how the symbol is pronounced. The words are hot. Click them 
to hear the word example pronounced.
To open and use the Pronunciation Key
1. In any Dictionary article, click the phonetic pronunciation (the word in parentheses next to the bold 

headword).
The Pronunciation Key displays.

2. Click any pronunciation word in the Key to hear the word pronounced.
To close the Pronunciation Key, do any of the following:

Click the Close button at the upper-left corner of the Pronunciation Key box.
Click anywhere outside the pop-up box.
Press any key.



Exploring the Thesaurus
The following topics describe the special features and organization of the Thesaurus and explain how to 
locate its wealth of information.

About Longman's   Roget  '  s Thesaurus  
Getting Acquainted with the Thesaurus
Using the Thesaurus



About Longman's Roget's Thesaurus
Copyright

Longman's original Roget's Thesaurus of English Words and Phrases is a vast resource of words and 
phrases classified according to underlying ideas and meaning. Each entry contains many more related 
terms than the typical thesaurus. This indispensable companion for writers and speakers will help you 
expand your vocabulary, improve precision of expression, avoid repetition, or simply recall a word that 
has slipped your mind. First published in 1852 by England's Longman publishers, this complete 
unabridged edition is fully revised to reflect the English language of the 1990s.
The words and phrases in the Longman version of Roget's Thesaurus are categorized into six classes. 
Dr. Peter Mark Roget developed this classification system in the 1800s for the first thesaurus, and his 
system has proven infinitely capable of absorbing new concepts and new vocabulary. Dr Roget used a 
logical progression from abstract concept, through the material universe, to mankind itself, culminating in 
what he saw as mankind's highest achievements: morality and religion.
The first three classes cover the external world while the last three deal with the internal world of human 
beings. The following topic presents Roget's six Classes and their corresponding Sections.

Roget's Plan of Classification
An in-depth discussion of Roget's Plan, as well as the way Thesaurus entries appear in Bookshelf, is 
presented in the following topic:

Understanding Roget's Thesaurus

See also
Getting Acquainted with the Thesaurus
Using the Thesaurus



Getting Acquainted with the Thesaurus
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Thesaurus is fun and 
easy. In the Thesaurus you locate and display information in the Bookshelf Main window. Each Thesaurus
entry is called an article. Articles are organized alphabetically and you locate them using the Tabbed Lists.
Individual articles display in the part of the Main window called the Article window. 

The following topics explain the layout and features of the Bookshelf Thesaurus:
Guide to the Thesaurus Article Window
Guide to the Tabbed Lists

See also
About Longman's   Roget  '  s Thesaurus  
Using the Thesaurus



Guide to the Thesaurus Article Window
G  LOSSARY  

The Article window is the part of the Main window where you read an individual Thesaurus article. Each 
Thesaurus article has the same layout and includes the following components:

Class, Section, and Head - the bold words in small print at the top of the article that are 
separated by colons. These words and/or phrases indicate the Class and Section into which the Keyword 
fits in Roget's Plan of Classification, as well as the Head under which the Keyword falls.

Keyword - the large bold word preceding the part of speech label. The words in the body of the 
article are related in idea or meaning to this Keyword. In some cases, the Keyword and the Head are the 
same.

Part-of-Speech label - the word in parentheses to the right of the Keyword. The Keyword and all 
words in the article body are this same part of speech.

Article body - groups of words that are related to the Keyword in meaning or idea.
Cross-references - colored text that is hot. Click a cross-reference to jump to the article for that 

word. Cross-references are other Keywords. 
Buttons at the bottom of the Thesaurus Article window allow you to Copy information from an article; 
Print an article; jump Back to articles you've just looked through; and "page" both backward, <Page, and 
forward, >Page, through articles according to their browse order.
The Thesaurus also has an Outline button that displays Roget's Plan of Classification. When you click 
the Outline button, the Outline box opens showing where the article's Keyword fits in Roget's Plan.

 You can also find Print on the File menu, Copy on the Edit menu, and Outline on the Tools menu 
of the Menu bar.

See also
Roget's Plan of Classification
Using the Thesaurus
Guide to the Tabbed Lists



Using the Thesaurus
G  LOSSARY  

There are several ways to use the Bookshelf Thesaurus to locate entries, or articles. You can work 
directly in the Thesaurus by opening it and using the Tabbed Lists. You can locate articles under a 
particular Head from the Thesaurus Outline. You can also access Thesaurus information for words in any 
other Bookshelf book. In addition, you can access the Bookshelf Thesaurus from other Windows 
applications by using the handy QuickShelf feature.

The following topics explain how to locate Thesaurus articles:
Locating Articles Using the Tabbed Lists
Locating Thesaurus Articles While in Other Bookshelf Books
Using QuickShelf to Access Bookshelf from Other Applications
Using the Thesaurus Outline

See also
About Longman's   Roget's Thesaurus  
Getting Acquainted with the Thesaurus



Locating Thesaurus Articles While in Other Bookshelf Books
G  LOSSARY  

While reading articles in other books, you can access the Thesaurus to obtain synonyms and related 
meanings for words in the article.
To locate Thesaurus articles while in other Bookshelf books
1. Right-click any word in the Article window.

The shortcut menu opens.
2. On the shortcut menu, click Find in.

A menu displays listing All Books and each of the seven individual books.
3. Click Thesaurus.

Bookshelf performs a full-text search through all Thesaurus articles. 
The Thesaurus opens with the Find Tab displayed. The Find list shows all Thesaurus articles that 
contain the word. The first article on the list is automatically displayed in the Article window, with all 
occurrences of the selected word highlighted.

4. Click any title in the Find list to display that article in the Article window.
To return to the article you were reading in the other book

Click the Back button at the bottom of the Article window. You may need to click several times 
depending on the number of Thesaurus articles you opened.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Using the Thesaurus Outline
G  LOSSARY  

The Thesaurus has an Outline that displays all levels of Roget's Plan of Classification and shows where 
each Keyword fits in relation to the rest of the Plan. The levels in the Outline expand and collapse so that 
you can see the Head, Section, and Class for each Keyword, as well as other Keywords that fall under 
the same Head. Understanding Roget's Plan, and therefore the Thesaurus Outline, requires some time 
and a little patience. Before using the Outline, it would be helpful to read the following Help topics:

Roget's Plan of Classification
Guide to the Thesaurus Article Window

To open the Thesaurus Outline
In any open Thesaurus article, click the Outline button at the bottom of the Article window or 

choose Outline from the Tools menu.
The Outline box opens.
In the box you'll see a list of words preceded by either a plus sign (+), minus sign (-), or bullet. The 
word with the minus sign is the Head for the Keyword in the open article. The words preceded by a 
bullet listed beneath the Head are all of its Keywords, among which is the Keyword in the open article.
Use the scroll bar to move up and down the Outline. The words above the Head preceded by a plus 
sign are other Heads within a particular Section. All the Heads fall under a particular Section, which in 
turn falls under a particular Class. Each Class, Section, and Head can be expanded or collapsed in 
order to show the various relationships in the overall Plan of Classification.

To expand or collapse the levels of the Thesaurus Outline
Click any plus sign to expand the item.

When an item is expanded, the plus sign becomes a minus sign. When you expand a Class, you will 
see all the Sections for that Class. When you expand a Section, you will see all the Heads for that 
Section. When you expand a Head, you will see all the Keywords (designated by a bullet) for that 
Head. 

Click any minus sign to collapse the item.
The minus sign becomes a plus sign. If you were to collapse every minus sign in the Outline, you 
would be left with the six Classes of Roget's Plan. 

Click any Keyword (designated by a bullet) to display that article in the Article window.
To close the Outline box, do any of the following:

Click the Close button at the upper-left corner of the Outline box.
Click anywhere outside the box.
Press any key.

See also
Understanding Roget's Thesaurus



Exploring the Quotations Book
The following topics describe the special features and organization of the Quotations book and explain 
how to locate its wealth of information.

About   The Columbia Dictionary of Quotations  
Getting Acquainted with the Quotations Book
Using the Quotations Book



About The Columbia Dictionary of Quotations
Copyright

The Columbia Dictionary of Quotations contains more than 18,000 lively and thought-provoking remarks, 
witticisms, judgments, and observations on 1,500 subjects that reflect the range of human experience. 
The quotations in this collection were spoken or written by both the famous and the forgotten--figures 
modern as well as old--who collectively constitute the shapers of our modern cultural landscape. These 
memorable, funny, or profound quotations were chosen not for their familiarity but for their relevance in 
the 1990s.
Bookshelf enhances The Columbia Dictionary of Quotations with pictures and audio clips of some of the 
people whose quotes are presented.
The following article appears in the print version of The Columbia Dictionary of Quotations. Written by 
Robert Andrews, who collected and compiled the quotations that make up this anthology, this introduction 
provides insight into how and why the quotations in this anthology were selected.

"Introduction" from   The Columbia Dictionary of Quotations   by Robert Andrews  

See also
Getting Acquainted with the Quotations Book
Using the Quotations Book



Getting Acquainted with the Quotations Book
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Quotations book 
becomes fun and easy. In the Quotations book, you locate and display information in the Bookshelf Main 
window. Each quotation is called an article. Articles are organized alphabetically and you locate them 
using the Tabbed Lists. Individual articles display in the part of the Main window called the Article window. 

The following topics explain the layout and features of the Bookshelf Quotations book:
Guide to the Quotations Book Article Window
Guide to the Tabbed Lists

See also
About   The Columbia Dictionary of Quotations  
Using the Quotations Book



Guide to the Quotations Book Article Window
G  LOSSARY  

The Article window is the part of the Main window where you read an individual quote, or article. Each 
article in the Quotations book will have some or all of the following components:

Subject - the word(s) at the top of the window in bold print tells you what subject the quote is 
about.

Quotation - the text of the actual quote.
Attribution - information about the author and source of the quotation, including the author's 

name, birth/death dates, description of the author, and source from which the quote was taken. Titles of 
books and periodicals are in italics. 

Media - some Quotations articles are enhanced with a picture of the person who authored it 
and/or an audio clip of the person speaking the quote. Audio clips have a media controller for playing the 
quotation. You use the media controller to start, pause, and stop the clip.
Buttons at the bottom of the Quotations book Article window allow you to Copy information from an 
article; Print an article; jump Back to articles you've just looked through; and page both backward, 
<Page, and forward, >Page, through articles according to their browse order.
The Quotations book also has an Outline button that displays a list of the book's other quotations on the 
same subject. Click any article in the list to display that article in the Article window.

 You can also find Print on the File menu, Copy on the Edit menu, and Outline on the Tools menu 
of the Menu bar.

See also
Using the Quotations Book
Guide to the Tabbed Lists



Using the Quotations Book
G  LOSSARY  

There are several ways to use the Bookshelf Quotations book to locate quotes, or articles. You can work 
directly in the Quotations book by opening it and using the Tabbed Lists. You can locate quotes on a 
particular subject by using the Quotations book Outline. You can also access quotations that contain a 
particular word, phrase, or number found in any other Bookshelf book. In addition, you can access the 
Bookshelf Quotations book from other Windows applications by using the handy QuickShelf feature.

The following topics explain how to locate Quotations:
Locating Articles Using the Tabbed Lists
Locating Quotations While in Other Bookshelf Books
Using QuickShelf to Access Bookshelf from Other Applications
Using the Quotations Book Outline

See also
About   The Columbia Dictionary of Quotations  
Getting Acquainted with the Quotations Book



Locating Quotations While in Other Bookshelf Books
G  LOSSARY  

While reading articles in other books, you can access the Quotations book to obtain quotations that 
contain a selected word, name, number, or phrase.
To locate quotations while in other Bookshelf books
1. Right-click any selected word, name, number, or phrase in the Article window.

The shortcut menu opens.
2. On the shortcut menu, click Find in.

A menu displays listing All Books and each of the seven individual books.
3. Click Quotations.

Bookshelf performs a full-text search through all Quotations articles. 
The Quotations book opens with the Find Tab displayed. The Find list shows all Quotations articles that
contain the selected item. The first article on the list is automatically displayed in the Article window, 
with all occurrences of the selected item highlighted.

4. Click any title in the Find list to display that article in the Article window.
To return to the article you were reading in the other book

Click the Back button at the bottom of the Article window.
You may need to click several times depending on the number of Quotation articles you opened.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Using the Quotations Book Outline
G  LOSSARY  

The Quotations book has an Outline that lists all the subjects into which the quotes are categorized. 
Under each subject you can see a list of all quotations on that subject.
To open and use the Quotations book Outline
1. In any open Quotations article, click the Outline button at the bottom of the Article window or choose 

Outline from the Tools menu.
The Outline box opens. In the box you'll see a subject preceded by a minus sign (-). Under the subject 
is a list of authors whose quotes on the subject are included in Bookshelf. Each author's name is 
preceded by a bullet. 

2. Click any item preceded by a bullet to display that quote in the Article window.
3. Click the minus sign preceding the subject to collapse the list of authors and open a complete list of all 

subjects for which the Quotations book has quotes. Each subject is preceded by a plus sign (+).
4. Click the plus sign preceding any subject to display its list of authors. 
To close the Outline box, do any of the following:

Click the Close button at the upper-left corner of the Outline box.
Click anywhere outside the box.
Press any key.



Exploring the Encyclopedia
The following topics describe the special features and organization of the Encyclopedia and explain how 
to locate its wealth of information.

About   The Concise Columbia Encyclopedia  
Getting Acquainted with the Encyclopedia
Using the Encyclopedia



About The Concise Columbia Encyclopedia
Copyright

The Concise Columbia Encyclopedia, Third Edition puts a world of knowledge at your fingertips with 
17,000 entries on a wide range of subjects. Its short articles allow you to check facts quickly, but you can 
also pursue a train of thought in many of the articles by means of a handy system of cross-references. 
Unlike other similar works, The Concise Columbia Encyclopedia is created in the United States for the 
reference needs of American readers. With the authority of a huge team of academic specialists, the Third
Edition offers the most up-to-date information found in any one-volume encyclopedia.
Bookshelf enhances the information provided by The Concise Columbia Encyclopedia with pictures, 
maps, charts and tables, audio clips, animations, and video clips.

 Although abbreviations have been kept to a minimum, some have been adopted to save space. 
They usually appear in special constructions designed to convey important information at a glance. 
Common abbreviations include those for compass points, the months of the year, the states of the United 
States, and such words as Corporation (Corp.) and graduated (grad.). Other, less familiar abbreviations 
are defined in:

Abbreviations Used in the Encyclopedia

See also
Getting Acquainted with the Encyclopedia
Using the Encyclopedia



Getting Acquainted with the Encyclopedia
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Encyclopedia becomes 
fun and easy. In the Encyclopedia, you locate and display information in the Bookshelf Main window. 
Each entry in the Encyclopedia is called an article. Articles are organized alphabetically and you locate 
them using the Tabbed Lists. Individual articles display in the part of the Main window called the Article 
window. 

The following topics explain the layout and features of the Bookshelf Encyclopedia:
Guide to the Encyclopedia Article Window
Guide to the Tabbed Lists

See also
About   The Concise Columbia Encyclopedia  
Using the Encyclopedia



Guide to the Encyclopedia Article Window
G  LOSSARY  

The Article window is the part of the Main window where you read an individual Encyclopedia article. 
Each article in the Encyclopedia will have some or all of the following components:

Article head - the word, name, or phrase in bold print that tells you what the article is about.
For most biographical articles, the person's name is listed with the last name first, followed by the first 
name, then middle name (example: Kennedy, John Fitzgerald). Exceptions to this rule are made for 
some figures from history and folklore (examples: John Henry, Judas Iscariot) and some pseudonyms 
of authors.
Japanese and Chinese names are listed in the traditional order, surname first, without a comma 
(example: the Japanese author Yukio Mishima is listed as "Mishima Yukio").
Americans of Japanese descent are listed in the Western style (example: American sculptor Isamu 
Noguchi is listed as "Noguchi, Isamu").

Audio icon 
 - in some articles, an Audio icon is located to the right of the article head. Click it to hear the word 

pronounced. There are also Audio icons in the body of some of the articles. Click the icon to hear a 
musical example. (To stop a musical example, click the Audio icon again or press ENTER.)

Article Body - the text that provides information about the article head.
Cross-references - colored text in the article body that is hot. Click cross-references to jump to 

related Encyclopedia articles.
Media - some Encyclopedia articles are enhanced with pictures, audio clips, animations, and 

video clips. Audio clips, video clips, and animations have a media controller for playing the media. You 
use the media controller to start, pause, and stop media.
Buttons at the bottom of the Encyclopedia Article window allow you to Copy information from an article; 
Print an article; jump Back to articles you've just looked through; and page both backward, <Page, and 
forward, >Page, through articles according to their browse order.
The Encyclopedia also has a See Also button that displays a list of suggested articles for further reading. 
Click any article in the list to display that article in the Article window. If no such list exists for a particular 
article, this button is dimmed.

 You can also find Print on the File menu, Copy on the Edit menu, and See Also on the Tools 
menu of the Menu bar.

See also
Using the Encyclopedia
Guide to the Tabbed Lists



Using the Encyclopedia
G  LOSSARY  

There are several ways to use the Bookshelf Encyclopedia to locate articles. You can work directly in the 
Encyclopedia by opening it and using the Tabbed Lists. You can also access Encyclopedia articles that 
contain a particular word, phrase, or number found in any other Bookshelf book. In addition, you can 
access the Bookshelf Encyclopedia from other Windows applications by using the handy QuickShelf 
feature.

The following topics explain how to locate Encyclopedia articles:
Locating Articles Using the Tabbed Lists
Locating Encyclopedia Articles While in Other Bookshelf Books
Using QuickShelf to Access Bookshelf from Other Applications

See also
About   The Concise Columbia Encyclopedia  
Getting Acquainted with the Encyclopedia



Locating Encyclopedia Articles While in Other Bookshelf Books
G  LOSSARY  

While reading articles in other books, you can access the Encyclopedia to obtain articles that contain a 
selected word, name, number, or phrase.
To locate Encyclopedia articles while in other Bookshelf books
1. Right-click any selected word, name, number, or phrase in the Article window.

The shortcut menu opens.
2. On the shortcut menu, click Find in.

A menu displays listing All Books and each of the seven individual books.
3. Click Encyclopedia.

Bookshelf performs a full-text search through all Encyclopedia articles. 
The Encyclopedia opens with the Find Tab displayed. The Find list shows all Encyclopedia articles that
contain the selected item. The first article on the list is automatically displayed in the Article window, 
with all occurrences of the selected item highlighted.

4. Click any title in the Find list to display that article in the Article window.
To return to the article you were reading in the other book

Click the Back button at the bottom of the Article window.
You may need to click several times depending on the number of Encyclopedia articles you opened.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Exploring the Atlas
The following topics describe the special features and organization of the Atlas and explain how to locate 
its wealth of information.

About the   Hammond Atlas of the World  
Getting Acquainted with the Atlas
Using the Atlas



About the Hammond Atlas of the World
Copyright

The Hammond Atlas of the World contains up-to-date political and topographic maps of the world's 
continents and countries, as well as the regions of the United States. These super high-definition maps 
are balanced, accurate, and visually pleasing. 

Bookshelf enhances the information provided by the Hammond Atlas with audio pronunciations of country
and U.S. state names, full-color examples of country and state flags, and audio clips of the national 
anthems for many of the world's nations. The Bookshelf Atlas is also conveniently linked to the 
Encyclopedia and the Almanac, so access to detailed information about a particular region is only a click 
away.
The following topics provide interesting insight into the general history of maps, as well as the art and 
science of mapmaking today.

Evolution of Cartography
Map Projections

See also
Getting Acquainted with the Atlas
Using the Atlas



Getting Acquainted with the Atlas
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Atlas becomes fun and 
easy. In the Atlas, you locate and display information in the Bookshelf Main window. Maps in the Atlas are 
called articles and you locate them using the Tabbed Lists. Individual articles display in the part of the 
Main window called the Article window. 

The following topics explain the layout and features of the Bookshelf Atlas:
Guide to the Atlas Article Window
Guide to the Tabbed Lists

See also
About the   Hammond Atlas of the World     
Using the Atlas



Guide to the Atlas Article Window
G  LOSSARY  

The Article window is the part of the Main window where you display and view Atlas maps. The maps in 
the Atlas are combined topographic and political maps. Each map in the Atlas is called an article. The 
Atlas is organized in three levels of successively detailed maps.

Level one is the World map showing the continents and oceans of the world.
Level two has maps of continents, large islands, and major regions. Several of the maps at this 

level are country maps, such as the United States, Canada, and Mexico, showing major cities.
Level three has maps of countries (with cities) and regions of the United States (with states and 

cities).
Each map in the Atlas will have some or all of the following components:

Article Head - the words in bold print at the top of the window that tell you what 
continent/country/region the map details.

Map - the map of the indicated area. The indicated area is highlighted and has detailed 
topography and bold place names. In most maps, the highlighted area is surrounded by adjacent 
geography that is "grayed out."

Hot place names and areas - the country and state names in the highlighted portion of a map 
and the surrounding grayed out area of a map are hot. Clicking a country or state name within the 
highlighted area will display the Information box for that country or state. Clicking in the grayed out area 
will display the map for that particular place.

Legend - some maps have a legend with a scale in both miles and kilometers.
Buttons at the bottom of the Atlas Article window allow you to Copy a map; Print a map; jump Back to 
maps you've just looked through; and page both backward, <Page, and forward, >Page, in a logical order
through maps.
The Atlas also has a Zoom Out or Zoom In button, depending on what is open in the Article window. 
When you first open the Atlas to its Contents screen, the button is Zoom In. Click the Zoom In button to 
display the World map. When a map is displayed in the Article window, the button is Zoom Out. Click the 
Zoom Out button to display an "expanded-view" map that includes the area highlighted in the currently 
open map. If no such map exists, the Zoom Out button is dimmed.

 You can also find Print on the File menu, Copy on the Edit menu, and Zoom Out on the Tools 
menu of the Menu bar.

See also
Using the Atlas
Guide to the Tabbed Lists



Using the Atlas
G  LOSSARY  

There are several ways to use the Bookshelf Atlas to locate maps, or articles. You can work directly in the 
Atlas by opening it and using the Tabbed Lists. Also, when you are reading articles in other Bookshelf 
books, you can access maps for many of the places mentioned. In addition, you can access the 
Bookshelf Atlas from other Windows applications by using the handy QuickShelf feature.

Along with the maps, the Atlas provides additional information about countries and U.S. states via its 
Flags feature and Information boxes.

The following topics explain how to locate Atlas articles and use special Atlas features:
Locating Articles Using the Tabbed Lists
Locating Atlas Articles While in Other Bookshelf Books
Using QuickShelf to Access Bookshelf from Other Applications
Using the Flags Feature
Using the Atlas Zoom Button
Opening and Using the Atlas Information Box

See also
About the   Hammond Atlas of the World  
Getting Acquainted with the Atlas



Locating Atlas Articles While in Other Bookshelf Books
G  LOSSARY  

While reading articles in other books, you can access the Atlas in order to view maps that contain a 
specific place name.
To access Atlas maps while in other Bookshelf books
1. Right-click any place name in the Article window.

The shortcut menu opens.
2. On the shortcut menu, click Find in.

A menu displays listing All Books and each of the seven individual books.
3. Click Atlas.

Bookshelf performs a full-text search through all Atlas articles. 
The Atlas opens with the Find Tab displayed. The Find list shows all Atlas maps that contain the 
selected place name. The first map on the list is automatically displayed in the Article window, with the 
place name highlighted.

4. Click any title in the Find list to display that map in the Article window.
To return to the article you were reading in the other book

Click the Back button at the bottom of the Article window.
You may need to click several times depending on the number of Atlas articles you opened.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Using the Flags Feature
G  LOSSARY  

When the Atlas is open, you can use the Flags feature to see a country or U.S. state flag. You can also 
copy any flag to the Clipboard in order to paste it into another application.
To open the Flags feature
1. Open the Atlas.
2. From the Tools menu, choose Flags.

The Flags dialog box opens.
To display a flag
1. In the Flags text box, type the name of the country or state whose flag you want to see.

The alphabetical list will scroll to the name as you type.
-Or-
Use the scroll bar to browse through the list to locate the country or state name.

2. Click a country or state name in the list.
-Or-
If the name you want is at the top of the list, click the Show button or press ENTER.
The flag displays.

To copy a flag to the Clipboard
With the flag you want to copy displayed in the Flags dialog box, click the Copy Flag button.

The flag copies to the Clipboard. You can now paste the flag into another application.
To close the Flags box, do any of the following:

Click the Close button.

Click anywhere outside the Flags dialog box.

Double-click the Control-menu box in the upper-left corner of the Flags dialog box or press ALT+ 
F4.

Click the Control-menu box to open the Control menu, then click Close.

See also
Opening and Using the Atlas Information Box



Using the Atlas Zoom Button
G  LOSSARY  

When the Atlas is open, there is a Zoom button at the bottom of the Article window. When the Atlas first 
opens to its Contents screen, the button is a Zoom In button. Click the Zoom In button to display the world
map in the Article window.
When any map is open in the Article window, the button is a Zoom Out button. Click the Zoom Out button,
or choose Zoom Out from the Tools menu, to display an expanded-view map of the area currently 
displayed in the Article window. For example, if the map of the New England states is open in the Article 
window, clicking Zoom Out will display the map of the entire United States. If there is no expanded-view 
map available for the open map, the Zoom Out button is dimmed.



Opening and Using the Atlas Information Box
G  LOSSARY  

When an Atlas map is displayed in the Article window, you can open an Information box for any country or
U.S. state in the highlighted area of the map. The Information box has a picture of the country or state flag
and a Copy Flag icon for copying the flag to the Clipboard. Many Information boxes have an Audio icon 
for hearing the place name pronounced and/or an icon for playing a country's national anthem. There are 
also icons for the Encyclopedia and Almanac that you can click to display articles from each book about 
the particular country or state.
To open and use the Information dialog box
1. In any Atlas map, click a country name or U.S. state name.

The Information box for that country or state opens.
2. Do any of the following:

 Click the pronunciation Audio icon to hear the place name pronounced.

 Click the anthem Audio icon to play the country's national anthem. (To stop an anthem, click the 
Audio icon again or close the Information box.)

 Click the Copy Flag icon to copy the flag to the Clipboard.

 Click the Encyclopedia book icon to replace the contents of the Information box with an 
Encyclopedia article about the country or state.

 Click the Almanac book icon to replace the contents of the Information box with an Almanac 
article about the country or state.
To close the Information dialog box, do any of the following:

Click the Close button in the upper-left corner of the box.

Click anywhere outside the Information box.

Press any key.

See also
Using the Flags Feature



Exploring the Chronology
The following topics describe the special features and organization of the Chronology and explain how to 
locate its wealth of information.

About   The People's Chronology  
Getting Acquainted with the Chronology
Using the Chronology



About The People's Chronology
Copyright

The People's Chronology is a social/historical compendium that documents events from 3 million years 
B.C. through 1994. Covering 30 distinct areas of human endeavor in more than 35,000 entries, The 
People's Chronology provides concise information about the milestones that have occurred throughout 
the ages. This indispensable reference work is both an at-a-glance portrait of the world and a chronicle of 
the people and events that have shaped it.

Bookshelf enhances the information provided by The People's Chronology with pictures, audio clips, 
animations, and video clips.

Each entry in The People's Chronology falls under one of the following categories:
Agriculture Literature
Architecture Marine Resources
Art Medicine
Communications and Media Music
Consumer Protection Nutrition
Crime Photography
Economics, Finance, and Retailing Political Events
Education Population
Energy Religion
Environment Science
Everyday Life Sports
Exploration and Colonization Technology
Food Availability Theater and Film
Food and Drink Tobacco
Human Rights and Social Justice Transportation

See also
Getting Acquainted with the Chronology
Using the Chronology



Getting Acquainted with the Chronology
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Chronology becomes fun
and easy. In the Chronology, you locate and display information in the Bookshelf Main window. Each 
Chronology entry is called an article. Articles are organized alphabetically and you locate them using the 
Tabbed Lists. Individual articles display in the part of the Main window called the Article window. 

The following topics explain the layout and features of the Bookshelf Chronology:
Guide to the Chronology Article Window
Guide to the Tabbed Lists

See also
About   The People's Chronology     
Using the Chronology



Guide to the Chronology Article Window
G  LOSSARY  

The Article window is the part of the Main window where you read an individual Chronology entry, or 
article. Each article in the Chronology will have some or all of the following components:

Category and year - in bold print at the top of the window. (See About   The People's Chronology   
for a complete list of the 30 categories.) 

Article body - the text detailing the event.

Cross-references - colored hot text in the article body. Click cross-references to jump to related 
Chronology articles.

Media - some Chronology articles are enhanced with pictures, audio clips, animations, or video 
clips. Audio clips, video clips, and animations have a media controller for playing the media. You use the 
media controller to start, pause, and stop audio and video clips.
Buttons at the bottom of the Chronology Article window allow you to Copy information from an article; 
Print an article; jump Back to articles you've just looked through; and page both backward, <Page, and 
forward, >Page, through articles according to their browse order.

 You can also find Print on the File menu and Copy on the Edit menu of the Menu bar.

See also
Using the Chronology
Guide to the Tabbed Lists



Using the Chronology
G  LOSSARY  

There are several ways to use the Bookshelf Chronology to locate entries, or articles. You can work 
directly in the Chronology by opening it and using the Tabbed Lists. You can also access Chronology 
articles that contain a particular word, phrase, or number found in any other Bookshelf book. In addition, 
you can access the Bookshelf Chronology from other Windows applications by using the handy 
QuickShelf feature.
The following topics explain how to locate Chronology articles:

Locating Articles Using the Tabbed Lists
Locating Chronology Articles While in Other Bookshelf Books
Using QuickShelf to Access Bookshelf from Other Applications

See also
About   The People's Chronology  
Getting Acquainted with the Chronology



Locating Chronology Articles While in Other Bookshelf Books
G  LOSSARY  

While reading articles in other books, you can access the Chronology to obtain articles that contain a 
selected word, name, number, or phrase.
To locate Chronology articles while in other Bookshelf books
1. Right-click any selected word, name, number, or phrase in the Article window.

The shortcut menu opens.
2. On the shortcut menu, click Find in.

A menu displays listing All Books and each of the seven individual books.
3. Click Chronology.

Bookshelf performs a full-text search through all Chronology articles. 
The Chronology opens with the Find Tab displayed. The Find list shows all Chronology articles that 
contain the selected item. The first article on the list is automatically displayed in the Article window, 
with all occurrences of the selected item highlighted.

4. Click any title in the Find list to display that article in the Article window.
To return to the article you were reading in the other book

Click the Back button at the bottom of the Article window.
You may need to click several times depending on the number of Chronology articles you opened.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Exploring the Almanac
The following topics describe the special features and organization of the Almanac and explain how to 
locate its wealth of information.

About   The World Almanac and Books of Facts 1995  
Getting Acquainted with the Almanac
Using the Almanac



About The World Almanac and Book of Facts 1995
Copyright

The World Almanac and Book of Facts 1995 is a general reference book of statistical data, contemporary 
facts, geographic information, and trivia that provides up-to-date, reliable information on people, places, 
and events in the United States and throughout the world. The entries in The World Almanac are 
organized into chapters. Each chapter is divided into categories based on a wide variety of subjects. Most
categories are further divided into sub-categories of information.
Bookshelf enhances the information provided by The World Almanac and Book of Facts 1995 with 
pictures, charts, graphs, maps, and calendars, as well as a number of informative animations and video 
clips. Bookshelf divides Almanac articles into the following eight chapters:
Arts & Media Science & Technology
Chronology Sports
Nations of the World The United States
People World History

See also
Getting Acquainted with the Almanac
Using the Almanac



Getting Acquainted with the Almanac
G  LOSSARY  

Once you understand the layout and features you see on your screen, using the Almanac becomes fun 
and easy. In the Almanac, you locate and display information in the Bookshelf Main window. Each 
Almanac entry is called an article. Articles are organized alphabetically and you locate them using the 
Tabbed Lists. Individual articles display in the part of the Main window called the Article window. 

The following topics explain the layout and features of the Bookshelf Almanac:
Guide to the Almanac Article Window
Guide to the Tabbed Lists

See also
About   The World Almanac and Books of Facts 1995  
Using the Almanac



Guide to the Almanac Article Window
G  LOSSARY  

The Article window is the part of the Main window where you read an individual Almanac entry, or article. 
Each article in the Almanac will have some or all of the following components:

Category - word(s) in bold print at the top of the window that indicate the subject category of the 
article's information. Each category belongs to one of the Almanac's eight main chapters: Arts & Media, 
Chronology, Nations of the World, People, Science & Technology, Sports, The United States, or World 
History.

Sub-category - words in bold print between the category and the article title. Not all articles have 
a sub-category. 

Article title - words in large, bold print that tell what the article is about. 

Asterisks and superscript numbers - some article titles and headings in the body of articles 
have a hot asterisk or superscript number. Click the asterisk or number to display a footnote containing a 
definition or additional information.

Article body - the article information. Articles with tables include source information. The names 
of books and periodicals are italicized.

Media - some Almanac articles are enhanced with charts, graphs, maps, calendars, animations, 
and video clips. Video clips and animations have a media controller for playing the media. You use the 
media controller to start, pause, and stop media.
Buttons at the bottom of the Almanac Article window allow you to Copy information from an article; Print 
an article; jump Back to articles you've just looked through; and page both backward, <Page, and 
forward, >Page, through articles according to their browse order.
The Almanac also has an Outline button that displays the Almanac's chapter and category organization. 
When you click the Outline button, the Outline box opens showing where the article fits in the 
chapter/category/sub-category organization. 

 You can also find Print on the File menu, Copy on the Edit menu, and Outline on the Tools 
menu of the Menu bar.

See also
Using the Almanac
Guide to the Tabbed Lists



Using the Almanac
G  LOSSARY  

There are several ways to use the Bookshelf Almanac to locate entries, or articles. You can work directly 
in the Almanac by opening it and using the Tabbed Lists. You can locate articles in a particular category or
sub-category by using the Almanac Outline. You can also access Almanac articles that contain a 
particular word, phrase, or number found in any other Bookshelf book. In addition, you can access the 
Bookshelf Almanac from other Windows applications by using the handy QuickShelf feature.

The following topics explain how to locate Almanac articles:
Locating Articles Using the Tabbed Lists
Locating Almanac Articles While in Other Bookshelf Books
Using QuickShelf to Access Bookshelf from Other Applications
Using the Almanac Outline

See also
About   The World Almanac and Books of Facts 1995  
Getting Acquainted with the Almanac



Locating Almanac Articles While in Other Bookshelf Books
G  LOSSARY  

While reading articles in other books, you can access the Almanac to obtain articles that contain a 
selected word, name, number, or phrase.
To locate Almanac articles while in other Bookshelf books
1. Right-click any selected word, name, number, or phrase in the Article window.

The shortcut menu opens.
2. On the shortcut menu, click Find in.

A menu displays listing All Books and each of the seven individual books.
3. Click Almanac.

Bookshelf performs a full-text search through all Almanac articles. 
The Almanac opens with the Find Tab displayed. The Find list shows all Almanac articles that contain 
the selected item. The first article on the list is automatically displayed in the Article window, with all 
occurrences of the selected item highlighted.

4. Click any title in the Find list to display that article in the Article window.
To return to the article you were reading in the other book

Click the Back button at the bottom of the Article window.
You may need to click several times depending on the number of Almanac articles you opened.

See also
Locating Articles Using the Tabbed Lists
Using QuickShelf to Access Bookshelf from Other Applications



Using the Almanac Outline
G  LOSSARY  

The Almanac has an Outline that shows where each article fits in the book's chapter/category/sub-
category organization. The levels in the Outline expand and collapse so that, for each article, you can see
the sub-category, category, and chapter in which the article belongs. This also allows you to see all the 
articles in a particular category or sub-category.
To open the Almanac Outline

In any open Almanac article, click the Outline button at the bottom of the Article window or choose
Outline from the Tools menu.

The Outline box opens.
In the box you'll see a list of words preceded by either a plus sign (+), minus sign (-), or bullet. The 
word with the minus sign is the category or sub-category of the open article. The words preceded by a 
bullet listed beneath the category are all of the articles in that category, among which is the open 
article.
Use the scroll bar to move up and down the Outline. The words above the category preceded by a plus
sign are other categories in a particular chapter. Each sub-category, category, and chapter can be 
expanded or collapsed in order to show the various relationships in the overall organization of Almanac
articles.

To expand or collapse the levels of the Almanac Outline

Click any plus sign to expand the item.
When an item is expanded, the plus sign becomes a minus sign. When you expand a chapter, you will 
see all the categories for that chapter. When you expand a category, you will see all articles in that 
category and any sub-categories. When you expand a sub-category, you will see all articles 
(designated by a bullet) in that sub-category.

Click any minus sign to collapse the item.
The minus sign becomes a plus sign. If you were to collapse every minus sign in the Outline, you 
would be left with the eight chapters. 

Click any article (designated by a bullet) to display that article in the Article window.
To close the Outline box, do any of the following:

Click the Close button in the upper-left corner of the Outline box.

Click anywhere outside the box.

Press any key.



Bookshelf Help Contents
To display a Help topic

With the mouse, move the mouse pointer to the underlined Help topic, then click the left mouse button.

On the keyboard, press TAB until you highlight the underlined Help topic, then press ENTER.
 In Help, click colored text with a solid underline to jump to that Help topic. Click colored text with a 

dotted underline to display a pop-up definition.

Using Help: The Basics

Exploring the Seven Books of Bookshelf

Using Bookshelf: A Comprehensive Guide

Using QuickShelf

Keyboard Shortcuts

Bookshelf Tips and Tricks

Glossary of Bookshelf Terms

Glossary of Error Messages

Troubleshooting

Suggestion Box



Using Bookshelf: A Comprehensive Guide
The books in Bookshelf open easily with a click of the mouse or a tap of a key. You can then move rapidly
from article to article or book to book. The interactive features of Bookshelf make the process of looking 
up and cross-referencing information fast and fun.
The Main Window

Guide to the Main Window
Opening Books

The Tabbed Lists
Guide to the Tabbed Lists
Locating Articles Using the Tabbed Lists

Using the Contents Tab
Using the Find Tab
Using the Gallery Tab
Using the Back List Tab
Using the Year in Review Tab

Resizing and Closing the Tabbed Lists Area
The Article Window

Guide to the Article Window
Choosing Hot Text and Graphics
Activating Media
Using the Article Window Buttons
Locating Definitions for Words in Any Bookshelf Article
Using the Right-Click Shortcut Menu
Copying and Pasting from Bookshelf Articles
Copying from Bookshelf Directly into Word
Printing All or Part of a Bookshelf Article
Using the Note Feature

The Bookshelf Menu Bar
Guide to the Menu Bar
Using the File Menu
Using the Edit Menu
Using the Tools Menu
Using the Books Menu
Using the Help Menu

Book-Specific Features
Opening and Using the Pronunciation Key
Using the Thesaurus Outline
Using the Quotations Book Outline
Using the Almanac Outline
Using the Flags Feature
Using the Atlas Zoom Button
Opening and Using the Atlas Information Box

Other Bookshelf Features
Setting Bookshelf Options
Using the Spelling Feature



Using Address Builder
Using Advanced Find
How Bookshelf and Word Work Together

Using Bookshelf Daily
Displaying Definitions for Words in Any Word Document
Copying from Bookshelf Directly into Word



Guide to the Main Window
G  LOSSARY  

The Bookshelf Main window is where you open books as well as locate and display articles. The Main 
window consists of the Book bar, Menu bar, Tabbed Lists area, and Article window. These four parts of the
window are always available so you can perform the most common tasks--opening and changing books, 
looking things up, browsing search results, and reading articles--without any complex navigation.

Take a few minutes to learn the function of each part of the Main window.
The Book bar, near the top of the window, is where you open books and keep track of the book 

you're in. Glide the mouse pointer over the icons in the Book bar to display ToolTips that tell you which 
book each icon represents. The name of the open book also displays in the title bar at the very top of the 
window.

The Menu bar, at the top left, has commands for performing a variety of tasks such as opening a 
book; printing an article; copying an article, picture, or sound; setting options; writing a note in a book; 
performing a focused full-text search; switching to a different book; or opening Help.

The Tabbed Lists area on the left is where you look for articles using one of Bookshelf's 
convenient "look up" Tabs: Contents, Find, Gallery, Back List, and Year In Review.

The Article window is where you display and read an article from the open book. This is where 
definitions, quotations, thesaurus synonyms, encyclopedia entries, atlas maps, almanac lists, and 
chronology topics appear. The bottom of the Article window has a bar with buttons for copying, printing, 
displaying a previously viewed article, and paging backward and forward in order through articles. Several
books have an additional button (Outline, See Also, Zoom Out) that displays information related to the 
open article.

See also
Opening Books



Opening Books
G  LOSSARY  

Every time you start Bookshelf, it opens automatically to All Books, which contains the articles from all 
seven of the Bookshelf references. Of course, you will want to open individual books and switch between 
books as needed. You can always tell which book you have open by glancing at the handy Book bar near 
the top of the Main window. When a book is closed, you see its colorful icon. When it is open, the icon 
looks like an open book. The title bar of the Main window also displays the name of the open book. 
Bookshelf gives you several easy ways to open and switch between books. 
To open a Bookshelf book do any of the following:

Click an icon on the Book Bar.
On the Menu bar, click the Books menu to display its list of books, then click the book you want to

open.
When All Books is open, click any article title in any Tabbed List. The book that contains the 

article opens, with the article displayed in the Article window.
 When you open a book, its active Tab is the same Tab that was active in the previously open book. In 

other words, if you have the Dictionary open with the Gallery Tab active, then switch to the Almanac, the 
Almanac opens with its Gallery Tab active.

Right-click any word in any Bookshelf article to open the shortcut menu, then click Find in... to 
open a list of books. Click the book you want.

The book you choose opens with its Find Tab active.
Use QuickShelf to open books when you are working in other Windows applications.

See also
Guide to the Main Window
Using the Right-Click Shortcut Menu
Using QuickShelf to Access Bookshelf from Other Applications



Guide to the Tabbed Lists
G  LOSSARY  

The Tabbed Lists area is where you look up information in Bookshelf. The Tabbed Lists are always 
available to the left of the Article window, making the process of locating information quick and easy. You 
can change the width of the Tabbed Lists area to suit your needs, or you can close the Tabbed Lists 
entirely, leaving just the five Tabs visible. Each Tab gives you a different way to locate Bookshelf articles.
The Tabbed Lists area consists of the following five Tabs:

Contents Tab - provides an alphabetical list of all the articles in the open book. When All Books 
is open, the Contents Tab displays a comprehensive list of articles for all seven books in Bookshelf.

Find Tab - allows you to do a full-text search for a word, phrase, or number throughout any or all 
of the seven books, similar to the search function in a word-processing program.

Gallery Tab - gathers together all the multimedia in Bookshelf--pictures, animation and video 
displays, and audio clips. The Gallery sorts articles according to the type of media they contain.

Back List Tab - provides a handy list of all the articles (up to 40) you've opened since you started
the current session of Bookshelf.

Year in Review Tab - provides a list of articles, categorized into subjects, covering noteworthy 
events, facts, people, and places of 1994. In addition, the Year in Review Tab displays a video that recaps
selected highlights of 1994.
Each of the five Tabs has the following features:
 Close button - the unlabeled button in the upper-right corner of each Tabbed List. When you click this 

button, all five of the Tabbed Lists close leaving just the five Tabs visible. This expands the Article window.
Click any Tab to reopen the lists.
 Information box - located near the top of each Tabbed List. The purpose of this box differs depending 

on the Tab. On the Contents and Find Tabs, the box provides instructions and a text box where you type 
in a word or phrase to quickly locate an article. There is also a Spelling button. On the Gallery Tab, the 
box contains four media buttons. You choose one of the buttons to sort articles according to the type of 
media they contain. On the Back List and Year in Review Tabs, the Information box simply provides 
instructions.
 Spelling button (Contents and Find Tabs only) - located next to the text box on the Contents and 

Find Tabs. Click the Spelling button to check the spelling of the word you typed in the text box. The 
Spelling feature analyzes the word and offers suggestions to help you enter the correct word.
 Articles list box - the alphabetical list of articles. If the list is long, this box is bordered on the right by a 

scroll bar. In this box you will see the following: 
-    Article titles: Click a title to display the article in the Article window. The titles of some articles in 

the lists are too long to fit in the list box. If you pause the mouse pointer on one of these titles, the 
full title displays. You can also expand the width of the Tabbed Lists area so the entire title is 
visible.

-    Book icon: The tiny icon located in front of most titles, this icon tells you which book the article is 
in. Pause the mouse pointer on the book icon to display a ToolTips label that identifies the book. 
This is especially helpful if you have All Books open. 

-    Arrow button: Located in front of some article titles, this button indicates that the title has two or 
more related articles. Click the arrow and the list of related articles opens. When the list is closed,
the arrow points up. When you open the list, the arrow points down. 

 Previous button and Next button - Located at the bottom of the Tabbed Lists, these two buttons allow 
you to open articles by moving up and down the list one article at a time. Click the Previous button to 
open the article immediately above the currently highlighted title. Click the Next button to open the article 
immediately below the currently highlighted title.

See also
Resizing and Closing the Tabbed Lists Area
Locating Articles Using the Tabbed Lists



Locating Articles Using the Tabbed Lists
G  LOSSARY  

You use the Tabbed Lists to locate articles when you are working directly in an open book. You can locate 
articles using any of the five Tabs. Be sure the book you want to work in is open. 
The following topics provided detailed instructions for using the Tabbed Lists:

Using the Contents Tab
Using the Find Tab
Using the Gallery Tab
Using the Back List Tab
Using the Year in Review Tab

See also
Guide to the Tabbed Lists
Resizing and Closing the Tabbed Lists Area



Using the Contents Tab
G  LOSSARY  

The Contents Tab provides an alphabetical list of all articles in the open book. When All Books is open, 
the Contents Tab provides a comprehensive list of all the articles in Bookshelf.
To locate articles using the Contents Tab
1. Click the Contents Tab to open it, if it is not already open. (You can also open the Contents Tab by 

pressing CTRL+ T or by choosing Table of Contents from the Tools menu.)
All articles in the open book are listed alphabetically in the Contents list box.

 A tiny Arrow button next to an article title indicates that the title has two or more related articles. Click the
button and the list of related articles opens.
2. In the text box above the Contents list, start typing the name of the article you wish to find. (Contents 

does not distinguish between uppercase and lowercase letters.)
Notice that, as you type, the list scrolls to the article titles that begin with the letters you type.
-Or-
Use the vertical scroll bar to look through the list until you find the article you want.

3. If you misspell a word, the Spelling dialog box opens automatically (unless you have turned off the 
automatic option) and displays a list of suggested words from which you may choose. Even if you have
turned off the automatic Spelling feature, you can still check the spelling of your word by clicking the 
Spelling button next to the text box.

4. When you've found the article, click it to display the article in the Article window.
The Tabbed Lists area stays visible, with the Contents Tab open, so you can refer back to it and 
choose other articles to read.

See also
Guide to the Tabbed Lists
Resizing and Closing the Tabbed Lists Area
Using the Spelling Feature



Using the Find Tab
G  LOSSARY  

You can use the Find Tab to perform a full-text search in a specific book or All Books. Simply type a word 
or phrase in the Find Tab text box, click Find! and Bookshelf searches the entire book, generating a list of 
all the articles that contain your word or phrase.
To locate articles using the Find Tab
1. Click the Find Tab to open it. (You can also open the Find Tab by pressing CTRL+ F or by choosing Find

from the Tools menu.)
2. In the text box, type the word, phrase, or number you wish to locate. (Find doesn't distinguish between 

uppercase and lowercase letters.)
 When searching for a phrase, type quotation marks around the phrase. If you don't, Find will locate all 

the articles that contain each individual word in the phrase rather than articles containing the phrase as a 
whole.

 Bookshelf will not search for words that are in its stop-word list.
3. If you misspell a word, the Spelling dialog box opens automatically (unless you have turned off the 

automatic option) and displays a list of suggested words from which you may choose. Even if you have
turned off the automatic Spelling feature, you can still check the spelling of your word by clicking the 
Spelling button next to the text box.

4. Click the Find! button or press ENTER to start your search.
Bookshelf searches through the open book(s) and provides a list of all the articles that contain your 
search text, up to a maximum of 2000 articles.

5. Use the vertical scroll bar to look through the list.
6. When you've found the article you want, click the article title to display the article in the Article window. 

All occurrences of the search text are highlighted.
The Tabbed Lists area stays visible, with the Find Tab open, so you can refer back to the list of found 
articles and choose other articles to read.

See also
Find Hints: Using Search Operators to Narrow the Scope of a Search
Using Advanced Find
Using the Spelling Feature
Guide to the Tabbed Lists
Resizing and Closing the Tabbed Lists Area



Using the Gallery Tab
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You can use the Gallery Tab to sort out articles in the open book that contain media. The Gallery Tab can 
give you a list of all the articles in a book that contain media of any type--animations, video clips, musical 
examples, pronunciations of words, pictures, and maps. The Gallery Tab can also sort a book's articles 
according to a particular type of media. For example, if you want to know which articles in the Dictionary 
have pictures, the Gallery Tab will give you a list.
To locate articles using the Gallery Tab
1. Click the Gallery Tab to open it. (You can also open the Gallery Tab by pressing CTRL+ G or by 

choosing Gallery from the Tools menu.)
2. Click one of the four media buttons: All Media, Audio, Animation & Video, or Picture.

The Gallery provides a list of all articles from the open book(s) that match the media criteria you chose 
with the media button.

 If a media button is dimmed, it means that the open book does not have any articles with that particular 
media. For example, when the Quotations book is open, the Animation & Video button on its Gallery Tab 
is dimmed because none of the Quotation articles contain animations or videos.
3. Browse through the list by using the scroll bar, or you can move quickly through the list by typing the 

first letter of the article you are looking for.
4. Click an item in the list to open the article and explore its media.

The Tabbed Lists area stays visible, with the Gallery Tab open, so you can refer back to the list of 
articles and choose other articles to open.

See also
Guide to the Tabbed Lists
Resizing and Closing the Tabbed Lists Area



Using the Back List Tab
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The Back List Tab keeps a list of up to 40 articles that you have displayed from all the different books 
since you started the current session of Bookshelf. No matter which book you have open, the Back List 
will show the same list of previously viewed articles.
To locate articles you previously opened in the current Bookshelf session
1. Click the Back List Tab to open it. (You can also open the Back List Tab by pressing CTRL+ L or by 

choosing Back List from the Tools menu.)
The Back List displays, with the most recently opened article at the top of the list.

2. Click an article title to open the article again.
The Tabbed Lists area stays visible, with the Back List Tab open, so you can continue to refer to the list
of articles and choose other articles to reread.

See also
Guide to the Tabbed Lists
Resizing and Closing the Tabbed Lists Area



Using the Year in Review Tab
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The Year in Review Tab displays a list of articles covering noteworthy events, facts, people and places of 
1994. The articles, compiled from several different Bookshelf books, are categorized into subjects. In 
addition, the Year in Review Tab displays a video that recaps selected highlights of 1994. Use the media 
controller at the bottom of the video screen to start, pause, and stop the video.
To play the Year in Review video
1. Click the Year in Review Tab. (You can also open the Year in Review Tab by pressing CTRL+ R or by 

choosing Year in Review from the Tools menu.)
The Year in Review Tab opens, with the Year in Review video screen displayed in the Article window.

2. Click the Play/Pause button  to start the Year in Review video.
3. If you wish, do any of the following:
 Click the Play/Pause button to pause the video. Click it again to continue the video.
 Click the Stop button 

 to stop the video. When you stop the video, it automatically "rewinds" to the beginning. 
 Keep track of the progress of the video clip as it plays by watching the slider glide down the track bar. 

(You can also drag the slider to any point on the track bar to view the video from that point.)
To locate articles using the Year in Review Tab
1. Click the Year in Review Tab. (You can also open the Year in Review Tab by pressing CTRL+ R or by 

choosing Year in Review from the Tools menu.)
The Year in Review Tab opens, which opens All Books. A list of subjects displays in the Tab list box 
and the Year in Review video screen displays in the Article window.

2. Click the Arrow button next to any subject to display the list of articles under that subject (if the subject 
has only a single article, the article will display in the Article window).

3. Click any article in the list.
The book containing the article opens and the article displays in the Article window. 
The Tabbed Lists area stays visible, with the Year in Review Tab open, so you can continue to refer to 
the list of articles and choose other articles to reread.

See also
Guide to the Tabbed Lists
Resizing and Closing the Tabbed Lists Area



Resizing and Closing the Tabbed Lists Area
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You can change the width of the Tabbed Lists area to suit your needs, or you can close the Tabbed Lists 
entirely, leaving just the five Tabs visible. The Article window expands or shrinks accordingly.
To resize the Tabbed Lists area
1. Move the mouse pointer along the right edge of the Tabbed Lists area until it turns into a double arrow.

A Resize label will display, unless you have turned off the ToolTips feature.
2. Hold down the left mouse button and drag to the right or left.
3. When the width of the Tabbed Lists area is what you want, release the mouse button.

The size of the Article window will adjust accordingly.
To close the Tabbed Lists

Click the Close button in the upper-right corner of any Tabbed List.
The Tabbed Lists disappear, leaving just the five Tabs visible. The Article window expands to fill the 
available space.



Guide to the Article Window
G  LOSSARY  

The Article window is where you display and read Bookshelf articles. Located to the right of the Tabbed 
Lists area, the Article window has a bar of buttons along the bottom. Each Bookshelf book has the same 
basic Article window and the same buttons, although a number of books have an additional button 
between the Print and Back buttons. When a book is open and an article is displayed, the layout of 
information in the Article window is distinct for each book.
 When you add an article to the Note feature, a Note icon displays in the top right corner of the Article 

window when that particular article is open.
The following topics cover the details of the Article window for each book:

Guide to the Dictionary Article Window
Guide to the Thesaurus Article Window
Guide to the Quotations Book Article Window
Guide to the Encyclopedia Article Window
Guide to the Atlas Article Window
Guide to the Chronology Article Window
Guide to the Almanac Article Window



Choosing Hot Text and Graphics
G  LOSSARY  

In Bookshelf articles, you click text that is hot to jump to another article or to display additional information
in a pop-up box or window. Click hot graphics to open a pop-up box or activate media. When the mouse 
pointer is over hot text or graphics, the pointer changes to a hand. 
To jump to another article

Click colored jump text (jump text is blue, unless you change it to another color using the Options 
command found on the Tools menu).

The current article will close and a new article will open in the Article window. You can redisplay the 
original article by clicking the Back button at the bottom of the Article window.

To pop up a box or activate media
Click colored pop-up text (pop-up text is magenta, unless you change it to another color using the

Options command found on the Tools menu)..
A box will pop up with additional information. Click outside the pop up to close it. 

Click hot graphics.
Depending on the graphic, either a box will pop up with additional information or media will be 
activated. Click outside the pop up to close the box.

 You can change the color of jump text and pop-up text by choosing Options from the Tools menu.

See also
Activating Media
Choosing Hot Text and Graphics with Keys
Setting Bookshelf Options



Activating Media
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Bookshelf enhances the information in the various reference books with pictures, audio clips, animations, 
and video clips. In most cases, a simple mouse click will let you enlarge a picture for clearer viewing, hear
an audio clip, and start the action of an animation or video.
The following topics explain how to activate specific types of media:

Enlarging Pictures
Playing Audio Clips
Playing Animations
Playing Video Clips



Enlarging Pictures
G  LOSSARY  

Some pictures in Bookshelf can be enlarged for better viewing. A caption at the bottom of such pictures 
reads "Click here to view picture."
To enlarge a picture

Move the mouse pointer over the picture until it turns into a hand, then click.
-Or-

Press TAB to highlight the picture, then press ENTER.
An enlargement of the picture displays in a pop-up box.

To close the pop up
Click anywhere.
Press any key.

See also
Choosing Hot Text and Graphics
Playing Audio Clips
Playing Animations
Playing Video Clips



Playing Audio Clips
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Audio clips are represented in Bookshelf articles by either an Audio icon  or a media controller. The 
Audio icon provides word pronunciations and musical examples. The media controller plays a variety of 
audio examples including musical compositions, musical instruments, famous people speaking or 
performing, and animal sounds.
To activate the Audio icon

Move the mouse pointer over the icon until it turns into a hand, then click. 
-Or-

Press TAB to highlight the Audio icon, then press ENTER.
The word is pronounced or the musical example plays. (To stop a musical example, for instance an 
anthem in the Atlas, click the Audio icon again or press ENTER.)

To play an audio clip using the media controller
Click the Play/Pause button 

 to start the audio clip.
Click the Play/Pause button to pause the clip. Click it again to continue the audio clip.
Click the Stop button 

 to stop the audio clip. When you stop a clip, it automatically "rewinds" to the beginning.
Keep track of the progress of the audio clip as it plays by watching the slider glide down the track 

bar. (You can also drag the slider to any point on the track bar to hear the clip from that point.)

See also
Choosing Hot Text and Graphics
Enlarging Pictures
Playing Animations
Playing Video Clips



Playing Animations
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Many Bookshelf articles are enhanced with informative animations. An animation is represented by an 
image with a caption that reads "Click here to view animation." If the animation is accompanied by 
narration, you will see an Audio icon in the lower-left corner of the image.
To start an animation

Move the mouse pointer over the animation image until it turns into a hand, then click.
-Or-

Press TAB to highlight the image, then press ENTER. 
A pop-up box displays with a viewing screen and a media controller. The animation automatically starts
to play. 

To control the animation once it has started
Click the Play/Pause button 

 to pause the animation. Click it again to continue the animation.
Click the Stop button 

 to stop the animation. When you stop an animation, it automatically "rewinds" to the beginning.
Once the animation is stopped, click the Play/Pause button to restart the animation from the 

beginning.
Keep track of the progress of the animation as it plays by watching the slider glide down the track 

bar. 
Keep track of sections of a narrated animation by watching as the slider goes past the tick marks 

below the track bar. Each tick mark indicates a section. (You can also drag the slider to any point on the 
track bar to view the clip from that point.)
Some narrated animations have a Section-menu button to the left of the slider. The Section menu lets you
jump to a specific section of the animation.
To use the Section-menu button
1. Put the mouse pointer on the Section-menu button and hold down the left mouse button. 

This displays a menu of section titles. Each section title corresponds with a tick mark under the track 
bar.

2. Continue holding down the left mouse button and drag to highlight the section you want to view, then 
release the mouse button. 
The slider jumps to the tick mark that corresponds with that section and plays the animation from that 
point forward. (You can also drag the slider to a tick mark to play that section.)

To close an animation, do any of the following:
Click the Close button at the upper-left corner of the animation pop-up box.
Click anywhere outside the pop-up box.
Press any key.

See also
Choosing Hot Text and Graphics
Enlarging Pictures
Playing Audio Clips
Playing Video Clips



Playing Video Clips
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Many Bookshelf articles are enhanced with video clips. You play video clips using the media controller 
located at the bottom of the video screen. 
To play a video clip

Click the Play/Pause button 
 to start the video clip.

Click the Play/Pause button to pause the clip. Click it again to continue the video clip.
Click the Stop button 

 to stop the video clip. When you stop a clip, it automatically "rewinds" to the beginning.
Keep track of the progress of the video clip as it plays by watching the slider glide down the track 

bar. (You can also drag the slider to any point on the track bar to view the clip from that point.)

See also
Choosing Hot Text and Graphics
Enlarging Pictures
Playing Audio Clips
Playing Animations



Using the Article Window Buttons
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The buttons at the bottom of the Article window help you navigate through the open book; copy and print 
articles or portions of articles; and in some books, display additional information that is related to the open
article.

With an article open in the Article window
Click To
Copy Copy the entire article, selected text, just 

the picture, or just the pronunciation from
the article to the Clipboard via the Copy 
dialog box. You can then paste the 
copied item into another application, 
such as Word. You can also paste copied
text into the Bookshelf Note dialog box. 

Print Print the article or a selection from the 
article via the Print dialog box. 

Back Re-display articles you have previously 
viewed in the current session of 
Bookshelf. The most recently viewed 
article displays first, followed by the 
remainder of the articles in reverse 
chronological order. If there is no 
previous article to view, the Back button 
is dimmed. 

<Page Display the previous article in the open 
book's browse order. If the open article is
the first article in the book, the <Page 
button is dimmed.

>Page Display the next article in the open 
book's browse order. If the open article is
the last article in the book, the >Page 
button is dimmed.

Outline Display a window containing information 
related to the open article. The 
Thesaurus, Quotations book, and 
Almanac have Outline buttons. 

See Also (Encyclopedia only) Display a list of Encyclopedia articles 
that contain information related to that in 
the open article. If no list exists for the 
open article, this button is dimmed.

Zoom Out (Atlas only) Display an '"expanded-view" map of the 
area currently displayed in the Article 
window. For example, if the map of the 
New England states is open in the Article
window, clicking Zoom Out will display 
the map of the entire United States. If 
there is no expanded-view map available



for the open map, the Zoom Out button is
dimmed.

See also
Copying and Pasting from Bookshelf Articles
Printing All or Part of a Bookshelf Article



Using the Right-Click Shortcut Menu
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The right-click shortcut menu provides a fast way to access and use Bookshelf information. You use the 
shortcut menu from any open article to look up the definition of a word; copy text or images to the 
Clipboard; copy text or images directly into a Word document; and perform a full-text search for selected 
text in any or all of Bookshelf's books. Simply right-click a word, selected text, or image to open the 
shortcut menu.
The following topics explain how to use each command on the shortcut menu:

Using the Shortcut Menu to Define a Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word
Using the Shortcut Menu to Do a Full-Text Search



Using the Shortcut Menu to Define a Word
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You can quickly display a definition from the Bookshelf Dictionary for any word in any article using the 
shortcut menu.
To display the Dictionary definition for a word in any Bookshelf article
1. Right-click a word in any open article.

The shortcut menu opens.
2. On the shortcut menu, click Define.

The definition from the Dictionary displays in a pop-up box.
If the word has more than one definition, the definition box will have a bar with arrow buttons that tells 
you how many definitions exist. Click the arrows to see additional definitions.

To close the definition box, do any of the following:
Click the close button in the upper-left corner of the definition box.
Click anywhere outside the definition box.
Press any key.

See also
Locating Definitions for Words in Any Bookshelf Article
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word
Using the Shortcut Menu to Do a Full-Text Search



Using the Shortcut Menu to Copy Text or Images
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You can quickly copy a word, image, or selected text to the Clipboard from any article in Bookshelf by 
using the shortcut menu.
To copy a selection from any article to the Clipboard
1. Right-click a word, image, or selected phrase in any open article.

The shortcut menu opens.
2. Click Copy on the shortcut menu.

This copies the item to the Clipboard.
You can now paste the item into another application by pressing CTRL+ V or choosing Paste from the 
application's Edit menu. (Be sure the insertion point is located where you want the copied information 
pasted.) You can also paste copied text into Bookshelf's Note dialog box using CTRL+ V.

See also
Copying and Pasting from Bookshelf Articles
Using the Note Feature
Using the Shortcut Menu to Define a Word
Using the Shortcut Menu to Copy Directly into Word
Using the Shortcut Menu to Do a Full-Text Search



Using the Shortcut Menu to Copy Directly into Word
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You can copy all or part of a Bookshelf article into a Word for Windows document using the shortcut 
menu. When Word is open, you can paste the copied items into any Word document you choose. If Word 
is not open, Bookshelf will open it for you and paste the copied information into a new document.
To copy from Bookshelf directly into Word using the right-click shortcut menu
1. Open the article containing the information you want to copy. If you want to copy only a portion of the 

article, select the text and/or image.
2. Right-click to open the shortcut menu, then click Copy to Word.

The Copy to Word dialog box opens listing all open Word documents. If Word is not open, Bookshelf 
will open it and paste the copied information directly into a new document.

3. Select a Word document from the list. (Be sure the insertion point in the Word document is where you 
want the copied information pasted.)

4. Click Copy.
Bookshelf copies the article or selection, pastes it into the Word document, and closes the dialog box. 
(Click Cancel if you decide not to copy.)

See also
Copying from Bookshelf Directly into Word
Using the Shortcut Menu to Define a Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Do a Full-Text Search



Using the Shortcut Menu to Do a Full-Text Search
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You can perform a full-text search for any word or selected text using the shortcut menu.
To instantly do a full-text search using the shortcut menu
1. Right-click a word or selected text in any open article.

The shortcut menu opens.
2. Click Find in on the shortcut menu.

A menu opens listing all of Bookshelf's books. 
3. From the menu of books, click any book title or All Books.

This activates a full-text search for the text in the selected book(s).
4. The Find Tab of the selected book opens, listing all articles that contain the search text. The first article

in the list is open in the Article window, with all occurrences of the search text highlighted.
5. Click any article in the list to display it in the Article window.
6. To return to the article in which your search text originated, click the Back button at the bottom of the 

Article window. This will take you back to articles you have previously read.

See also
Using the Shortcut Menu to Define a Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word



Copying and Pasting from Bookshelf Articles
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You can easily copy entire articles or selected text, pictures, and pronunciations from any Bookshelf 
article onto the Clipboard. You can then paste the copied information into other applications. You can also 
past copied text into Bookshelf's Note feature.
The following topics explain the various ways to copy from Bookshelf:

Copying Entire Articles and Selected Text
Copying a Picture
Copying a Pronunciation
Copying from Bookshelf Directly into Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word
Copying and Pasting into Note



Copying Entire Articles and Selected Text
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You can copy entire articles or selected text from any Bookshelf article onto the Clipboard. From the 
Clipboard, you can paste the article or text into another application. You can also paste selected text from 
an article into the Bookshelf Note feature. You can use either the Copy command on the Edit menu or the 
Copy button at the bottom of the Article window to copy information.
To copy an entire article
1. Open the article you want to copy.
2. From the Edit menu, choose Copy or press CTRL+ C.

-Or-
Click the Copy button at the bottom of the Article window to open the Copy dialog box, click the Copy 
All Text option (a black dot means the option is selected), then click OK. (Click Cancel if you decide not
to copy.)
The entire article is copied onto the Clipboard and the Copy dialog box closes.

To copy selected text from an article
1. Open the article you want to copy from.
2. Select the text you want to copy.
3. From the Edit menu, choose Copy or press CTRL+ C.

-Or-
Click the Copy button at the bottom of the Article window to open the Copy dialog box, click the Copy 
Selected Text option (a black dot means the option is selected), then click OK. (Click Cancel if you 
decide not to copy.)
The text is copied onto the Clipboard and the Copy dialog box closes.

To paste the Clipboard contents
1. Open the document into which you want to paste.
2. With the insertion point in the correct location, press CTRL+ V or choose Paste from the application's 

Edit menu.
The copied information is pasted into the document, along with a footnote citing the source of the 
information.

See also
Copying a Picture
Copying a Pronunciation
Copying from Bookshelf Directly into Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word
Copying and Pasting into Note



Copying a Picture
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You can copy just the picture from most Bookshelf articles onto the Clipboard. From the Clipboard, you 
can paste the picture into another application. If a picture cannot be copied, the Copy Picture command or
option is dimmed.
To copy a picture from an article
1. Open the article you want to copy from.
2. From the Edit menu, choose Copy Picture.

-Or-
Click the Copy button at the bottom of the Article window to open the Copy dialog box, click the Copy 
Picture option (a black dot means the option is selected), then click OK. (Click Cancel if you decide not
to copy.)
The picture is copied onto the Clipboard and the Copy dialog box closes.

To paste the picture
1. Open the document you want to paste the picture into.
2. With the insertion point in the correct location, press CTRL+ V or choose Paste from the application's 

Edit menu.
The picture is pasted into the document.

See also
Copying Entire Articles and Selected Text
Copying a Pronunciation
Copying from Bookshelf Directly into Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word
Copying and Pasting into Note



Copying a Pronunciation
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You can copy the pronunciation from any Bookshelf article onto the Clipboard. Pronunciations are 
represented in Bookshelf articles by an Audio icon. From the Clipboard, you can paste the pronunciation 
into another application. If an article has no pronunciation or the sound cannot be copied, the Copy 
Pronunciation command or option is dimmed.
To copy a pronunciation from an article
1. Open the article you want to copy from.
2. From the Edit menu, choose Copy Pronunciation.

-Or-
Click the Copy button at the bottom of the Article window to open the Copy dialog box, click the Copy 
Pronunciation option (a black dot means the option is selected), then click OK. (Click Cancel if you 
decide not to copy.)
The pronunciation is copied onto the Clipboard and the Copy dialog box closes.

To paste the pronunciation
1. Open the document you want to paste the pronunciation into.
2. With the insertion point in the correct location, press CTRL+ V or choose Paste from the application's 

Edit menu.
An icon representing the pronunciation is pasted into the document. Double-click the icon to hear the 
pronunciation.

See also
Copying Entire Articles and Selected Text
Copying a Picture
Copying from Bookshelf Directly into Word
Using the Shortcut Menu to Copy Text or Images
Using the Shortcut Menu to Copy Directly into Word
Copying and Pasting into Note



Printing All or Part of a Bookshelf Article
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You can print all or part of any Bookshelf article. The printed result may look different from the article on 
your screen. When you print, Windows may use a different font. In addition, special characters may print 
differently or may not print at all. Images in some Bookshelf articles may not print clearly. Whenever you 
print from a Bookshelf article, the printout will include a citation for the source of the article text.
To print all or part of an article
1. Open the article you want to print.
2. Select the part of the article you want. If you want to print the entire article, no selection is needed.
3. From the File menu, click Print Article or press CTRL+ P.

-Or-
Click the Print button at the bottom of the Article window.
The Print dialog box opens. 

4. In the Print dialog box under Print Range, click All to print the entire article or Selection to print the 
selected portion of the article.

5. Set the options for Print Quality and number of Copies as needed.
6. If you need to adjust printer settings, click the Setup button to open the Print Setup dialog box. Select 

the printer settings and options you need, then click OK to save your selections and close the Setup 
dialog box. 

7. In the Print dialog box, click OK to print the article. (Click Cancel if you decide not to print.)
This starts your print job and closes the Print dialog box.

See also
Using the Article Window Buttons
Changing Printers and Printer Options



Changing Printers and Printer Options
Bookshelf prints articles on the default printer for Windows. If you have installed more than one printer in 
Windows, you can make any of your installed printers the default printer. You can also change the default 
printer options.
To change printers and printer options
1. In Bookshelf click the Print button at the bottom of the Article window or choose Print Article from the 

File menu.
The Print dialog box displays.

2. In the Print dialog box, click the Setup button.
The Print Setup dialog box displays.

3. Under Specific Printer, select the printer that you want.
4. Click the Options button in the Print Setup window if you need to change the default printer options.
5. Select the options you want, and then click OK to return to the Print Setup window.
6. Click OK again to close the Print Setup window.
For more information on setting up printers, see your Windows documentation.



Using the Note Feature
G  LOSSARY  

Use the Note feature (choose Note from the Edit menu) to keep a handy list of articles that interest you, 
and to make your own annotations about articles. You can use this personalized list to open articles as 
well as read your notes on them. When you no longer need to keep track of an article and/or its 
annotations, you can delete the annotations, the article, or both.
Once an article is added to Note, a Note icon displays in the upper-right corner of the open article.
The following topics explain how to use the Note feature:

Using Note to Keep an Annotated List of Articles
Copying and Pasting into Note
Opening Articles from Note
Deleting Annotations and Articles from Note



Using Note to Keep an Annotated List of Articles
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Use the Note feature to keep a personalized list of Bookshelf articles. For each article on your list, you 
can add your own comments and/or portions of text from other Bookshelf articles.
To add an article to Note
1. Open the article you wish to add.
2. From the Edit menu, choose Note or press CTRL+ N.

The Note dialog box displays.
3. Click the Add Current Article button.

The article title is added to the Articles list box. If there is more than one article in the list box, the new 
article is added to the top of the list.

4. Click OK to save the addition and close the Note dialog box.
Notice that the Note icon now appears at the upper right of the article.

To annotate an article using Note
1. Add the article to Note if it is not already added, using steps 1-3 above.
2. With the article you wish to annotate highlighted, put the insertion point in the Annotation text box and 

type your comments.
If you need to correct or clear something you type, press the BACKSPACE key to erase any unwanted 
characters, or select the text, then press DELETE. When you type, text wraps automatically, but you can
end a line before it wraps by pressing ENTER.

3. Click the OK button to save your additions and close the Note dialog box.
 You can click the Note icon to open the Note dialog box and reread your annotations.

See also
Copying and Pasting into Note
Opening Articles from Note
Deleting Annotations and Articles from Note



Copying and Pasting into Note
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Copying and pasting text into Note is a powerful way to collect information in one place. You can copy 
selected text from a Bookshelf article or other application and paste that text into the Annotations box for 
any article listed in Note. For example, you could copy all or part of a quote by Sigmund Freud from the 
Quotations book, open the Note dialog box and paste the copied quote into the Annotations for the 
"Freud, Sigmund" Encyclopedia article.
You can also copy text from any annotation in Note and paste it into another Bookshelf text box or into 
another application.
To copy text and paste into Note
1. From any Bookshelf article or other application, select the text you want to copy.
2. From the Edit menu, choose Copy or press CTRL+ C.

The text is copied to the Clipboard.
3. From the Edit menu choose Note, or press CTRL+ N.

-Or-
Click the Note icon in any open article that has one.
The Note dialog box displays.

4. In the Articles list, click the article you wish to annotate with the copied text.
5. Put the insertion point in the Annotations text box.
6. Press CTRL+ V. 

The copied text is pasted into the Annotations box for the chosen article. 
 When you paste text that was copied from a Bookshelf article, the citation for the source is also pasted 

into Note. If you wish, you can delete all or part of the citation by selecting it and pressing DELETE.
7. Click the OK button to save your addition and close the Note dialog box.
To copy all or part of an annotation from Note onto the Clipboard
1. From the Edit menu choose Note, or press CTRL+ N.

-Or-
Click the Note icon in any open article that has one.
The Note dialog box displays.

2. In the Note dialog box, click the name of the article that has the annotation you want to copy.
3. Highlight the annotation text.
4. Press CTRL+ C.

The annotation is now copied onto the Clipboard.
5. Click the OK button to close the Note dialog box.

The copied text is now available for pasting to the location of your choice.

See also
Using Note to Keep an Annotated List of Articles
Opening Articles from Note
Deleting Annotations and Articles from Note
Selecting and Editing in Text Boxes with Keys



Opening Articles from Note
G  LOSSARY  

All articles listed in Note can be opened directly from the Note dialog box.
To open an article from Note
1. From the Edit menu choose Note, or press CTRL+ N.

-Or-
Click the Note icon in any open article that has one.
The Note dialog box displays.

2. Click an article name to highlight it.
3. Click the Go To button at the bottom of the Articles list box.
4. The article opens in the Bookshelf Article window.
To close the Note dialog box, do any of the following:

Click the Cancel or OK buttons or press ESC.
Double-click the Control-menu box in the upper-left corner of the Note dialog box.
Click the Control-menu box to open the Control menu, then click Close or press ALT+ F4.

See also
Using Note to Keep an Annotated List of Articles
Copying and Pasting into Note
Deleting Annotations and Articles from Note



Deleting Annotations and Articles from Note
G  LOSSARY  

When you no longer need to keep track of an article or you no longer need annotations you have made in 
Note, you can delete them. You can either delete annotations and leave the article in Note or you can 
delete both the annotations and the article at the same time.
To delete an article and its annotations at the same time
1. From the Edit menu choose Note, or press CTRL+ N.

-Or-
Click the Note icon in any open article that has one.
The Note dialog box displays.

2. In the Articles list, click the name of the article you want to delete.
3. Click the Delete button at the bottom of the Articles list box. 

The article and any annotations are deleted from the Note dialog box.
4. Click OK to save the changes and close the Note dialog box.
To delete an annotation from Note without deleting the article
1. From the Edit menu choose Note, or press CTRL+ N.

-Or-
Click the Note icon in any open article that has one.
The Note dialog box displays.

2. In the Articles list, click the name of the article whose annotation you want to delete.
3. Select the annotation you want to delete.
4. Press DELETE or BACKSPACE on your keyboard to remove the annotation.

The annotation is deleted but the article remains in the Articles list box. 
5. Click OK to save the changes and close the Note dialog box.
 If you delete an annotation by clicking the Delete button at the bottom of the Articles list box, the article 

will also be deleted.

See also
Using Note to Keep an Annotated List of Articles
Copying and Pasting into Note
Opening Articles from Note
Selecting and Editing in Text Boxes with Keys



Guide to the Menu Bar
Located near the top of the Bookshelf Main window, the Menu Bar has five drop-down menus containing 
commands for accessing Bookshelf features, such as Address Builder and Advanced Find, and 
performing common tasks, such as copying text and media, printing articles, and opening Help. All 
menus, except Tools, contain the same commands regardless of the open book. The Tools menu has one
additional command when the Thesaurus, Quotations book, Encyclopedia, and Almanac are open, and 
two additional commands when the Atlas is open.
The following topics cover the commands on each menu:

Using the File Menu
Using the Edit Menu
Using the Tools Menu
Using the Books Menu
Using the Help Menu



Using the File Menu
G  LOSSARY  

The File menu is one of five menus located on the Bookshelf Menu bar. The commands on the File menu 
are the same no matter which book is open. Click File to open the menu.

From the File menu click To
Print Article Print the open article via the Print 

dialog box.

Exit Close Bookshelf.

See also
Printing All or Part of a Bookshelf Article



Using the Edit Menu
G  LOSSARY  

The Edit menu is one of five menus located on the Bookshelf Menu bar. The commands on the Edit menu
are the same no matter which book is open. Click Edit to open the menu.

From the Edit menu click To
Cut Cut highlighted text from any text box in 

Bookshelf. Text that is cut is stored on 
the Clipboard and can be pasted into 
other Windows applications. 

Copy Copy text you have selected in the open 
article onto the Clipboard. If nothing is 
selected, the Copy command copies the 
entire article onto the Clipboard.

Paste Paste text from the Clipboard into a text 
box. The insertion point must be in the 
text box in order for Paste to work.

Copy Picture Copy the picture in the open article onto 
the Clipboard.

Copy Pronunciation Copy the pronunciation in the open 
article onto the Clipboard. (This 
command is available only when the 
open article contains a sound you can 
copy.)

Copy to Word Copy an entire article or selected text or 
media from the open article directly into a
Word document via the Copy to Word 
dialog box.

Note Open a dialog box in which you can add 
the title of the currently displayed article 
and make annotations about the article 
for future reference. 

See also
Copying a Picture
Copying a Pronunciation
Copying and Pasting from Bookshelf Articles
Copying from Bookshelf Directly into Word
Printing All or Part of a Bookshelf Article
Using the Note Feature



Using the Tools Menu
G  LOSSARY  

The Tools menu is one of five menus located on the Bookshelf Menu bar. The Tools menu has the same 
commands no matter which book is open, plus one additional command when the Thesaurus, Quotations 
book, Encyclopedia, and Almanac are open, and two additional commands when the Atlas is open. Click 
Tools to open the menu.

From the Tools menu click To
Table of Contents Display the Contents Tab for the open 

book. Locate articles using the 
alphabetical list of titles in the list box.

Find Display the Find Tab for the open book. 
Type a word, phrase, number, or date in
the text box, then click Find! to perform 
a full-text search through all articles in 
the book.

Gallery Display the Gallery Tab for the open 
book. Click a media button to sort 
articles according to the type of media 
they contain.

Back List Display the Back List Tab, where you 
can see the list of articles (up to 40) you
have read since you started the current 
Bookshelf session.

Year in Review Open the Year in Review Tab, where 
you can see a list of articles, 
categorized into subjects, covering 
noteworthy events, facts, people, and 
places of 1994. In addition, the Year in 
Review Tab displays a video that recaps
selected highlights of 1994.

Advanced Find Open the Advanced Find dialog box 
where you can select options to focus 
and narrow your full-text search.

Address Builder Open the Address Builder dialog box 
where you can locate address 
information and build addresses for 
most U.S. locations.

Bookshelf Daily Open the Bookshelf Daily dialog box 
where you can read the Quote of the 
Day and Word of the Day articles.

Options Opens the Options dialog box where 
you can change the color of hot text and
the size of article text; turn on or off the 
Automatic Spelling feature, Interface 
Sounds, ToolTips, Pronunciations; and 
change the word range for the NEAR 



search operator.

Outline Open a window containing information 
related to an open article in the 
Thesaurus, Quotations book, or 
Almanac

See Also (Encyclopedia only) Open a list of Encyclopedia articles that 
contain information related to that in the 
open article. If no list exists for the open
article, this command is dimmed.

Flags (Atlas only) Open the Flags dialog box where you 
can view and copy the flags of most 
countries and all U.S. states.

Zoom Out (Atlas only) Open an '"expanded-view" map of the 
area currently displayed in the Article 
window. For example, if the map of the 
New England states is open in the 
Article window, clicking Zoom Out will 
display the map of the entire United 
States. If there is no expanded-view 
map available for the open map, the 
Zoom Out button is dimmed.

See also
Locating Articles Using the Tabbed Lists
Setting Bookshelf Options
Using Address Builder
Using Advanced Find
Using Bookshelf Daily



Using the Books Menu
G  LOSSARY  

The Books menu is one of five menus located on the Bookshelf Menu bar. The Books menu lists the title 
of each book in Bookshelf, plus All Books. Click a title to open a book.

See also
Opening Books 



Using the Help Menu
G  LOSSARY  

The Help menu is one of five menus located on the Bookshelf Menu bar. The commands on the Help 
menu are the same no matter which book is open. Click Help to open the menu.

From the Help menu click To
Copyright Information Display copyright information and 

credits for the open book. When All 
Books is open, you'll see the copyright 
information for all seven books.

Help Contents Open Help to its Table of Contents. 
Help is your Bookshelf "user's 
manual." You can read Help topics 
while you work in Bookshelf and you 
can also print individual topics for 
future reference.

About the...[open book] Display a Help topic that describes the 
open reference book. This topic may 
also provide access to articles of 
interest reproduced from the print 
version of the book. For example, 
when you click About the Dictionary, 
you display a topic that describes The 
American Heritage Dictionary, Third 
Edition. From this topic you can display
articles from the print version of The 
American Heritage Dictionary.

Using Help Open a Help topic that teaches you 
how to use Bookshelf's online Help.

Keyboard Shortcuts Open directly to the Help topics that list
keyboard shortcuts for using many of 
the features and functions in 
Bookshelf.

About Microsoft Bookshelf Open a window containing basic 
information about Microsoft Bookshelf, 
including copyright and license 
information and system statistics. To 
close the window, click OK or double-
click the Control-menu box in the 
upper-left corner of the window.

See also
Using Help: The Basics
Keyboard Shortcuts



Setting Bookshelf Options
G  LOSSARY  

Bookshelf has a number of appearance and behavior settings that you can adjust to suit your needs and 
preferences. You can change the color of jump text and pop-up text; increase the size of Article window 
text; turn off the automatic Spelling feature, interface sounds,    ToolTips, and audio pronunciations; and 
adjust the word range for the "NEAR" search operator.
To set Bookshelf options
1. From the Tools menu, choose Options.

The Options dialog box opens. 
2. Decide which options you wish to change.

The Bookshelf default settings include blue jump text, magenta pop-up text, and normal text size. The 
automatic Spelling feature, interface sounds, ToolTips, and audio pronunciations are turned on; and 
the NEAR word range is 8.

 Click the down arrows next to the text boxes under Article Text options to display the choices for jump 
and pop-up text color and article text size, then click an item on each drop-down list to select that option. 

An example of your selection displays to the right of the text box. 
 Click the check box next to Automatic Spelling, Interface Sounds, ToolTips, and Pronunciations to 

remove the X and turn off the feature. 
 Highlight the number in the "NEAR" text box and type a new number in order to change the word range 

of the search operator. 
3. Click the OK button to save your settings and close the Options dialog box. (Click Cancel if you decide 

not to make changes.) 

You can also close the Options dialog box by double-clicking the Control-menu box in the upper-left 
corner, pressing ESC or ALT+ F4, or clicking the Control-menu box to open the Control menu, then clicking 
Close.
See also
Find Hints: Using Search Operators to Narrow the Scope of a Search
Using the Spelling Feature
Choosing Dialog Box Options with Keys



Using the Spelling Feature
G  LOSSARY  

The Bookshelf Spelling feature checks the spelling of words you type in text boxes on the Contents Tab, 
Find Tab, and in the Advanced Find dialog box. Spelling automatically checks your words against its 
dictionary and offers suggestions. You can turn this automatic feature off and still use Spelling when you 
need to by clicking the Spelling button located to the left of the text box.
The automatic Spelling feature
When you type a misspelled word in a text box, the Spelling dialog box automatically opens with the 
incorrectly spelled word displayed in its text box. The Spelling list box will have either suggested words or 
a message indicating no suggestions are available. Click a word from the suggested list to replace your 
incorrect word. If there are no suggested words, you can type a different spelling of your word in the text 
box and click the Suggest button. 
To turn off automatic Spelling
1. From the Tools menu, choose Options.

The Bookshelf Options dialog box opens.
2. Click the check box next to Automatic Spelling to remove the X.

Automatic Spelling is turned off.
To use the Spelling feature manually
1. Type a word in the Contents Tab, Find Tab, or Advanced Find text box.
2. Click the Spelling button.

The Spelling dialog box opens.
3. Click the Suggest button.

One or more words displays in the list box, or a message displays if there are no suggestions.
4. Click a word in the list to replace your misspelled word in the text box and close the Spelling dialog 

box, or click the Close button in the top left corner of the dialog box to close the box without making a 
choice.

-Or-
1. Open the Contents Tab or Find Tab for any book, or the Advanced Find dialog box.
2. Before typing anything in the text box, click the Spelling button.

The Spelling dialog box opens.
3. Type a word in the Spelling text box.
4. Click the Suggest button.

One or more words displays in the list box, or a message displays if there are no suggestions.
5. Click a word in the list to replace your misspelled word in the text box, add it to the text box of the open

feature, and close the Spelling dialog box, or click the Close button in the top left corner of the dialog 
box to close the box without making a choice.

See also
Using the Contents Tab
Using the Find Tab
Using Advanced Find



Using Advanced Find
G  LOSSARY  

You use the Advanced Find feature instead of the Find Tab when you want to precisely focus your search 
for a specific word, phrase, number, or date. Like the Find Tab, Advanced Find performs a full-text search 
in any or all of the Bookshelf books. But with Advanced Find, you have more flexibility in the number and 
combination of books in which you search, as well as more ways to narrow your search to specific 
articles.
To perform a full-text search using Advanced Find
1. From the Tools menu, choose Advanced Find.

The Advanced Find dialog box opens.
2. In the text box, type the word, phrase, number, or date you want to find. 

 Click the Hints button to get some suggestions for narrowing the scope of your search.
If you misspell a word, the Spelling dialog box opens automatically (unless you have turned off the 
automatic option) and displays a list of suggested words from which you may choose. Even if you have 
turned off the automatic Spelling feature, you can still check the spelling of your word by clicking the 
Spelling button next to the text box.
3. Click one of the three "Select where to look" options:
 Click All Articles (the default) to search through all the articles in the selected books.
 Click Current Article Only to limit your search to the article currently open in the Article window.
 Click Last Articles Found to limit your search to the articles in the list generated by your last search.

4. Click the buttons for the books you want to search in. You can search in any number or combination of 
books. All Books is the default. (Click a selected button to de-select it.)
Remember, if you selected the Current Article Only or the Last Articles Found options, make sure your 
book selections match your previous selections.

5. Click one or more media buttons if you want to limit your search to just the articles that contain 
particular types of media.

 If you click more than one media button, for example Audio and Video, Bookshelf finds articles that 
contain an audio clip OR a video clip. Bookshelf does not narrow the search to just those articles that 
contain both an audio AND video clip.
6. Click the Find! button. (Click Cancel if you decide not to search.)

Bookshelf searches according to the criteria you selected and compiles a list, up to a maximum of 
2000 articles. Bookshelf opens the Find Tab of the first book in which it finds a matching article. The 
article is displayed in the Article window and the full list of matching articles is shown in the Find Tab 
list box. When you click an article in the list that is in a book other than the currently open book, that 
book opens with the article you clicked displayed in the Article window.

See also
Find Hints: Using Search Operators to Narrow the Scope of a Search
Using the Spelling Feature



Find Hints: Using Search Operators to Narrow the Scope of a Search
G  LOSSARY  

With both the Find Tab and Advanced Find features you can narrow the scope of a full-text search by 
using the search operators AND, OR, NOT, and NEAR when you type the text you want to search for in 
the text box. You can enter an operator in either lowercase or uppercase letters (for example, "and" is the 
same as "AND"). If you use multiple search operators they are evaluated, by default, from left to right. You
can use parentheses ( ) to specify a different order--operators within parentheses are evaluated first.

This example Searches for
read AND books Articles containing both the word "read" 

and the word "books."

read books Articles containing "read" and "books" 
(same as "read AND books" above). 
AND is the default operator.

"read good books" Articles containing the words "read good 
books" in that order. (The quotation 
marks are part of the search criteria.)

read OR books Articles containing "read" or "books" or 
both.

read NOT books Articles containing "read" but not 
"books."

read NEAR books Articles containing "read" and "books" 
where the two words are separated in 
the text by eight or fewer words. (8 is the 
default setting for the NEAR word range. 
You can increase or decrease the NEAR 
word range in the Options dialog box. 
Choose Options from the Tools menu.) 

read OR good AND books Articles containing "read" and "books" or 
articles containing "good" and "books."

read OR (books AND good) Articles containing just the word "read" or
articles containing "books" and "good."

 Bookshelf will not look for words that are in its stop-word list.

See also
Using Advanced Find
Setting Bookshelf Options





"Introduction" from The Columbia Dictionary of Quotations by Robert Andrews
The art of quotation is as old as human speech, and collections of writings and sayings have been with us
since the invention of letters. It seems that we have need of a corpus of recognized authorities to bolster 
our knowledge or confirm our beliefs. Books of quotations are an elemental model of how culture is 
perpetuated, the wisdom of the tribe passed on to posterity, to be added to, edited, and modified by 
subsequent generations. But whereas many anthologies remain content to recycle inventories of 
ancestral wisdom, cataloguing our cultural waymarks according to the gnomic pronouncements of our 
forebears, The Columbia Dictionary of Quotations is a book intended for our own times; its keynote is not 
familiarity, but aptness. It embraces the past in order to illustrate the present.
Arranged under topics which reflect the gamut of human experience, the quotations in this book have 
been chosen because they matter, because they were spoken or written by people who matter, and 
because they address issues as important now as they were for Ben Jonson or Benjamin Franklin. Thus, 
alongside the established sources I have included others, many previously unanthologized, or at best 
under-represented, in other collections¾figures modern as well as old¾who collectively constitute the 
shapers of our modern cultural landscape.
This format has allowed me to venture far beyond the confines of the conventional quotation anthology, 
bringing to light all but forgotten sources as well as deeper insights into those icons whom we have 
always presumed to know. In the welter of unfiltered information unleashed by the media age, it is easy to
lose sight of the authentic wellsprings that have fertilized our thought and shaped our consciousness. 
Fashions change, and increasingly there is a need for us to take stock, to remind ourselves of these 
formative influences both past and present, to help us understand who we are, where we have come 
from, where we might end. If, in perusing this mosaic of aperçus and opinions, you find yourself 
stimulated, subverted, or enlightened, it may well be the challenge of confronting your own image that has
aroused you.
The inescapable impression that strikes the reader of these clashing perspectives is how the same topics 
absorbed the minds of different generations and how "modern" so many of the discussions of them 
appear to us today: on EQUALITY, for example; on LITERATURE AND SOCIETY; on BUSINESS AND 
COMMERCE; and on CHILDREN. In assembling all this material, I have been impressed, as I hope the 
reader will be, not so much by how reactions to these eternal themes have differed through the centuries, 
but by the degree to which they varied within the same generation and converged across the gulf of 
years. "Elegant juxtapositions are one of the delights of any anthology," wrote the author A. S. Byatt: here 
they are accidental, but no less pleasurable. To sift through these quotations is to eavesdrop on an 
endless argument, a vociferous hubbub of voices that alternately shocks and soothes. Some are, in the 
words German critic Walter Benjamin, "like wayside robbers who leap out armed and relieve the stroller of
his conviction," while others achieve that rate perfection of style summarized by Pope, "What oft was 
thought, but ne'er so well expressed."
Quotations have been selected on the basis that it is just as important for us to know what Susan Sontag 
and John Updike said on a certain subject as it is to acquaint ourselves with the views of Jonathan Swift 
and Henry David Thoreau on the same. Harriet Martineau had an opinion: what was it? Walter Lippmann 
was a giant in the field of twentieth-century political thought: let us remind ourselves of his argument. 
Similarly, we need to know what the Marquis de Sade thought about society and moral values, just as we 
need to be aware of Andrea Dworkin's viewpoint. It is too easy for stereotypes to congeal around certain 
figures without going to the trouble of listening to what they have to say. The Bible is an important 
influence on the world, the Qur'an no less so. Dr. Johnson can amuse and entertain us; so can Lenny 
Bruce. Dr. Martin Luther King, Jr., was a superb speaker: what did he say? And how exactly did his 
philosophy differ from that of Malcolm X?
Among the voices that have found space in these pages are those of individuals and groups whose 
contribution to debate has been seriously under-acknowledged in other collections. These include 
women, dissenters of all persuasions, minorities, homosexuals and lesbians, and a significant sample 
from non-English-speaking nations¾not because there has been any exercise in positive discrimination, 
but because their literary and polemical engagement in the perennial questions about ourselves and the 
world we live in is valuable, and we cannot afford to ignore it.
At the same time I make no apology for taking from many habitués of quotation anthologies¾such giants 
of aphorism and wit as Emerson, Wilde, Johnson, and Montaigne, and such stylists as Proust, Thoreau, 



Woolf, and George Eliot¾virtuosi of literature, who invariably seemed to find (in Coleridge's phrase) "the 
best words in the best order" to describe their experience of life. Readers can expect to encounter plenty 
of old acquaintances, known or half-known or dredged up from the recesses of memory. Where this 
anthology differs markedly from most others is in the fact that no quotation has been included simply 
because it is famous. Rather, the criteria are wit, grace, originality, relevance, usefulness, and meaning. 
What has been avoided are those stock quotations that have ceased to carry their original resonance, 
whether through over-use, misapplication, or by a sort of process of petrification whereby the great 
sayings have been sucked of their life and reduced to triteness, cliché, and parody. This has excluded a 
lot of Shakespearian and Biblical material that over the years has lost its edge, not to mention much bad 
poetry, hymns and anthems, and snatches of speeches or songs that, while well known and possibly well 
composed, have ceased to have much impact for us at the end of the twentieth century.
Once the bland, the dull, and the over familiar have been sifted, what remains inevitably displays a 
tendency towards the caustic and antagonistic: the devil, we find, has the best tunes. The finest art has 
always run counter to received opinion. Similarly, the most pointed quotations are those that undermine 
our prejudices. Quotability, not niceness or correctness, is the prime requirement for inclusion in this 
book. On the other hand, demagogues and politicians, who specialize in a highly quotable verbal style, 
are represented far less often here than the flow of their words might seem to warrant. They, more than 
anyone, have long recognized the power of quotations, knowing that opinions can be sanctified by 
appealing to precedent. Above all they have seized on and exploited the fact that the power also runs the 
other way, that every time they themselves are quoted, they assume the influence of an oracle. But their 
objectives are too limited, their themes too unoriginal, their messages too ephemeral. Thus we live in the 
epoch of the "soundbite"¾a new word for an old trick that has nonetheless attained new heights of artifice
and superficiality. The more recent examples of this spurious, manufactured species of quotation have not
been included in this collection, although some older exponents such as Winston Churchill and Theodore 
Roosevelt can be found here by virtue of their combined historical importance and fine oratory. Slogans 
and refrains, however, do not figure in these pages, since they lack any personal quality.
Indeed it is this vital personal ingredient that more than anything defines a quotation. Without it the words 
are orphaned, and for this reason these pages include the bare minimum number of contributions by the 
usually ubiquitous Anon. (although proverbs have been included when they evoke a particular time and 
mode). A true quotation cannot be divorced from the character who uttered or scribbled it; it should say as
much about the person quoted as about the particular subject referred to, and for this reason an 
anthology of quotations should be a kind of portrait gallery. The Columbia Dictionary of Quotations 
presents as rich a parade of personalities as can be found within the covers of a single book. Here they 
are, revealed in all their genius and prejudice, goodness and pathos, profundity and absurdity, heroism 
and evil. Their extracted speeches and writings represent a motley confection of philosophies, ideologies, 
preoccupations, and temperaments, imprecation, injunction, or insights offering a quotable commentary 
on the human condition.
Just as an effective quotation is indissolubly bound with the person who created it, so it is inseparable 
from the spirit and context in which it was originally phrased. A quotation must be authentic or it loses its 
vigor, and an important feature of this book is the precise citational and contextual information 
given¾more detailed than any previous anthology has provided. It is not enough to quote Jane Austen 
saying: "Where an opinion is general, it is usually correct." She did not say it, and in all likelihood would 
have strongly disagreed with the notion. Mary Crawford said it, a character in Austen's Mansfield Park, 
and the statement loses all its poignancy unless one takes this into account. Likewise, such an immortal 
remark as "A horse is at least human, for God's sake" is imbued with the unique character of Holden 
Caulfield, the narrator in J. D. Salinger's Catcher in the Rye: we are detracting from its energy and humor 
if we omit to mention this. Such details vitalize a quotation, prompting images and memories that express 
more than the words on their own ever can. In the same way no one should credit Oliver Stone with 
believing that "Lunch is for wimps." Stone put the words in the mouth of Gordon Gekko, played by 
Michael Douglas in the 1987 movie Wall Street. This is information we need to know, not only to quote 
honestly and incisively, but to avoid looking foolish when we learn that the context of the quotation may 
undermine its message.
It is also instructive to know something of the circumstances in which a quotation first appeared¾that, for 
example, when Oscar Wilde wrote, in De Profundis, "What is said of a man is nothing. The point is, who 
says it," he was writing to his lover Lord Alfred Douglas following the scandal and trial that ruined Wilde. I 



have also tried to enhance the interest of certain quotations by drawing attention to others by the same or 
a different author either in agreement or contradiction. The amount of citational information has been a 
matter of discretion in each case: essays have rarely required much comment, while letters and journal 
entries, for example, are enriched by one or two words of context. Characters speaking in fiction and 
drama are named throughout. Dates of first publication have been given in all cases except plays and 
short poems, where there is often a distracting discrepancy between dates of composition, performance, 
and publication. On the whole, information has been given as accurately and concisely as space allows, 
without succumbing to the temptation to swamp the quotation with extraneous facts. Thus where 
addressees of letters are little know, their names have been omitted, while if they are members of the 
writer's family, or have some standing in their own right, they are named. For foreign quotations 
translation dates are appended with more recent works only, where only one translation exists. 
Translators are named only when they are considered to be of interest in themselves.
As a rule, the information provided should be sufficient not only to place the quotation in context, but to 
permit anyone interested to locate the words fairly quickly.
Although accuracy has been a paramount consideration in the reproduction of quotations and citational 
information, the vagaries of publishing and the existence of variant texts mean that there is always scope 
for confusion. On the whole, the instances are few in this compilation, although there are a handful of 
cases in which it is necessary to specify particular editions that have been used. Quotations from 
Shakespeare have been drawn from the 1987 Oxford University Press edition of the Complete Works, 
edited by Stanley Wells and Gary Taylor, in which the arrangements of acts and scenes can diverge 
significantly from those in some other editions, notably in the plays Pericles, Hamlet, and King Lear (in 
King Lear I have followed the Folio text). In quoting from Oscar Wilde, I have gone to the original, four-act 
edition of The Importance of Being Earnest, later cut to three acts to satisfy theatrical exigencies, in a 
version which has been subsequently, although unnecessarily, reproduced in many editions. More 
controversially, quotations from James Joyce's Ulysses are from Hans Walter Gabler's "corrected" text, as
published by The Bodley Head and Penguin Books in 1986. And lastly, Biblical quotations are taken from 
the Authorized, or King James, Version.
To quote is to open a form of dialogue, requiring a degree of receptivity on the part of the hearer or 
reader. There must be an element of recognition of a truth or sentiment, something that sets bells chiming
and thoughts racing down newly remembered tracks. Even when it is a strikingly original notion, a fresh 
formulation, or a felicitous expression, there is always a reference to something in our own experience 
without which it is merely words. A quotation does not need to be familiar to trigger this response, but it 
must evoke in us a sense of familiarity. Whether or not the authors quoted in this collection are known to 
the reader, I hope that browsing through The Columbia Dictionary of Quotations will provoke the same 
thought that recurred to me throughout my research on it: . . . interesting¾ I would like to know more 
about this person. My greatest hope is that the selection manages to communicate some of the fun I had 
in compiling it.
              Robert Andrews



"Introduction" from The American Heritage Dictionary, Third Editon by Anne H. 
Soukhanov, Executive Editor
(Edited for use in Microsoft Bookshelf 1995)

Almost a quarter of a century ago a new dictionary bearing the name American Heritage appeared. That 
book was notable because it did four things and it did them well. It faithfully recorded the language in 
easily understood definitions. It provided guidance toward accuracy, precision, and grace in the use of 
English that intelligent people need and seek in a dictionary. It traced, whenever possible, the 
development of English words to their origins and keyed many to an Appendix of Indo-European Roots. 
And it presented complex lexical data in a typographically attractive design accented by thousands of 
photographs and line drawings in spacious margins. The American Heritage Dictionary of the English 
Language, Third Edition, builds upon this distinguished, innovative foundation.
The Third Edition is a lexicon of more than 200,000 boldface forms and hundreds of thousands of 
meanings reflecting the rich and varied texture of American English as it has been used over time by a 
broad group of educated speakers. This Dictionary is the product of four years of work by 175 
contributors. In preparing the Dictionary, our editors have had access to a database containing hundreds 
of millions of lines of text that could be searched for any word in context.
The A-Z vocabulary, containing more than 16,000 words and meanings new to this Edition, is a 
comprehensive, detailed record of the language. Use of citations allowed the editors to identify new words
and new meanings, identify levels of usage, and select more than 4,000 quoted illustrations from nearly 
2,000 sources for use in exemplifying entry words in printed context. The quoted illustrations range from 
the works of Shakespeare, Pope, and Ruskin to the works of contemporary writers such as Joyce Carol 
Oates, Joan Didion, John Updike, and Tom Wicker. More than 30,000 nonquoted illustrative examples 
were also derived from study of the citations. Finally, the citations were used to determine the status of 
variants. For example, 4,000 electronic citations were accrued for the spelling ambiance and about 2,000 
were found for the variant ambience. On the basis of this 2:1 ratio the Dictionary gives ambience as an 
"unequal," or less frequently occurring, variant of the entry word ambiance.
If language is a reflection of the ethos of the generation speaking it, then the new entries and meanings in
this Edition have much to say about us and our time. The great majority of the new words relate to social 
and life patterns; to the life sciences with an emphasis on health, medicine, genetics, and ecology; and to 
the physical sciences with an emphasis on computer technology and electronics, physics, and astronomy.
The goal of the Third Edition is to provide the user with comprehension and appreciation of the language 
in a readable manner. Keeping the needs of the contemporary user in mind, we have presented the 
central and often the most frequently sought meaning of a word first. The definitions are worded in 
concise, lucid prose without the specialized terms and abbreviations that make most dictionaries 
forbidding and confusing.
The Third Edition contains more than 500 notes and comments on matters of grammar, diction, 
pronunciation, and levels and nuances of usage. Citations were used in identifying new and evolving 
usage problems, attesting and evaluating the currency of certain usages, studying various levels of 
usage, and evaluating their sociolinguistic implications. The 173-member Usage Panel, with 75 new 
members and chaired by Geoffrey Nunberg, a linguist associated with Stanford University, has made an 
important contribution to the content and direction of the Usage Notes through responses to periodic 
surveys developed by the Chair and the editors. The Usage Panel of the Third Edition consists chiefly of 
writers, editors, and scholars, 22 of whom are professors of linguistics or English. Other Panelists occupy 
distinguished positions in law, diplomacy, government, business, science and technology, medicine, and 
the arts. Eighteen are recipients of the Pulitzer Prize and one is a Nobel Laureate. These men and 
women, who reside in 28 states and in Canada and England, are a cross section of today's critical, 
literary, and scholarly community.
A list of usage issues--old and new--was prepared by the Chair and the editors, and from it the usage 
program for the Third Edition was developed. Some of the usage issues are entirely new. An example is 
the Note at world-class. Other issues discussed in previous editions were resurveyed. An example is the 
use of contact as a verb. In some instances the Panel's views are more conservative than in the past: 
only 27 percent of the current Panel accepts hopefully as a sentence adverb, a usage that in 1969 was 
acceptable to 44 percent of the Panel. Other Notes, such as the one that discusses the use of above as a



noun, present guidance and linguistic analysis without Panel opinions. The Usage Notes are not confined 
solely to matters of stylistic excellence. Our concern with usage extends to issues of gender, ethnicity, 
and sexual preference.
Considerable attention is devoted in this Edition to the history of words. The etymologies have been 
thoroughly revised and expanded by a group of 25 specialists whose work reflects original scholarly 
research in many fields, including African, Persian, Turkish, and Native American languages. Special 
symbols, abbreviations, and complex technical vocabulary have been avoided in the etymologies. More 
than 400 word history paragraphs, most of which contain dates of first occurrence of the words in English,
appear at entries with especially interesting etymologies. These word histories, such as the one at nerd 
provide a social, historical, and cultural context for the evolution of words and explain the various linguistic
processes that contribute to the development of language.
A great many Modern English words can be traced to the reconstructed ancestral language called Proto-
Indo-European. The etymologies in the Third Edition, like those in the First, trace many words to their 
earliest ascertainable origins, usually in Proto-Indo-European, by means of cross-references to new and 
thoroughly revised Indo-European Root entries. The Indo-European Root entries, in a major departure 
from previous style, give the root followed by a brief gloss and a list of some of the Modern English words 
derived from it. The individual roots entry then follows. For example, the Modern English words fierce and 
treacle, at first glance strange semantic companions, both derive from the root *ghwer-, "wild."
The Third Edition contains hundreds of labeled words and meanings whose occurrence is restricted to 
certain areas of the United States. An important new feature unique to the Third Edition is the inclusion of 
more than 100 Regional Notes that explore the various linguistic and historical processes contributing to 
the development of these terms. These processes are apparent in the Regional Notes at entries such as 
absquatulate.
In an effort to assist the reader in using the language with color, vitality, and freshness, the Third Edition 
devotes more attention than ever before to synonymy by including more than 900 synonym paragraphs. 
The fully cross-referenced synonym paragraphs are of two kinds. The first, liberally illustrated with 
quotations, discriminates shades of meaning. The second kind lists exact synonyms, that is, words 
sharing a common irreducible element of meaning, and provides antonyms when applicable.
The American Heritage Dictionary of the English Language, Third Edition, like the First, is the product of 
significant advances in the use of computer technology. The Third Edition is derived from a complex, 
highly versatile structured database. Every element in the Dictionary was parsed, examined, and coded to
reflect its lexical function and position within the base. In combination, these elements form dictionary 
entries, and on a broader scale they reflect a multitude of relationships across the lexicon. Use of the 
database in connection with electronically generated citations places the Third Edition a generation ahead
of other dictionaries.
It is no longer possible for a few general editors working strictly within a publishing house to compile a 
true and accurate record of the language as it is used today. Semantic, etymological, linguistic, and 
technical complexities inherent in the language require the counsel of specialists from many disciplines. 
We wish to thank all of them for helping us in our pursuit of accuracy and truth. Special thanks go to John 
Simpson, Co-Editor of the New Oxford English Dictionary, for valuable comments made during the early 
stages of the project. And to all members of our Editorial Staff who gave unstintingly of their time and 
expended great effort in the development of the Third Edition, we express our deepest gratitude.
          Anne H. Soukhanov



A Natural History of English: Language, Culture, and the American Heritage by 
Lee Pederson
American speech and writing record the transactions of nearly 400 years of social history. Dialects 
embody patterns of sound, syntax, and meaning; literature documents those spoken forms in poetry and 
prose. Through the process of communication, a native language becomes the social inheritance of its 
speakers. In describing the linguistic resources of American English this Dictionary becomes a cultural 
property book for all the American people.    
A century before Noah Webster organized his first American dictionary (1806), Jonathan Edwards defined
the materials of inquiry in remarkably modern terms:

By conversation, I mean intelligent beings expressing their minds one to another in words, or other signs 
intentionally directed to us for our notice, whose immediate and main design is to be signification of the mind of 
him who gives it.

Defining conversation as one might characterize language today, Edwards recognized the conceptual, 
symbolic, and functional aspects of human communication: the engagement of thought, the use of signs, 
and the transmission of ideas from one mind to another. 
Today the English language makes conversation possible among 350 million native speakers who share 
its system of symbolic behavior. This number includes speakers of American, Australian, British, 
Canadian, Irish, New Zealand, and Scots English as members of the most influential speech community 
in the history of civilization. Their common cultural heritage makes possible the use of a single language 
by the members of these different groups, but each national variety with all its regional and social dialects 
reflects unique social experience. In a natural history of a national language, the richest gatherings of 
such material endure in folk speech¾the unaffected, conservative expression of common people, as 
preserved in their oral traditions. National folk usage forms a subset of social dialects within regional 
dialects that comprise the larger divisions, the national varieties of a language. 
Such experience makes a national vocabulary the most accessible and productive source of cultural 
information. Words are the complex linguistic structures that transmit the native lexicon through the 
systems of sound, grammar, and meaning. Words are also cultural emblems, symbols with social 
meaning that preserve the experience of human activity. Ralph Waldo Emerson said that words are signs 
of natural facts and wrote: "The etymologist finds the deadest word to have been once a brilliant picture. 
Language is fossil poetry." He demonstrated by his own example, moreover, that words are also signs of 
sociohistorical facts by giving the American meaning to transcendentalism. George Washington furnished 
the earliest citations for Democrat and Republican and was the first to receive the designation favorite 
son. Noah Webster made the earliest use of the phrase American English with characteristic impatience 
but ultimate accuracy: "In fifty years from this time [1806], the American English will be spoken by more 
people than all other dialects of the language." Such thought, conversation, and social interaction shaped 
the national character and gave substance to the lexicon. Contributions came from every sector of the 
American culture. 
As the central component of American English culture, the national language transmits the essential 
messages of all other cultural systems. All of these are inseparable from language: family (kinship and 
marriage), training (education and economics), values (morality, ethics, and religious rites), government 
(political and social control), technology (artifacts of survival), and fine arts (artifacts of the creative 
imagination and of spiritual expression). From the earliest days on its first frontiers, American English 
carried forward the messages of the culture and the experience of the past. As it did its work, the national 
language established an identity and expressed native ideas in an American voice. This Dictionary 
records that American voice and gives substance to its underlying systems, language and culture. 
Henry David Thoreau recognized a national dictionary as "a very concentrated and trustworthy natural 
history of the people": 

What they have a word for, they have a thing for. A traveller may tell us that he thinks they used a pavement or 
built their cabins in a certain form, or soaked their seed corn in water . . .; but when one gives us the word for 
these things, the question is settled¾that is a clincher. Let us know what words they had and how they used 
them, and we can infer almost all the rest. The lexicographer not only says that a certain people have or do a 
certain thing, but, being evidently a disinterested party, it may be allowed that he brings sufficient evidence to 
prove it. He does not so much assert as exhibit. He has no transient or private purposes to serve.    



The Historical Background of American English    
This natural history of the American people is the essential gift of the mother tongue. With all speakers of 
the English language Americans share the results of 1,500 years of linguistic development, and English 
had itself evolved for a full millennium before the first American words were spoken in Virginia. 
Furthermore, as a member of the Germanic language group of the Indo-European language family, 
English shares an ultimate heritage with most of the modern languages of Europe and Asia and with the 
official languages of every government in North and South America. 
The essential features of the Germanic languages are these: (1) a thoroughgoing modification of the 
consonant system, especially the so-called First Germanic Consonant Shift, which distinguishes the 
system from all other Indo-European consonant patterns. It is captured in Grimm's Law and accounts for 
the differences between initial sounds in such cognate pairs as Latin/English pater/father, tu/thou, and 
hortus/garden; (2) mutation of vowels by neighboring sounds (umlaut) and the adaptation of the vowel 
system to express grammatical functions; (3) regular word stress on the first syllable; (4) seven classes of
strong (irregular) verbs, such as sing, sang, sung; (5) three classes of weak (regular) verbs, such as love, 
loved, loved; (6) strong and weak adjectives that disappeared in Medieval English but endure elsewhere, 
as in Modern German and Norwegian definite and indefinite articles; and (7) a core vocabulary of 
common words. These shared characteristics define the 13 modern Germanic languages: Danish, 
Faroese, Icelandic, Norwegian, Swedish, German, Yiddish, Low German, Dutch, Afrikaans, Flemish, 
Frisian, and English. 
The history of the English language begins with the arrival of Germanic invaders from the continent, said 
to be in A.D. 449 according to the Anglo-Saxon Chronicle. In the eighth century the Venerable Bede 
identified these Germanic peoples as Angles, Saxons, and Jutes. In Britain they encountered their Indo-
European relatives, the British Celts, who had settled in Britain centuries before. Like the Native 
Americans, the Celts left their greatest linguistic legacy in place names, such as Avon, Brynmawr (Welsh 
for "great hill"), Dover, Thames, and London. The Celts and Germans, however, were never separated by 
a distance greater than the narrow English Channel and shared a common Indo-European ancestry. 
Conversely, in North America, native inhabitants and newcomers emerged from different environments 
thousands of miles apart, from homelands distinguished by their native forms of vegetation, animal life, 
and social behavior. 
As the dialects of the invaders merged in England they gave rise to the Northumbrian, Mercian, and 
Saxon varieties of the language that is called Old English today. Three tenth-century texts show the close 
similarities of those dialects in their respective translations of the Medieval Latin (Matthew 6:9) "pater 
noster, qui est in caelis, sanctificetur nomen tuum": 

NORTHUMBRIAN
Fader urer thu arth in heofnas, sie gehalgad noma thin
Father our thou art in heaven, be hallowed name thy

MERCIAN
Fader ure thu the in heofunum earth, beo gehalgad thin noma
Father our thou which in heaven art, be hallowed thy name

WEST SAXON
Fader ure thu the eart on heofonum, si thin nama gehalgod
Father our thou which art in heaven, be thy name hallowed

Despite differences in pronunciation, word formation, and syntax, simple and effective conversation was 
surely possible among speakers of these different regional dialects of English. Conversation was also 
possible between the English and their Viking conquerors, the Norwegians and the Danes, many of whom
settled primarily in what are now the northeast counties and took up peaceful ways with English wives. 
The fact that cultural interaction extended through most of the Old English period (449-1066) is evidenced
in the greatest literary monument of the Anglo-Saxons, their epic poem Beowulf, which has a thoroughly 
Scandinavian setting and cast. 
Words shared by Anglo-Saxons and Vikings include bring, can, come, father, folk, house, life, man, mine, 
mother, see, sit, smile, sorrow, summer, thine, wife, will, winter, and wise. In addition to hundreds of such 



intimate correspondences, the Scandinavians gave English many other familiar words through cultural 
interaction: anger, fellow, happy, husband, meek, root, rotten, skill, skin, skull, sky, and ugly. A second and
much greater influence was brought to bear on the language and culture after the Battle of Hastings in 
1066, when the Normans, French-speaking descendants of the Vikings, arrived from Normandy. 

French Influences    
The Norman-French presence marked the beginning of great changes in English social behavior, 
reflecting a gradual evolution of institutional and conversational forms. The chronicles and other writings 
show that Old English was in transition before the coming of the Normans, and later poetry and prose 
record unmodified Germanic forms deep into the Middle English period. In England, French became the 
official language of the dominant culture and spread its influence into every social system. Earlier, on the 
continent, the Normans had adopted Frankish laws, developed a system of knightly conduct, and 
perfected the skills of cavalry warfare. Through force and friendship they gave the English a chivalric 
code, a parliamentary system of government, and one of the most distinctive architectural styles in all of 
European civilization. During the period of Norman dominion, English vernaculars evolved without a 
native standard dialect. The cultural influence of the Vikings emerged most clearly in Scandinavian loan 
words that marked regional speech in those northern counties where they had settled earlier, as the 
regional dialects of England were broadly reorganized. In the process, Middlesex became the preeminent 
focal area, and from its center arose the London Standard, the most influential social variety the English 
language has ever known. 
Several dialects of 14th-century England were the immediate ancestors of the London Standard, but it 
drew most from the speech of the Southeast Midland region. The recorded usage of that era illustrates 
great linguistic change, a process that began more than 200 years earlier through the mingling of English 
and French. Causal relations for the change are hard to establish because phonological, grammatical, 
lexical, and cultural modifications were under way before the Battle of Hastings. 
Romance language words, such as cheese, copper, and dish, entered Germanic dialects from Latin 
before the invasion of England in A.D. 449; from the same source came cleric, psalm, and temple with the
Christianization of England in the seventh century. Later Romance loans in Old English include pride 
(French), capon and castle (French or Latin), and apostle, epistle, lily, and peony (Latin). Old English texts
of the tenth century¾the Vercelli Book, Exeter Book, Junius Manuscript, and Beowulf Manuscript¾show 
the early simplification of weakly stressed vowels and inflectional patterns. During the reign of Edward the
Confessor (1042-1066) a Norman association was firmly established between the king and his cousin, 
William the Conqueror, underscored by the installation of Robert of Jumièges as archbishop of 
Canterbury in 1051. 
During the next 300 years the French presence altered the development of English through direct 
contributions and reinforcement of linguistic trends already under way. Four voiced fricative consonants 
emerged as distinctive elements of the sound system during this period, the initial sounds of veal, zeal, 
and thee, as well as the medial sound of leisure. None of these were distinctive in Old English, which had 
only the fricatives of feel, seal, thing, and pressure, respectively. The single outright contribution of 
Norman French to the English sound system was the diphthong of joy. French usage did accelerate the 
leveling of weakly stressed vowels, the simplification of noun, pronoun, and adjective inflections, and the 
transfer of many strong (irregular) verbs to weak (regular) conjugations. For example, Old English forms 
of modern doom included domes (genitive singular), domas (nominative plural), and domum (dative 
plural); all became doomes in Middle English. Strong verbs such as creopan, helpan, and slœpan 
became the weak verbs creep, help, and sleep, although a residue of the old patterns endures in the past 
forms crept and slept, as well as holp (pronounced like hope) in several current American dialects. 
More French loan words entered English during the 14th century than during any comparable period 
before or since. As the French language fell into disuse in England, many of its culturally useful words 
were borrowed. Here the relationship between speech and writing is an important consideration. The 
documented evidence of the written forms is conservative and lags behind current usage. After King John 
lost the province of Normandy in 1204, French influence on English society began to decline. Before the 
Hundred Years' War (1337-1453) began, English speech had already returned as the native tongue of the
nobility, and before the century closed, it had replaced French in the courts, Parliament, schools, and 
finally the highly formal documents of title, deeds, and wills. 



Chaucer composed The Canterbury Tales in his native Southeast Midland dialect and so demonstrated 
the appropriateness of London speech as a literary medium, but The Canterbury Tales did not mark the 
triumph of a standard language within the culture at large. Just two years before he began his 
masterwork, Chaucer worried about the diversity of current speech in his envoy for Troilus and Criseyde 
(c. 1385): 

And for ther is so gret diversite
In Englissh and in writyng of oure tonge,
So prey I God that non myswrite the[e],
Ne the[e] mysmetre for defaute of tonge;
And red wherso thow be, or elles songe,
That thow be understonde, God I biseche!
But yet to purpos of my rather speche.

He prayed that none miswrite, mismeter (wrongly scan the measures), or misunderstand the purpose of 
his earlier (rather) speech, his spoken words that became this "litel bok." 

The Emergence of Modern English    
Chaucer had good reason for concern. The Great Vowel Shift was beginning a modification in quality of 
all long vowels and diphthongs, and the inconsistent treatment of weakly stressed vowels placed many 
syllables in jeopardy. The shift raised [a] to [æ] (and later to [e]), [e] to [i], [ô] to [o], and [o] to [u]. The 
vowels formerly pronounced [i] and [u] became, respectively,        [ei] (later [ai]) and [eu] (later [au]).* Thus 
Chaucer's final vowels in diversite and the[e] rhyme with modern they; his verb write rhymes with modern 
feet; biseche and speche rhyme with modern aitch; and the vowel in oure rhymes with the vowel in boot. 
Although metrical evidence is difficult to interpret, Chaucer quite possibly pronounced the weakly stressed
e in myswrite and elles but ignored it in tonge, understonde, speche, and other words in the same stanza 
that comprise those seven iambic pentameter lines of rhyme royal. 
At the outset of the Early Modern English period (1500-1700) fewer than 5 million people in the world 
spoke English, as compared to 12 million speakers of French, 10 million of German, and 8 million of 
Spanish. During the next two centuries those "intelligent beings expressing their minds" in English 
included More, Tyndale, Milton, Newton, Locke, and Dryden. At its center was Elizabethan English, the 
language of Shakespeare, Marlowe, Bacon, Donne, Raleigh, Spenser, and the queen herself. From this 
stage of linguistic development came the earliest varieties of American English. By 1700 the number of 
English speakers had nearly doubled, while German, Italian, and Spanish had scarcely maintained their 
numbers of two centuries earlier, and only French surpassed the growth rate of English among the 
western European nations. 
As an emergent world language, English advanced with the spread of the London Standard and general 
education, with the loosening of class distinctions, and through the influence of what would today be 
called the mass media. By the year 1500 printed books in all of Europe included 35 thousand titles, most 
of which were in Latin. During the next 140 years 20 thousand English titles appeared in print, and scribal 
composition of manuscripts became virtually a lost art. England regained its cultural self-reliance with 
those new sources of influence and the spread of empire. In 1579 E.K., the anonymous editor of 
Spenser's The Shepheardes Calender, commended his author and reflected the spirit of the age: 

For in my opinion it is one special prayse, of many whych are dew to this Poete, that he hath laboured to restore,
as to theyr rightfull heritage such good and naturall English words, as haue ben long time out of vse and almost 
cleane disherited. Which is the onely cause, that our Mother tonge, which truely of it self is both ful enough for 
prose and stately enough for verse, hath long time ben counted most bare and barrein of both.

The English recognized the legitimacy of their native tongue for all modes of communication, including 
those technical fields formerly dominated by Latin and Greek. In his Elementary (1582) Richard Mulcaster
defended the use of English and explained the implications of his work: 

For the account of our tongue, both in pen and speech, no man will doubt therof who is able to judge what those 
things be which make any tongue to be of account; which things I take to be three: the autority of the people 
which speak it, the matter and argument wherein the speech dealeth, the manifold use for which the speech 
serveth. For all which three our tongue needeth not to give place to any of her peers. 

Mulcaster and others wrote rules for pronunciation and grammar and tried to enrich the national word 



store. Earlier the Italians, Spanish, French, and Germans had done the same things for their own varieties
of speech, as the transformation of local vernaculars into national languages characterized the 
Renaissance in every European country that it touched. 
During the reign of Elizabeth I (1558-1603) a language pattern developed that was to become the base 
form of early American English. London usage reflected the linguistic patriotism of the English 
Renaissance and accepted forms from a variety of regional and social dialects in the development of a 
spoken standard. Roger Ascham, Elizabeth's Latin tutor, was a Yorkshireman; Raleigh preserved his 
distinctive Devonshire speech throughout his life; Essex was from Hertfordshire; Sidney, from Kent; 
Shakespeare, from Warwickshire; Donne, although of Welsh ancestry, emerged from the London 
merchant class. The language habits of all those speakers contributed to the shaping of the urban pattern
and to the development of vigorous conversational speech. 

The Beginnings of American English    
The fluid structure of Early Modern English underlies the formation of American English. Although the 
Great Vowel Shift had assigned new values to the long vowels, many British, Scots, and Irish social 
dialects were slow to accept all of these emergent features. Morphology and syntax showed 
inventiveness and flexibility in word formation and adaptations, as with the free use of affixes in word 
building (re-, de-, -ish, -ize), functional shift of parts of speech (nouns used as verbs, verbs as nouns, and 
both as adjectival or adverbial modifiers), frequent parenthetical expression, and phrase structures of 
predication, complementation, and coordination that reflect the intonational contours of the spoken 
language. 
Drawn from that rapidly flowing stream, American English shows a much greater uniformity than its origins
might suggest. Einar Haugen has called this evolution of the national language in America "Babel in 
reverse." The concept of the American melting pot can be found in the writing of Michel Guillaume Jean 
de Crèvecoeur (J. Hector St. John), a Norman-French immigrant and the eponym of St. Johnsbury, 
Vermont. In Letters from an American Farmer (1782) he provided the logic for a unified American 
language and culture: 

What, then, is the American, this new man? He is either a European or the descendant of a European; hence 
that strange mixture of blood, which you will find in no other country¼. He is an American, who, leaving behind 
him all his ancient prejudices and manners, receives new ones from the new mode of life he has embraced, the 
new government he obeys, and the new rank he holds. He becomes an American by being received in the broad 
lap of our great Alma Mater [Dear Mother]. Here individuals of all nations are melted into a new race of men, 
whose labors and posterity will one day cause great changes in the world. Americans are the western pilgrims 
who are carrying along with them that great mass of arts, sciences, vigor, and industry which began long since in
the East; they will finish the great circle. The Americans were once scattered all over Europe; here they are 
incorporated into one of the finest systems of population which has ever appeared, and which will hereafter 
become distinct by the power of the different climates they inhabit. The American ought therefore to love this 
country better than that wherein either he or his forefathers were born. 

The first substantial collection of immigrant literature appeared in New England, where writers worked 
with Elizabethan patterns and recorded a variety of occasional spellings and distinctive forms. In The 
History of Plimoth Plantation, 1620-1647, William Bradford wrote burthen, fadom, furder, gifen (given), 
gusle (guzzle), trible (triple), and vacabund (vagabond). Roger Williams rhymed abode/God, blood/good, 
and America/away in A Key into the Language of America (1643). Anne Bradstreet paired conceit/great, 
stood/flood, and satisfy/reality in The Tenth Muse Lately Sprung Up in America (1650). Two generations 
later Edward Taylor alternated spoil and spile, as well as soot and sut, and rhymed is/kiss, far/cur, and 
vile/soil.
Early American grammar also showed a great variety of forms. In 1630, while sailing westward aboard the
Arbella, John Winthrop preached "A Modell of Christian Charity" with the line "We must love brotherly 
without dissimulation; we must love one another with a pure heart fervently." Bradford used rid, runned 
(and ranne), drunk, writ, and shrunk as past forms of ride, run, drink, write, and shrink, respectively. 
Williams declared, "My disease is I know not what" and offered the interrogative form "Sleep you?" Mary 
Rowlandson wrote, "It is not my tongue or pen can express the sorrow of my heart" in her captive 
narrative of 1676. 
During these same years cultural activity all along the Atlantic seaboard produced the first Americanisms. 
The following native words, among hundreds of others, originated, gained special meaning, or entered the



English language through American speech in the 17th century: creek (stream), fat pine, green corn, and 
papoose from Massachusetts; catfish, corn (maize), mock[ing]bird, polecat (skunk), and raccoon from 
Virginia; Chippewa, groundhog, Manhattan, and Podunk from New York; gang [of birds], hominy, 
snakeroot, and Virginian from Maryland; frontier people, oyster rake, samp, and wampum from Rhode 
Island; grocery (store), hotcakes (corn cakes), peavine (a climbing plant similar to the pea), and sunfish 
from Pennsylvania; settlement and swampland from Connecticut; Dutch grass (any one of various 
grasses) and hickory nut from South Carolina; frontier from New Jersey. Beyond the frontiers pilot (a 
guide over a land route) appeared in what is now Colorado, and Miami from what is now Illinois. 

Native American Influences    
These words suggest the importance of Native American loans, especially for artifacts and places. From 
the Algonquian dialects alone English and French in the New World borrowed more than a hundred terms
that remain current today. In addition to Chippewa, hominy, Manhattan, papoose, Podunk, samp, squash, 
and wampum, the eastern tribes provided caribou, mackinaw, pone, Tammany, terrapin, and toboggan. 
Such terms often suggest multiple language contacts; as caribou and toboggan entered through 
Canadian French in the north, barbecue, canoe, and cushaw came out of the West Indies through 
Spanish. Spanish later transmitted coyote and peyote from the Nahuatl language of Mexico. From 
Quechua, probably through the cooperative efforts of French and Spanish, the New Orleans term 
lagniappe appeared somewhat later. American place names are the greatest Native American 
contribution. From Appalachia and the Alleghenies, across all five of the Great Lakes (Erie, Ontario, 
Huron, Michigan, and Superior [Ojibwa Gitchi via French Supérieur]); from Chicago to Sitka, native words 
cover the continent. Emblematic of American language and culture are the blends, such as Bayou La 
Batre, Alabama (Choctaw bayuk, "creek" + French de la Batre, "of the [artillery] battery"), and 
Minneapolis, Minnesota (Dakota minne, "water" + Greek/English (a)polis, "city"), or the loan translations 
Spearfish, South Dakota, Ten Sleep, Wyoming, Warroad, Minnesota, and Yellow Dirt Creek, Georgia, 
besides the native loans of the state names Alabama (people), Dakota (people), and Minnesota (Dakota 
minne, "water" + sota, "white").

Loans From the European Languages    
Early loans from European languages correspond with Dutch, French, and German settlements in the 
coastal colonies and along the first interior frontiers. During their New Amsterdam experience the Dutch 
added to American English the words boss, Bowery, coleslaw, cookie, sleigh, stoop, and waffle. Later they
gave more place names, such as Catskill, Kinderhook, and Schuyler. Although Thoreau spoke of "Yankee
ingenuity" in 1843, the durable nickname probably had its origin in Jan (Janke), the Dutch diminutive for 
John (Johnny); Saint Nicholas, clipped to Sinterklaas in a Dutch dialect, became Santa Claus before the 
Revolutionary War. 
French loans contrast sharply with the Dutch and later German contributions. Although they also gave 
English such ordinary household words as chowder, pumpkin, sashay, shanty, and shivaree, the 
enterprising French illustrate their experience in a distinctive set of loans. Explorers, missionaries, and 
frontier warriors made American words of bateau, crevasse, levee, portage, prairie, and voyageur. As the 
English, Dutch, and Swedes struggled to control the seaboard, the French ranged across the interior and 
left their mark with the names of places at Bienville, Cape Girardeau, Prairie du Chien, and Sault Sainte 
Marie. 
Early German loans on the frontier are difficult to ascertain. Like the Scandinavians and Anglo-Saxons in 
England, the Germans and English spoke languages with a common word stock that still endures in the 
basic vocabularies of both cultures. For the same reason it is impossible to determine whether nosh 
(snack) and schlemiel are of Yiddish or German origin and whether spook and dumb (stupid) are of Dutch
or German origin, because in each case the words occur in both languages. Only when the Germans 
established discrete territories, as the Dutch had in New York, did the loans begin to appear in significant 
numbers from Pennsylvania, Cincinnati, Chicago, Milwaukee, St. Louis, and east-central Texas. From 
early Pennsylvania, American English probably received smearcase, ponhaws
(pannhass, "pan" + "hare," or "scrapple"), rainworm (earthworm), and possibly George Washington's most
familiar title, The Father of His Country, which first appeared as Der Landes Vater on a Nord 
Amerikanische Kalender for 1779. 



The American Frontier    
The frontier contributions of the Swedes and folk speakers of British, Irish, and Scots dialects are virtually 
impossible to identify because these Northern Europeans were soon united in a common culture. As 
Crèvecoeur described the people at the outbreak of the Revolution: 

They are a mixture of English, Scotch, Irish, French, Dutch, Germans, and Swedes. From this promiscuous 
breed, that race now called Americans have arisen. The eastern provinces [i.e., the coastal colonies] must 
indeed be excepted as being the unmixed descendants of Englishmen. 

Early frontier speech probably included the pronouns hit (for it), hisn, ourn, theirn, and yourn, the inflected
verb forms clumb, drug, holp, and riz, the auxiliary construction mought could (or might could), and a 
large number of folk pronunciations and lexical items, forms transmitted through the oral tradition of the 
common people. Scots forms, also appearing in the poetry of Burns, include duds (clothes), gumption, 
hunkers, mountain billy (hillbilly), tow (hemp fiber), and the distinctive pronunciations reflected chimla 
(chimney), het (heated), and southron (southern), as well as the simplification of consonant clusters, as in
kin' (kind) and sin' (since), and the total assimilation of l after back vowels, as in ca' (call), fu' (full), and 
howe (hollow). From Irish sources probably came mammy, moonshine, and mountain dew. General 
English folk forms also included clean, flat, and plumb (all meaning "completely"), passel (from parcel), 
and sass (from sauce). Many of these forms appear in Middle English, and all survive in current American
Midland and Southern dialects. 

The Evolution of Dialects in American English    
During the 18th century the principal regions of American English developed. These are the historic 
cultural areas. Every major regional dialect area, past and present, corresponds almost perfectly with a 
cultural area delimited by other social systems. The presbyteries of Appalachia mark the pattern of 
Scottish settlement, the Dutch and German barns show a Germanic presence in the eastern and east-
central states, the methods of cooking cornmeal in pones, dodgers, and hushpuppies reflect the 
settlement patterns of various groups, and the superstitions connected with chicken clavicles (wishbone, 
pulley bone, or lucky bone) identify social groups, as do the Southern greetings hey and Christmas Gift! 
The styles of folk, blues, jazz, and rock music also correspond with cultural areas, contrasting the 
perfected forms of the Carter Family in southern Appalachia, Huddie Ledbetter in the Red River Delta, 
and Robert Johnson in the Yazoo Delta, the rural blues of Richard Amerson and the urban blues of Bill 
Broonzy, the Kansas City jazz of Count Basie and the Chicago jazz of Bud Freeman, or the middle 
Georgia rock of the Allman Brothers and the southern California rock of the Beach Boys. All of these are 
as regionally distinctive as are the voices of the musicians. Wherever clear-cut boundaries of culture can 
be reconstructed on the basis of historical information from archaeology, music, graphic arts, or the social 
sciences, dialect differences can be predicted, based on the most persuasive kind of circumstantial 
evidence: the recorded experience of the forebears of a speech community. 
Because language changes, many of the following historical dialect features¾ such as bucket, firefly, 
hushpuppy, and lariat¾may no longer reflect current usage, especially among the young and better 
educated. Elsewhere, general currency forms¾such as harmonica, headcheese, mantelpiece, and 
wishbone¾serve as useful internal, subregional dialect features, contrasting with folk forms in systematic 
dialect study, as, for example, French harp, souse, fireboard, and pulley bone, respectively. Finally, the 
diachronic perspective of essay and the synchronic perspective of the Dictionary itself make it impossible 
to integrate such examples in their historical settings in terms wholly consistent with usage today or with 
ultimate etymologies. For those reasons, the designation of some forms listed below will not conform with 
either the current regional labels or the ultimate etymological sources identified in the text of the 
Dictionary. The social evolution of such words, however, provides historical context and cultural 
foundations for the contemporary usage the Dictionary describes. 
Modern American seaboard dialects preserve the early system from Maine to the Florida Keys and along 
the Gulf shores to Brownsville, Texas. The coastal communities shared the evolution of urban British 
pronunciation, grammar, and vocabulary, but very different speech forms developed throughout the 
interior along the old frontier. Neither of these regions is a uniform cultural area, but remarkable 
concordances of speech endure. Early centers at Boston, New York, and Philadelphia were quite different
from their southern counterparts at Richmond, Charleston, and New Orleans. Along the Atlantic and Gulf 



coasts, however, the dialects shared important features: the loss of constricted r after vowels (making 
popper homophonous with Papa); a contrast of stressed vowels in Mary, merry, and marry; a most 
distinctive diphthong in dues, news, and shoes that approaches that in few, music, and pupil; the loss of h
in whip, white, wheelbarrow, and similar words; and even a "broad a" in hammer, pasture, and Saturday. 
Besides the familiar British past form et (of eat), the coastal dialects also shared lexical features, such as 
hog's head cheese, haslets (or harslets), and piazza (porch). 
The coastal pattern divides near the Potomac River. To the north the language and culture drifted away 
from British influence more quickly than they did in the South, where the early planters of Jefferson's 
agrarian democracy required close association with British commerce, education, and industry. Southern 
coastal dialects preserved several other British features: the "clear l" of lean in Billy and Nelly, as opposed
to the "dark l" of look and law, a flapped r in three and thresh, as heard in some British pronunciations of 
very, and even an occasional back vowel in pot and crop. Along the Gulf Coast these forms had mixed 
currency, largely because of the powerful influence of New Orleans, a cultural center that dominated the 
entire interior South until the Civil War. Basic Northern and Southern contrasts persist from the Potomac 
to the mouth of the Rio Grande: the Southern drawls (patterns of diphthongs, lengthening, and 
intonation), the vowel of ride [a] (which Northerners confuse with rod [ä]), the vowel ofbird [3I] (which 
Northerners confuse with Brooklynese), a positional variant [eU] in house and mouse but not in rouse and
cows, the plural pronoun you-all (or y'all), the past form drug (of drag), and a large set of vocabulary 
forms, such as mosquito hawk (dragonfly), crocus sack (burlap bag), snap beans (string beans), and tote 
(carry). 
The New Orleans focal area interrupts this pattern, extending its influence from Mobile Bay to beyond the 
Sabine River. A Coastal and New Orleans contrast is marked by serenade, bateau, clabber cheese, and 
mush along the Southern coast, except in the area of New Orleans dominion, where shivaree (charivari), 
pirogue, cream cheese, and cush-cush (mush) prevail. Although cush has currency throughout the South,
nowhere else is there a double form to match the New Orleans usage. Other distinctive terms are 
flambeau (makeshift torch), (h)armonica (instead of Southern harp), lagniappe something extra, instead of
South Carolina brawtus, Texas-Spanish pilon, and Florida-Minorcan countra), wishbone (instead of South 
Midland and Southern pulley bone), and creole tomatoes (instead of Northern cherry tomatoes and 
Southern tommytoes). 
Unlike coastal speech, the Midland dialects of that transition area between the North and South grew up 
in the interior. From Pennsylvania to Georgia the eastern boundary of the Midland dialect area coincides 
with the geography of the old frontier. Settlers took the land in the great migrations out of Pennsylvania, 
Maryland, and Virginia during the half century (1725-1775) that preceded the Revolutionary War. Thomas 
Walker's discovery of the Cumberland Gap in 1750 provided a southern gateway to the Midwest, that 
passage into Kentucky for the ancestors of both Jefferson Davis and Abraham Lincoln. Before the War of 
1812 the frontier extended in the north out of Pittsburgh and down the Ohio River and in the south out of 
the Yadkin Valley of North Carolina, across Tennessee and Kentucky along the Wilderness Trail of 
Pennsylvania's Daniel Boone. 
Like other American dialects, the Midland varieties rose from a British-English base in Pennsylvania, but 
the social composition on the frontier was different. Six of the seven ethnic groups mentioned by 
Crèvecoeur did not speak British English before they arrived in North America. Later those residents of 
the interior Midland dialect areas were without ports of entry to receive the influence of English culture 
and to share in the development of the prestigious London forms. More important, the frontier people 
occupied themselves mainly with survival in a hostile region. Those factors influenced the disparate 
groups in a uniform way: Midland dialects resisted the phonological changes under way in England and in
the coastal colonies to the north and south; English, Irish, and Scots folk speech reinforced the regional 
grammar and vocabulary, giving these American dialects identities of their own. 
The Midland pattern contrasts most sharply with the interior varieties of Northern and Southern speech. 
With a domain that in modern times extends from western New England and upstate New York, along the 
southern shores of the Great Lakes and then northwestward into the upper Midwest, the Inland Northern 
dialect spread from its eastern source after the War of 1812. The construction of the Erie Canal from 
Albany to Buffalo gave upstate New York and New England access to the Great Lakes, as had the wagon
roads that preceded the watercourse and the railroads that followed it. As Northern speech extended out 
of upper New Jersey and northern Pennsylvania, a major dialect boundary was established with the 
southern limit of darning needle (dragonfly), pail, and whiffletree, contrasting with North Midland snake 



feeder, bucket, and single-tree. From upstate New York and across Ohio, Indiana, Illinois, and Iowa 
westward, the division of Northern and North Midland remains apparent in the pronunciation of fog and 
hog, which are pronounced with the vowel of father in the North and the vowel of dog in the North 
Midland; in the pronunciation of the diphthong of cow, house, and towel, which is [äU] in the North, 
beginning with a lower vowel that is closer to that of father, and [æU] in the North Midland, beginning with 
a vowel that is closer to that of lather; and in the existence of an excrescent r in "warsh" and 
"Warshington" in some Midland speech. Formerly distinctive are the Northern terms stone wall, pail, swill, 
teeter-totter, faucet, pit (of a cherry or peach), and firefly, contrasting with the Midland terms stone fence, 
bucket, slops, seesaw, spicket (spigot), seed, and lightning bug. In the West the Northern/Midland 
distinction is most clearly heard in the pronunciation of car, yard, and similar words: the Northern 
pronunciation is marked by a vowel closer to that of father; the Midland pronunciation, by one closer to 
the vowel of saw. 
Prior to the Civil War other interior forms spread from south of the Great Lakes to the fringes of the 
plantation cultures from Virginia to Texas and gave rise to the principal Midland varieties, North Midland 
and South Midland. Between those contrasting cultures the Midland area is perhaps best divided by a 
phonological Mason-Dixon Line established by the pronunciation of the medial consonant of greasy, with 
[s] to the north and [z] to the south. On the Atlantic Coast the boundary replicates the historic Mason-
Dixon Line, the common border of Pennsylvania and Maryland. Philadelphia, with the pronunciation [s], 
must be considered a Northern territory. Westward, however, the difference in pronunciation marks the 
division within the Midland territory, from Ohio to Missouri. Heading south, a traveler encounters the line 
at approximately the same place where grits replace hash browns on the breakfast menu, and where the 
words nice, white, and rice are all pronounced with a vowel Northerners confuse with the vowel common 
to cat, hat, and sat, whether the side dish is served with Indiana- or Kentucky-fried chicken. With this 
feature comes the first suggestion of the drawl, indigenous bluegrass music, and stock car instead of 
Indy-type or midget automobile racing. Along the same line the northern extent of Southern cultural 
penetration appears in these contrasts: North Midland bunk, wishbone, husks, headcheese, fritters, bag, 
and turtle, versus South Midland pallet, pulley bone, shucks, souse (or pressed meat), flitters, sack, and 
terrapin. 
South Midland speech is a Southern dialect, formerly called Hill Southern in contrast with the Upcountry 
and Lower Southern patterns (Plantation Southern) to the south and east. The principal South 
Midland/Southern boundary follows the Blue Ridge across Virginia, the Carolinas, and Georgia. In South 
Carolina and Georgia the boundary coincides with the 180-day growing season for cotton, the waterways,
the soil types, and the cultural organizations inseparable from the plantation systems devoted to the 
cultivation of indigo, rice, and cane, as well as cotton. 
Those geographic features and cultural factors underlie the Midland enclaves, as far south as the Florida 
Panhandle, and their Southern counterparts as far north as the St. Francis Basin of Arkansas and the 
bootheel of Missouri, the cotton country around New Madrid. South Midland is marked by the presence of 
a constricted r after a vowel in bird, car, and horse and monophthongs in right and ride, whereas Southern
preserves a diphthong in right and similar words. Lexical contrasts include South Midland green beans, 
red worm, fireboard, French harp (for harmonica), and tow sack (for burlap bag), versus Southern snap 
beans, earthworm, mantelpiece, harp, and crocus sack. In the east, South Midland contrasts with Virginia 
Piedmont Southern: snake feeder, peanuts, and terrapin, versus snake doctor, goobers, and cooter. In the
Mississippi Valley the South Midland dialect occupies the territory bypassed by the plantation cultures as 
unsuitable for the production of cotton, cane, and rice. 
Where the planters extended their operations north and west, as in upper Louisiana, western Tennessee, 
Arkansas, and eastern Texas, Lower Southern features outline the area. The Coastal and Gulf plains 
were settled from the east, but the deltas of the Mississippi, Atchafalaya, Red, Yazoo, and St. Francis 
rivers received their populations from the south. As a result, interior Southern areas do not show the 
predictable gradations of uniformity from east to west that are found in the North and North Midland 
regions. 
Instead, the pattern extends from north to south, from the Piedmont at the southern fringe of eastern 
Appalachia, through the Coastal Plains and Piney Woods, to the Atlantic and Gulf coastal regions. In the 
Piney Woods dialects of the interior lower plains of Georgia, Florida, Alabama, Mississippi, and Louisiana,
as well as the dialects of upper East Texas, below the plains and above the coastal strip, a striking 
configuration emerges. Piney Woods pronunciation includes three systematic features: (1) constricted 



postvocalic r, as in beard, bird, and butter; (2) excrescent constriction, yielding Chicargo (Chicago), croker
sack (crocus sack), skeeter hawk (mosquito hawk), and tomaters (tomatoes); and (3) vocalized l in hotel, 
hospital, and bulge. These forms mark the regional vocabulary: piney-woods rooter (range hog), smut 
(soot), mantelboard (mantelpiece), corndodger (cornmeal dumpling), pinders (peanuts), press peach 
(cling peach), and fat lighterd (resinous kindling). 
Lower Southern dialects are distinguished by coastal forms and by the distinctive contributions of the New
Orleans focal area. Coastal Southern pronunciation includes the loss of constricted r after vowels, the 
contrast between the stressed vowels of Mary, merry, and marry, a "clear l" in Billy and Nelly, and 
vocabulary items such as mosquito hawk, crocus sack, hoghead cheese (or hog's head cheese), and red 
bug (instead of chigger). Besides locker (for closet) and flambeau (for makeshift lamp), the domain of 
New Orleans is marked by the pervasiveness of gallery (for porch), lagniappe, pirogue (dugout canoe), 
cream cheese (cottage cheese), wishbone (instead of South Midland and Southern pulley bone), and 
(h)armonica (instead of South Midland French harp or Southern harp). Such forms appear as far north as 
Lake Providence and Monroe, Louisiana; Yazoo City, Mississippi; and along the Gulf Coast beyond the 
Sabine River into Texas and eastward to Mobile Bay. 
Western dialects begin beyond the 98th meridian, 40 miles west of the Red River in North Dakota and 50 
miles west of Fort Worth in Texas, where annual rainfall usually fails to exceed the 22 inches required for 
traditional Midwestern farming. Thus, modern agricultural methods, such as dry farming and irrigation 
through reservoirs, and tools, such as the Oliver moldboard plow and the springtooth harrow, opened the 
West for general settlement only after the Civil War. Before that, pioneers followed the Oregon and 
Mormon trails into the Upper Rockies and the Pacific Northwest, and the Santa Fe and Old Spanish trails 
into the Lower Rockies and California. Today, Western dialects divide primarily south to north, marked by 
the extent of the Spanish influence through Texas, New Mexico, and southern California, at least as far 
north as lower Colorado or even Montana among ranchers. 
History complicates the speech of the West, by the blending of Northern, Midland, and Southern forms as 
well as by a heavy Spanish influence from Texas to California. The North Midland boundary extends over 
Iowa and cuts across South Dakota in a northwesterly direction. In Montana and Idaho the presence of 
North and South Midland features reflects the history of the frontier and the enterprises of cattle, 
agriculture, and mining. Throughout the Rocky Mountains and the urban West Coast the dialects of early 
settlers determined the pattern. Seattle and San Francisco speech grew from an Inland Northern base 
quite similar to old-fashioned Chicago speech. Denver and Los Angeles also developed from the same 
source, although the Hispanic influence in both places and the successive waves of newcomers from the 
East, especially in Los Angeles, have obscured the regional pattern that endures with greater stability in 
Seattle and San Francisco. The Midland influence is strongest west of the Rockies, from Idaho to Arizona,
and especially in the conservative speech of Boise, Salt Lake City, and Phoenix. American English in 
Wyoming, Colorado, and Utah, for example, includes old-fashioned Inland Northern features, such as [I] 
in creek, fully constricted postvocalic r, [hw] in wheel, whip, and similar words, and homophony in marry, 
Mary, and merry, and teeter-totter (seesaw); Midlands green beans, gunnysack, and anymore (meaning 
"nowadays" in positive statements); and Southern roasting ears (corn on the cob), slop bucket, and 
clabber. Beside these are the distinctive Interior Western pronunciations [æ] instead of [a] in Colorado 
and Nevada, [i] instead of [e] in rodeo, and widespread replacement of [a] for [ô] in automobile, log, and 
Utah. 

The Influence of Bilingualism    
The national idiom grew through contacts between various languages and dialects. Spanish, French, and 
German bilingualism marks the regional patterns of Florida, Louisiana, Pennsylvania, and south Texas. 
Gullah, an English-based pidgin, developed in the Sea Islands of South Carolina and Georgia. From that 
source many varieties of American Black folk speech are derived, reflecting various stages of creolization 
as the dialects merge with the dominant patterns. Social dialects grew through urban and rural 
experiences throughout the country, many of these related to the Americanization of European bilinguals 
in the urban North and the integration of Black people in all sectors of society. These dialects are further 
conditioned and refined by formal and situational styles, including slang, ethnic variation, and patterns of 
usage reflecting socioeconomic class. 
Before urban American Spanish gained prominence in San Antonio, Los Angeles, and Miami, that 



language had already made large contributions to American English in the West. Besides place names, 
extending from the Rio Grande to Montana, the Spanish vocabulary marks the cattle country with 
Western words: arroyo, bronc(o), canyon, chaparral, cinch, corral, frijol, hoosegow, lariat, lasso, mesa, 
mustang, patio, pronto, ranch, remuda, rodeo, sombrero, and tortilla. 
In bilingual communities Spanish speakers of English tend to avoid regional dialect forms in favor of terms
from the general vocabulary, despite the distinctive accent and syntax carried over from the parent 
language. The same tendency appears among the French in Louisiana, who freely use their native loans, 
such as banquette (sidewalk), boudin (blood sausage), fais-dodo (country dance), and jambalaya, as well 
as loan translations and adaptations, such as coffee black, cream cheese (cottage cheese), green beans,
(h)armonica, and wishbone, resisting the Southern regionalisms clabber cheese, snap beans, and pulley 
bone. German, Italian, Scandinavian, Slavic, Spanish, and Yiddish speakers reflect the same trend in the 
urban North, perhaps through learning from books rather than by simple oral acquisition and perhaps 
through efforts to translate from their native tongues. In becoming Americans all of these people enriched 
the national language and culture. If examples are limited to food alone, Germans provided bock beer and
pretzels, Italians brought antipasto and pizza, Scandinavians added lingonberries and smorgasbord; 
Slavs contributed kolacky and kielbasa, Yiddish-speaking Germans and Slavs gave bagels and gefilte 
fish; and Mexican Spanish provided the base for an endless variety of enchiladas, burritos, and tacos, as 
its cooking entered the fast-food industry. 

Contributions From African Languages    
The full impact of African languages through Gullah and Plantation Creole remains to be assessed 
properly, but evidence suggests the influence is significant. Among certain and probable African loans, 
these have gained currency in the national language: banana, cola (kola), goober, gumbo, juke
(-box, -joint, and -step), okra, voodoo, and yam, as well as, perhaps, boogie-woogie, chigger, gorilla, and 
tote. Some are regionally restricted to the South: cooter (turtle), cush and cush-cush, and pinder (peanut).
Others seem limited to the South Carolina and Georgia Low Country: buckra (white man), det (heavy), as 
in det rain and det shower, and pinto (coffin). In addition to the loan words from Gullah, the creolization of 
that auxiliary language may also have left its mark on American English phonology and grammar. As a 
contact vernacular, a language of business (and a possible source of the word pidgin), Gullah provided a 
medium of communication for African slaves and their American overseers. Thus, the pidgin was a 
language variety native to neither group. In the development of Plantation Creole the language acquired 
highly complex phonological and grammatical rules, as well as a complete vocabulary, necessary in a 
self-reliant, independent language. General Southern features today include many correspondences with 
Plantation Creole, the creolized English Black folk speech of the plantation cultures of cane, cotton, 
indigo, and rice. Southern vowel nasality often replaces nasal consonants in am, been, and bacon, but 
this feature occurs in Parisian and Louisiana French as well as in Plantation Creole and West African 
languages. The simplification of consonant clusters, as in des (for desk and desks) or tase (for taste and 
tastes), is commonplace in all of those languages, as well as in the Scots dialect of Robert Burns, who 
like American Southerners, Black and white, often assimilated l after back vowels, as in fa' (fall) and saut 
(salt). Similarly, the pervasive deletion of articles, copulas, prepositions, and other function words, so 
characteristic of Gullah and its creolized extensions, is a feature regularly associated with the speech of 
French, German, and Spanish bilinguals. Nevertheless, this fact remains: large numbers of Black and 
white speakers share those features across the lower South, especially in those areas dominated by the 
plantation cultures. 

The Influence of Social Dialects    
As creolization reflects the blending of languages and cultures, so slang, argot, and social dialects mark 
the activities of subcultures within the basic social structure. Although nothing as widespread as Cockney 
and Australian rhyming slang has developed in America, inventive usage here has steadily modified 
native speech. Most slang originates in the specialized conversations of particular groups, in which usage
reinforces group identity and develops into private codes that may later gain widespread acceptance. 
These include such now-familiar terms as clout and gerrymander from politics, blues and jazz from music,
headline and editorial from journalism, and by a nose, inside track, front-runner, shoo-in, and sure thing 
from the vocabulary of horse racing. The distinctive words of other groups¾pickpockets, CB operators, 
and computer specialists¾suggest the ways in which the subcultures function and illustrate the ways in 



which language develops. 
Social dialects also underlie the regional patterns of speech, reflecting absolute factors, such as sex, age,
and ethnic origin, and relative factors, such as education, experience, and social position. Since a healthy
language is always changing, the age and experience of its speakers are recorded by incipient, dominant,
and recessive forms, as demonstrated in the vocabulary of automobiles: the emergent gas-guzzler and 
pimpmobile, the durable sedan and limousine, and the relic tin lizzie and roadster. Ethnic terms are the 
cultural birthrights of individual speakers and great linguistic resources for society at large. Yiddish 
schlock, chutzpah, macher (fixer, operator, clever fellow), and schmaltz have moved from the Jewish 
communities to the national language, as have the specialized Sicilian terms capo, Cosa Nostra, and 
Mafia in urban American subcultures. Education reinforces language trends with the spread of 
generalized patterns of pronunciation, grammar, and vocabulary, but these are challenged by migrant 
accents in Chicago today just as they were in London 400 years ago. As Latinos made macho an 
American word, Black people have put many Southern regionalisms, such as funky, uptight, and right on, 
into common usage. The language reflects cultural patterns, refined and strengthened through 
association and social status. 
Social dialects also mark the evolution of a language. In America the middle classes have generated 
great changes. These include the absorption of immigrant cultures at the lower level and influence upon 
the dominant culture at the higher level. As the linguistic and cultural forms are traditionally conservative 
in both aristocratic and folk groups, however different their social styles, middle-class society and speech 
alter those conventional patterns from below and from above. Just as members of the secular and regular
clergy, educators, lawyers, politicians, and physicians helped shape the London Standard from the early 
Middle Ages through the English Renaissance because they were conversant with both the ruling class 
and the common people, so new patterns of American usage grow today through the influence of upper-
middle-class dialects. Even stronger influences appear from the speech of the lower middle class, 
especially in urban centers, where large numbers of workers come in contact with the entire community in
their daily work. 
Of these, ethnic dialects preserve the most complicated social varieties of language and reflect the 
essential spirit of American culture. As frontier societies developed distinctive regional patterns, Spanish, 
French, Dutch, Scandinavian, and German settlers used their native languages before adopting the 
dominant English dialect. English, Irish, and Scots folk speech constituted probably the most influential 
ethnic varieties on the frontier, but these were modified by the language habits of their neighbors. In the 
process of Americanization, Europeans, Africans, and Asians gave the language some of its most familiar 
words: chop suey, hamburger, hillbilly, jukebox, pizza, prairie, rodeo, Santa Claus, smorgasbord, and 
tycoon. 
The national vocabulary reflects the intimacy of conversation and the evolution of democratic social 
forms. John Adams proposed that Congress establish an American Academy "for refining, correcting, 
improving, and ascertaining the English language." Later, when asked to preside over such activities, 
Thomas Jefferson responded: 

There are so many differences between us and England, of soil, climate, culture, productions, laws, religion, and 
government, that we must be left far behind the march of circumstances, were we to hold ourselves rigorously to 
their standard. If, like the French Academicians, it were proposed to fix our language, it would be fortunate, that 
the step was not taken in the days of our Saxon ancestors whose vocabulary would illy express the science of 
this day. Judicious neology can alone give strength and copiousness to language, and enable it to be the vehicle 
of new ideas. 

Instead of rules from a National Academy of English, Americans accepted the common-law customs of 
intelligent conversation with all its modifications through time and circumstance. Current usage may reject
"illy express" and "judicious neology," but history shows the correctness of Jefferson's message. He 
recognized the certainty of change, the function of language as a cultural tool, and the importance of 
thoughtful selection of vocabulary. Through common-law customs of speech and writing the national 
language develops words and documents social facts. This Dictionary orders those materials of 
discourse, records the natural history of a people, and transmits the substance of the American heritage. 

*All pronunciations in this article are in the notation of the International Phonetic Alphabet. The Pronunciation Key lists
these symbols and their equivalents in the pronunciation system employed for this Dictionary.





The Indo-European Origin of English by Calvert Watkins
The name Indo-European is given for geographic reasons to the large and well-defined linguistic family 
that includes most of the languages of Europe, past and present, as well as those found in a vast area 
extending across Iran and Afghanistan to the northern half of the Indian subcontinent. In modern times the
family has spread by colonization throughout the Western Hemisphere.    
A curious byproduct of the age of colonialism and mercantilism was the introduction of Sanskrit in the 18th
century to European intellectuals and scholars long familiar with Latin and Greek and with the European 
languages of culture¾Romance, Germanic, and Slavic. The comparison of this ancient tongue with the 
two classical languages revolutionized the perception of linguistic relationships.    
Speaking to the Asiatick Society in Calcutta on February 2, 1786, the English Orientalist and jurist Sir 
William Jones (1746-1794) uttered his now famous pronouncement:

The Sanskrit language, whatever be its antiquity, is of a wonderful structure; more perfect than the Greek, more 
copious than the Latin, and more exquisitely refined than either, yet bearing to both of them a stronger affinity, 
both in the roots of verbs and in the forms of grammar, than could possibly have been produced by accident; so 
strong, indeed, that no philologer could examine them all three, without believing them to have sprung from some
common source, which, perhaps, no longer exists.

Jones was content with the assertion of a common original language, without exploring the details. Others
took up the cause, but it remained for the German philologist Franz Bopp (1791-1867) to found the new 
science of comparative grammar, with the publication in 1816 of his work On the Conjugational System of 
the Sanskrit Language, in Comparison with that of the Greek, Latin, Persian, and Germanic Languages. 
He was 25 years old when it appeared.    
It has been rightly said that the comparatist has one fact and one hypothesis. The one fact is that certain 
languages present similarities among themselves which are so numerous and so precise that they cannot
be attributed to chance and which are such that they cannot be explained as borrowings or as universal 
features. The one hypothesis is that these languages must then be the result of descent from a common 
original. Certain similarities may be accidental: the Greek verb "to breathe," "blow," has a root pneu-, and 
in the language of the Klamath of Oregon the verb "to blow" is pniw-. Other similarities may reflect 
universal or near-universal features of human language: in the languages of most countries where the 
bird is known, the cuckoo has a name derived from the noise it makes. A vast number of languages 
around the globe have "baby talk" words like mama and papa. Finally, languages commonly borrow 
words and other features from each other, in a whole gamut of ways ranging from casual or chance 
contact to learned coinages of the kind that English systematically makes from Latin and Greek.    
But where all of these possibilities must be excluded, the comparatist assumes genetic filiation: descent 
from a common ancestor, which in the case of Indo-European, as Sir William Jones surmised almost two 
centuries ago, no longer exists.    
In the early part of the 19th century scholars set about systematically exploring the similarities observable 
among the principal languages spoken now or formerly in the regions from Iceland and Ireland in the west
to India in the east and from Scandinavia in the north to Italy and Greece in the south. They were able to 
group these languages into a family that they called Indo-European (the term first occurs in English in 
1813, though in a sense slightly different from today's). The similarities among the different Indo-
European languages require us to assume that they are the continuation of a single prehistoric language 
(called Indo-European or Proto-Indo-European). In the words of the greatest Indo-Europeanist of his age, 
the French scholar Antoine Meillet (1866-1936), "We will term Indo-European language every language 
which at any time whatever, in any place whatever, and however altered, is a form taken by this ancestor 
language, and which thus continues by an uninterrupted tradition the use of Indo-European."    
Those dialects or branches of Indo-European still represented today by one or more languages are Indic 
and Iranian, Greek, Armenian, Slavic, Baltic, Albanian, Celtic, Italic, and Germanic. The present century 
has seen the addition of two branches to the family, neither of which has left any living trace: Hittite and 
other Anatolian languages, the earliest attested in the Indo-European family, spoken in what is now 
Turkey in the second millennium B.C.; and the two Tocharian languages, the easternmost of Indo-
European dialects, spoken in Chinese Turkestan (modern Xinjiang Uygur) in the first millennium A.D.
It should be pointed out that the Indo-European family is only one of many language families that have 
been identified around the world, comprising several thousand different languages. We have good 



reason, however, to be especially interested in the history of the Indo-European family. Our own 
language, English, is the most prevalent member of that family, being spoken as a native language by 
nearly 350 million people and being the most important second language in the world. The total number of
speakers of all Indo-European languages amounts to approximately half the population of the earth.    
English is thus one of many direct descendants of Indo-European: one of the dialects of the parent 
language became prehistoric Common Germanic, which subdivided into dialects of which one was West 
Germanic; this in turn broke up into further dialects, one of which emerged into documentary attestation 
as Old English. From Old English we can follow the development of the language directly, in texts, down 
to the present day. This history is our linguistic heritage; our ancestors, in a real cultural sense, are our 
linguistic ancestors. Only a small proportion of people in the United States can trace their biological 
ancestry back more than a century or two, and certainly a large segment of the population had languages 
other than English in their backgrounds only a few generations ago. But every individual is part of a 
culture, with language its external expression. That language, our language, has an ancestry, a history. 
Indeed, languages have perhaps the longest uninterrupted histories of all the cultural phenomena that we 
can study.    
But it must be stressed that linguistic heritage, while it may well tend to correspond with cultural continuity,
does not imply genetic or biological descent. The transmission of language by conquest, assimilation, 
migration, or any other ethnic movement is a complex and enigmatic process that this discussion does 
not propose to examine¾beyond the general proposition that in the case of Indo-European no genetic 
conclusions can or should be drawn.    
The comparative method¾what we have called the comparatist's "one fact and one hypothesis"¾remains 
today the most powerful device for elucidating linguistic history. When it is carried to a successful 
conclusion, the comparative method leads not merely to the assumption of the previous existence of an 
antecedent common language but to a reconstruction of all the salient features of that language. In the 
best circumstances, as with Indo-European, we can reconstruct the sounds, forms, words, even the 
structure of sentences¾in short, both grammar and lexicon¾of a language spoken before the human race
had invented the art of writing. It is worth reflecting on this accomplishment. A reconstructed grammar and
dictionary cannot claim any sort of completeness, to be sure, and the reconstruction may always be 
changed because of new data or better analysis. But it remains true, as one distinguished scholar has put
it, that a reconstructed protolanguage is "a glorious artifact, one which is far more precious than anything 
an archaeologist can ever hope to unearth."    
English, genetically a member of the Germanic branch of Indo-European and retaining much of the basic 
structure of its origin, has an exceptionally mixed lexicon. During the millennium of its documented history,
it has borrowed extensively from its Germanic and Romance neighbors and from Latin and Greek. At the 
same time, it has lost the great bulk of its original Old English vocabulary. However, the inherited 
vocabulary, though now numerically a small proportion of the total, remains the genuine core of the 
language; all of the 100 words shown to be the most frequent in the Corpus of Present-Day American 
English, also known as the Brown Corpus, are native, inherited words; and of the second 100, eighty-
three are native. Precisely because of its propensity to borrow from ancient and modern Indo-European 
languages, especially those mentioned above but including nearly every other member of the family, 
English has in a way replaced much of the Indo-European lexicon it lost. Thus, while the distinction 
between native and borrowed vocabulary remains fundamentally important, more than 50 percent of the 
basic roots of Indo-European as represented in Julius Pokorny's Indogermanisches Etymologisches 
Wörterbuch (Bern, 1959) are represented in modern English by one means or the other. Indo-European 
therefore looms doubly large in the background of our language.    



Usage in the American Heritage Dictionary: The Place of Criticism by Geoffrey 
Nunberg
Ever since the conception of "correctness" first emerged in the 18th century, there has never been a time 
when standards of usage were not controversial. Swift's proposals for improving English were derided by 
Whig pamphleteers. Noah Webster remonstrated with the influential Dr. Robert Lowth for defending a 
construction like the King of England's hat, and was in turn excoriated by later grammarians for 
countenancing the double negative. And so on, to the present day. 
This litigious history may be disconcerting to those who would like to think of the English rules of 
correctness as long-settled standards from which we have lately fallen away. But a healthy tradition of 
language criticism requires controversy. This Dictionary contains over 500 Usage Notes and comments, 
which deal with several thousand words and usages altogether. That is a good deal more than what is 
found in most dictionaries. But at the most conservative estimate, an educated speaker of English knows 
around 100,000 words and constructions. And these can be combined in an infinite number of ways, most
of them infelicitous¾for there are many more ways to get a word wrong than to get it right. The number of 
possible mistakes in English is inexhaustibly vast, and no one could hope to catalog them all.
So traditional usage criticism has had to provide critical methods rather than lists. As a matter of 
convenience, of course, these methods are usually demonstrated in disputations over a body of canonical
rules and dicta. When readers with an interest in these matters pick up a new usage book or a dictionary 
containing usage guidance, they invariably turn first to the entries dealing with the modification of unique, 
the proper use of disinterested, the distinction between shall and will, and the like. These, however, are 
merely the traditional occasions for discussions of usage and scarcely exhaust the scope of the subject. 
Modern controversies about usage are different from their predecessors. The earlier disputes were waged
intramurally, with everyone tacitly agreed about the stakes and the ground rules. Between Webster and 
Lowth there was no disagreement about the central premise of language criticism: that some forms of 
expression are preferable to others. Now that assumption itself has become controversial. 
Modern discussions of usage often take the form of engagements in a battle between irreconcilable 
camps. On one side of the field is ranged the party of science, the "descriptivists," who hold that all 
standards are ultimately based on the facts of use and that the business of dictionaries and usage books 
is simply to record those facts in a neutral way. On the other side stand the "prescriptivists," who insist 
that language is subject to a higher morality and that people who care about the state of the language 
have an obligation to defend traditional values in the face of growing laxity and permissiveness.    
Certainly language criticism was not originally conceived as an apology for traditional values. The 18th 
century founders of the tradition were champions of a new class of writers, freed by an expanded reading 
public from a direct dependence on aristocratic patronage. The object of their criticism, whether of 
language, literature, or life, was to usurp the authority of the court and the aristocracy as a source of 
social values. Hence their insistence that the spoken language must defer to the written and that custom 
must sometimes defer to criticism¾for in that era "custom" was simply another name for the practices of 
the privileged. Serious language criticism since then has been more often than not an arm of traditional 
liberalism, which reserved its sternest admonitions for the transgressions of the educated and the 
powerful. Matthew Arnold could berate the London Times for its "orthographical antics." Edmund Wilson 
taxed Walter Lippmann, Lionel Trilling, and John F. Kennedy for their stylistic lapses.    
Usage doctrines must change with the times, of course. The fundamental linguistic virtues¾order, clarity, 
and conciseness¾are unassailable, yet they must be constantly reinterpreted against an evolving social 
background. It is no longer permissible to pretend that the English language is a club for gentlemen who 
have "their" Latin authors at their fingertips. The language is too important to be left to nostalgic reveries. 
Nevertheless, it is also too important to be excused from responsible critical review.    

USAGE IN THIS DICTIONARY
In the treatment of usage the editors of The American Heritage Dictionary of the English Language, Third 
Edition, have tried to construct each Usage Note as a miniature critical exercise and to provide, within the 
limits of space, the kinds of information that readers will require to resolve the question to their own 
satisfaction. 
Naturally the Notes vary greatly in content and length according to the point at issue. Some provide no 



more than brief comments on relatively technical points. (What is the difference between flotsam and 
jetsam?) At the other end of the spectrum, several Notes run close to a thousand words¾far longer than 
the discussions of usage in any other dictionary. The longer Notes deal primarily with complex 
grammatical questions or with questions of particular social or critical interest (I, man, he, hopefully, and 
unique, for example). In these cases we have begun the Note with a brief summary for the reader who 
has only a cursory interest in the issue.    
The material provided in the Notes falls into three broad categories: information about use, summaries 
and analyses of critical arguments, and observations about the opinions of writers and critics. Speaking 
very broadly, all questions of usage involve a weighing of one or more of these three considerations.    
Use    The doctrine that correctness rests on use is hardly an invention of modern linguistics. Horace 
insisted that the laws of speech are fixed by custom, "whose arbitrary sway/Words and the forms of 
language must obey," a dictum quoted with approval by the grammarians of every succeeding era. Of 
course, the rules of the language are determined by use, but whose? Where use is uniform, the question 
does not arise. It is a curious fact of English that the phrase more than one takes a singular verb, despite 
its sense, as in More than one student has left. Doubtless it would be more logical to say More than one 
student have left, but it would not be English.    
Still, usage is often divided, sometimes unaccountably but more often according to social or geographic 
differences. And in these cases Horace's dictum offers little by way of helpful advice, as Noah Webster 
observed with some impatience:

But what kind of custom did Horace design to lay down as the standard of speaking? Was it a local custom?. . . 
Is it the practice of a court, or a few eminent scholars, that he designed to constitute a standard?

Webster's questions have no general answer. It depends on the word. Sometimes local custom is the only
determinant, and we find as many standards as there are speech communities.    
In other cases people do insist that there must be some one general standard, usually as determined by 
the practice of educated middle-class speakers. The Dictionary records facts about the use of items like 
these either in usage labels such as Non-Standard (see the Guide to the Dictionary) or, in particularly 
complicated cases, in the Usage Notes. Take the past tense form snuck. It originated as a nonstandard 
regional variant for sneaked, and many people still have a lingering prejudice against it: 67 percent of the 
Usage Panel disapproves of it. In recent years, however, snuck has become increasingly frequent in 
reputable writing (the American Heritage Dictionary files contain citations for it from the New Republic and
the San Francisco Chronicle, as well as from the works of writers like Anne Tyler and Garrison Keillor). 
And while the files show that sneaked is by far more prevalent in edited prose by a factor of about 7 to 2, 
it is no longer possible to label snuck as nonstandard, even though many educated users of English 
continue to consider it informal.    
While the practice of the educated middle class often determines what counts as "Standard English," it 
does not have the last word in all matters of divided usage. Not even the most assiduously "descriptivist" 
dictionary would think of basing its definitions of annuity or zabaglione simply on the way the words are 
used by educated speakers in general. Here readers do not expect to find a mirror of their own practice; 
they want to know how the words are used by experts in finance or Italian cooking. Of course, those are 
specialists' terms, but the point applies to many words in the general vocabulary as well. A great many 
educated speakers use ironic to mean simply "coincidental," as in It's ironic that he was also using a 
borrowed bat when he hit a grand slam last week against the Dodgers. The use, then, is unquestionably 
Standard English, and it is certainly the responsibility of a dictionary to record it. But the meaning of ironic 
is not at the disposition of the general public in quite the way the past tense of sneak is. Ironic is still a 
literary sort of word, and it is likely that a good many of the people who have used it to mean coincidental 
were reaching for a literary effect at the time. As long as literary folk continue to use ironic in a narrower 
sense¾and what is no less important, as long as a large proportion of the general public continues to 
think of the word as literary¾a dictionary has the responsibility to note that in this case the general use is 
sometimes at odds with the use of the writers and critics who have particular authority about the notion in 
question.    
It is never easy to say which group has authority over any given usage, of course. Who owns 
disinterested? Is the word kudos by now a common or garden-variety English plural like peas, or is it still 
an elegant borrowing that should be held responsible to its origin as a Greek singular? We will want to 
take the facts of use into consideration when we approach these questions, but it is the height of 



scientistic self-deception to suppose that use provides an objective criterion for resolving them. 
Lexicographers invariably have to make critical evaluations of the raw facts of use. And where the verdict 
of use is equivocal, a dictionary should give readers the wherewithal to make up their own minds.    
Criticism    Custom fixes the rules of language but does not justify them. Even complete uniformity of use 
doesn't make a practice exempt from critical review. After all, custom is partly determined by our beliefs 
about the world and society, and in these we might all be wrong. At one time everybody used fish to refer 
to whales, but the practice was abandoned in the light of new zoological evidence. And until quite 
recently, everybody used the words man and men to mean simply human beings, but now many people 
have abandoned that practice in the light of new conceptions of social justice. 
The prescriptive tradition had its origins in the Age of Criticism as a method no different in kind from the 
criticism of artistic works or of civil society in general. The 18th-century writers established the battery of 
principles to which usage might be held accountable¾the familiar arguments from analogy, logic, 
etymology, meaning, and the rest. Granted, they often applied these principles with the overzealous love 
of rules and systems that they brought to all their critical enterprises, so that we may sometimes feel, as 
Leslie Stephen put it, that they "sanctioned the attempt to do by rule and compasses what ought to be 
done by the eye." And much of the "logic" they invoked was derived either from speculative philosophy or 
from inappropriate parallels to Latin grammar, with the result that it often turns out to be of dubious 
relevance to the facts of English. It is fair to criticize the double negative in a sentence like I never got 
nothing on the grounds that it is associated with nonstandard varieties of English. But one cannot fault the
construction on logical grounds without also being willing to assert the illogicality of standard French and 
Italian.    
Linguists of a generation or so ago were fond of citing examples such as these in an effort to undermine 
the entire prescriptive program, and some of them went on to argue that the rules of language are simply 
immune from criticism, since they answer to natural laws inaccessible to cursory reflection. But the fact 
that particular prescriptive arguments are sometimes unsound does not vitiate the case for criticism in 
general. If modern linguistics teaches us that the logic of language structure is a good deal more subtle 
and elusive than traditional grammarians supposed, it does not follow that the grammar of every variety 
has achieved complete consistency or functional perfection¾particularly with regard to the relatively 
"unnatural" requirements of written public communication.    
In fact there is no reason that the methods of scientific linguistics and of traditional criticism should be 
regarded as incompatible. Modern syntax and semantics have developed an impressive array of 
analytical tools, which often make it possible to capture distinctions and subtleties that elude the 
sometimes coarse apparatus of traditional, Latin- based school grammar. These techniques can be as 
useful in analyzing prescriptive rules as in describing the facts of actual speech, and we have turned to 
them here in the course of analyzing a number of traditional questions, as well as some of the 
grammatical complications raised by the new concerns about matters of gender (see, for example, the 
entries at dare, different, each other, plus, and than, and at man and he). We have avoided the use of 
unfamiliar technical terminology, since we are interested in providing a critical method, not in 
communicating a body of scientific results. We believe, along with an increasing number of linguists, that 
there is an important place for a "critical linguistics" in the study of usage.    
Opinion: The Role of the Usage Panel    Custom can provide precedents and criticism can provide 
principles, but each has to be evaluated at the bar of opinion. Of course, dictionaries register received 
opinion at every turn (what else could justify labeling a usage as "offensive"?) But it is often useful to have
a more explicit way of gauging the opinions of people who have a critical interest in the language. This, 
then, is the role of the Dictionary's Usage Panel, a group of 173 well-known writers, critics, and scholars. 
Panel members are regularly surveyed on a broad range of usage questions, from the distinction between
each other and one another to the status of words such as the noun lifestyle and the verb impact. The 
results of these surveys are included in many of the Usage Notes.    
The Usage Panel should not be thought of as an Academy, charged with ruling on all questions of 
disputed usage. Indeed, the opinions of the Panel are often divided, even though at times the Panelists 
seem to speak with a single voice. In earlier surveys, for example, 99 percent of the Panelists rejected 
between you and I and ain't I in formal writing. But the Panel's judgment on questions like these merely 
reflects the hegemony of Standard English. The results of the surveys are far more interesting when they 
involve questions that are matters of dispute among educated speakers. In the most recent survey, for 



example, 49 percent of the Panel accepted the use of alternative to refer to one of three or more choices, 
as in Of the three alternatives, the first is the least distasteful.    
One might think that faced with this sort of disagreement readers interested merely in knowing which 
usage is "correct" would be perplexed: if there is no agreement among so august a group as this, what 
hope is there of fixing standards? But this misses the point. In the first place, the variation may itself be 
instructive. In the most recent survey, for example, we included several questions about words of 
uncertain pronunciation, such as banal, err, harass, and hegemony. We were not surprised to find a lack 
of consensus¾the Usage Panel was split exactly 50-50 on which syllable takes the emphasis in harass, 
for example¾but the results did serve to make the no less useful point that on these matters, at least, 
there is no agreed-upon standard.    
More important, the Panel's diverging opinions underscore the point that usage questions are always 
controversial¾must be controversial, if discussions of usage are to be instructive. The Usage Panel 
surveys are most interesting in providing a rough indication of just how controversial an issue is, that is, 
how seriously the views of individual critics have been taken by people with a critical interest in the 
language. This fact becomes clear when we compare the Panel's reactions on different items. For 
instance, if you read what some critics have had to say about new forms like the use of parent as a verb, 
or the word lifestyle, you may be led to believe that they are all egregious New Age jargon. But 
collectively, the Panel was more discriminating. Fully 98 percent of the Panel rejected the sentence Critics
have charged that the department was remiss in not trying to dialogue with representatives of the 
community. By contrast, lifestyle is acceptable to a large majority of the Panel, 70 percent, in the 
sentence Salaries in the Bay Area may be higher, but it may cost employees as much as 30 percent more
to maintain their lifestyles. Readers, of course, will want to make up their own minds about each of these 
usages, but the opinions of the Panel may carry some weight, especially when taken together with the 
critical discussions in the Usage Notes.    
Changing Attitudes    In preparing this edition of the Dictionary, we were able for the first time to use the 
results of the Usage Panel surveys to draw another kind of comparison, one that shows the shifts in 
critical attitudes over time. The Usage Panel was first polled in 1964, nearly a generation ago. That is not 
a long time on the linguistic scale of things, for language as a whole changes much more slowly than 
other social institutions. But it is time enough for usages to change significantly in their status, particularly 
when they involve the sorts of innovations and neologisms that criticism often focuses on. 
One notable trend, for example, is that a number of words and constructions that were questionable a 
generation ago have become more acceptable. The verb contact was problematic to many language 
critics of the 1950's and 1960's, but resistance seems to have abated: between 1969 and the most recent 
survey the Panel's acceptance of contact rose from 34 to 65 percent. The pattern of increasing 
acceptability was repeated with the use of the verb intrigue to mean "arouse interest" (up from 52 to 78 
percent) and with various senses of the words host, identify, and many others. The tendency is not 
surprising. Innovations rarely remain for long on the linguistic littoral; most either make their way onto dry 
land or are carried off with the receding tide. 
But other shifts in the Panel's opinions may have less to do with changing patterns of usage than with 
changes in critical standards. In evaluating the most recent survey, for example, we were struck by the 
Panelists' increased indifference to traditional injunctions against using certain words in ways that appear 
to be inconsistent with their Latin origins. Fully 68 percent of the Panel now accepts the use of aggravate 
to mean "irritate," up from 43 percent in 1969. The same shift is evident with the use of anxious to mean 
"eager" (up from 23 to 52 percent), transpire to mean "happen" (up from 38 to 58 percent), cohort to refer 
to a single person (up from 31 to 71 percent), and several other words of this type. 
Does this mean that the Panel has become generally more liberal or permissive? It is true that its 
composition has changed over the years. The membership of the current Panel is more numerous and 
younger than it was in 1969, and it includes a greater proportion of women and members of minority 
groups than before. Yet on many other canonical usage issues the current Panelists have proved to be no
less conservative than their predecessors. For example, 89 percent rejects the use of disinterested to 
mean "uninterested," a figure not significantly different from the 93 percent who rejected this usage in 
1969. And on a few issues, such as the use of hopefully as a sentence adverb, the Panel is actually more 
conservative now than it was a generation ago. Why then the shift in the Panelists' opinions on aggravate 
and the rest? Perhaps they have come to believe that it is no longer possible to expect adherence to 



general usage standards that presuppose a familiarity with classical languages, even if many of them 
note that they still observe the traditional strictures in their own writing. (See also the Usage Notes at 
data, dilemma, celibate, minimal, and nauseous.) 

THE SCOPE OF COVERAGE
The Traditional Canon    These changes in critical attitudes should not obscure the fact that most of the 
traditional canon of usage questions has emerged largely intact from the controversies of recent years. 
When people think about "usage questions," they still have in mind the same points of grammar and 
diction that occupied critics a century ago: the differences between who and whom, between and among, 
enormity and enormousness; the qualification of absolute terms such as unique, equal, and parallel; and 
so forth. These questions exemplify the consideration of usage in its most general form; they are 
ostensibly motivated by very broad critical principles that apply to writing of all sorts and about all 
subjects: criteria of logic, coherence, clarity, and concision. Over the years, to be sure, the traditional 
canon has accumulated a good deal of unexamined grammatical lore that does not hold up well under 
scrutiny; see, for example, the Notes at and and preposition. But we believe that canonical issues like 
these give language criticism its historical continuity; thus they still constitute the largest single category 
among the Usage Notes in the Dictionary. In some cases we have added Notes dealing with questions 
that, though not historically part of the canon, have much the quality of traditional issues: the use of 
periodic to mean "occasional," the use of specious to mean "false," the modification of infinite, and the 
potential ambiguity of deceptively. The traditional canon has always been surrounded by a penumbra of 
items like these, introduced by individual writers or reference books in the interest of making particular 
points. What makes the canon central, after all, is not so much the particular words included, but the 
broader linguistic questions raised. 
New Words, New Issues    The Dictionary's treatment of usage has been extended to cover a variety of 
new issues. Notes are included for a host of new words that have attracted commentary. Some of these 
are drawn from the language of particular domains: new social movements (caring, parent, wellness, 
lifestyle, and father, for example); postmodernism (about); publicity (world-class, legend, and showcase); 
technology (parameter, input, and access). Others have a more general provenance: the use of go to 
mean "say" or the use of holocaust to mean simply "disaster" or "misfortune." Of course the Dictionary's 
coverage of such items cannot be "comprehensive"¾the class is far too fluid for that¾but we have tried to
cover items of particular critical interest. 
In other cases, we have included Usage Notes for items not often touched on by criticism, which 
exemplify problems that might be considered appropriate elements in a revised usage canon. For 
example, there are Notes on several terms, such as black English, nonstandard, and literacy, that figure 
in recent public discussions of language questions. In including items like these, of course, we may be 
open to a charge of special pleading. But such words are only examples of a kind of scientific and 
technical terminology that has become increasingly important in public discussion. So we have also 
included Usage Notes on questions such as the difference between methodology and method, whether a 
cross section is necessarily "representative," and whether one can speak of a quantity as having been 
"reduced by 150 percent." Obviously the brief of usage criticism cannot be extended to cover all of the 
specialized discourse of the sciences. But the program of criticism can make at least a token effort to 
acknowledge the role that scientific and quantitative argumentation has come to play in general 
discourse. 
Usage and Social Justice    Over the past 30 years the most radical change in the scope of language 
criticism has been its extension to a wide range of usages involving the relation between language and 
questions of social diversity and social justice. Discussion of these issues constitutes the most important 
and extensive additions to the treatment of usage in this Edition. One category includes the names of 
various social groups defined along lines of ethnicity, religion, race, physical capacity, and sexual 
preference, as discussed in the Notes at Asian, black, Chicano, color, gay, handicapped, Hispanic, Jew, 
Jewess, Kanaka, Moslem, Native American, and Negress. In one sense, of course, these questions are 
not genuinely "new." But in the past they were not taken up as part of the public discussion of language 
standards. Only recently have these issues emerged as critical questions, whether as a result of the rise 
of official pluralism or of a more general tendency to emphasize the political and ideological aspects of 
usage. 



In matters like these, of course, a dictionary has no authority to lay down standards of "correct" usage (at 
least not in the linguistic sense of the term). Most of these words are subject to a great deal of variation, 
even among members of the groups they apply to, and their connotations and use can change very 
rapidly. The Dictionary can help by providing information on the social and linguistic backgrounds of the 
questions. Thus the Note at Hispanic explains how that term is different in meaning from Latino. At the 
least, this information may spare some readers from resorting to unnecessary circumlocution or from 
giving inadvertent offense. 
Usage and Gender    With a few exceptions (as with black and gay), the usage questions raised by the 
names of ethnic categories and the like are socially complex but linguistically simple. Replacement of one
such word by another rarely causes grammatical difficulties or creates ancillary linguistic problems. But 
gender differences are so extensively and intricately woven into the fabric of the language that efforts to 
change usage often require a great deal of attentiveness and linguistic ingenuity. So it is not surprising 
that feminism has had more extensive consequences for questions of usage than any other recent social 
movement or that the debate over these issues has been particularly energetic. In this Edition we have 
greatly expanded coverage of these issues, which are discussed in the Usage Notes at blond, brunette, -
ess, -ette, feminist, gender, he, heroine, lady, man, and Ms. 
With these items, as with the names of ethnic and social categories, we have tried to present the linguistic
and social background that readers will require to make informed decisions about the issues. Because the
linguistic program of feminism has called for such extensive and varied changes in usage, we have also 
made an effort to gauge its overall effects on the attitudes and practice of writers, both in general and with
regard to particular words and constructions. To this end, we included a number of questions about these 
issues in recent Usage Panel surveys. Generally speaking, we found that a great majority of the Panelists
of both sexes have adopted at least a few of the recommendations of feminists. But virtually all the 
Panelists were discriminating in their revisions; they found some usages more objectionable than others. 
(In reporting the results on these items, we have sometimes broken down the Panelists' responses on the
basis of gender. Not surprisingly, women were consistently more likely than men to reject usages that 
might be labeled sexist. But men and women showed roughly the same patterns in differentiating one 
item from the next. Thus both groups found hostess more acceptable than sculptress, and so forth.) 
Fewer than 40 percent of the Panelists say they would use the masculine pronoun his to complete the 
sentence A child who wants to become a doctor should be encouraged by____ parents and teachers, 
against 81 percent (including 58 percent of the women members) who accepted the generic use of man in
If early man suffered from a lack of information, modern man is tyrannized by an excess of it. 
Like most critical users of the language, the Panelists seem to have revised their usage on a case-by-
case basis, evaluating each item in the light of the sometimes conflicting claims of syntax, established 
use, and social justice. In a sense, one can say that the feminist linguistic program has already 
succeeded, in requiring most literate people to reflect carefully on the ways in which usage might imply or 
reinforce gender stereotypes. Of course, the Panel's divisions reflect controversies about these usages 
that are not likely to be resolved in the near future. But these are precisely the kinds of controversies 
about particular words and principles that ensured the vitality of traditional language criticism in the 18th 
and 19th centuries. Here as elsewhere, what matters is not that we should expect to achieve uniformity 
but that we should find in our differences the occasion for lively critical discussion. 



Guide to the Dictionary: Conventions Used to Present and Define Words
The American Heritage Dictionary of the English Language, Third Edition is a record of the language as it 
is used by a broad and diverse group of educated speakers and writers over the long term. Its word list 
reflects the many complex elements that constitute our language. This Guide, which explains the 
conventions used in presenting the great array of information contained in the Dictionary, is intended to 
enable you to find and understand that information quickly and easily.

THE HEADWORDS: ALPHABETICAL ORDER
Each headword is set in boldface type at the top of the Article window. All entries ¾including biographical 
and geographic names, abbreviations, symbols, compounds of two or more words, and Indo-European 
roots ¾are listed in strict alphabetical order:

abs.
Absaroka Range
Absaroke
Absarokes
abscess
abscessed
abscesses
abscessing
abscise
abscised
abscises
abscisic acid
abscising

For the sake of convenience, proper names are listed according to their most important element, such as 
a surname shared by a number of important people. In these cases, the alphabetical sequence applies 
only to those letters preceding the first comma. For example, "George" comes before "George VI," which 
in turn comes before "George, Henry."
Superscript numbers. Words with identical spellings but different etymologies are entered separately 
and have superscript, or raised, numbers. In most cases, these numbers reflect the frequency of use: 

tick1 (tík) noun      1. A light, sharp, clicking sound made repeatedly by a machine, such as a 
clock¼[Middle English tek, light tap.]

tick2 (tík) noun      1. Any of numerous small bloodsucking parasitic arachnids of the family 
Ixodidae, many of which transmit febrile diseases, such as Rocky Mountain spotted fever and 
Lyme disease¼[Middle English teke, tik, perhaps from Old English *ticca.] 

tick3 (tík) noun      A cloth case for a mattress or pillow.[Middle English tikke, probably from Middle
Dutch tìke, ultimately from Latin thêca, receptacle, from Greek thêkê.] 

tick4 (tík) noun      Chiefly British.      Credit or an amount of credit.      [Short for TICKET.]    

Note: In the Table of Contents of the Bookshelf Dictionary, entries, such as those above, are listed with 
the number in parentheses instead of superscript: tick(1), tick(2), tick(3), tick(4).

SYLLABICATION
A headword and its inflected and derived forms are divided into syllables by means of centered dots: 

ac·e·tate (às¹î-tât´) noun.

In entries, such as ethyl acetate, that consist of two or more words separated by spaces, the words 
without centered dots are divided into syllables at their own places in the Dictionary.



Pronunciations are syllabicated for the sake of clarity. The syllabication of the pronunciation may not 
match the syllabication of the headword because the division of the pronunciation follows phonological 
rules, while the division of the headword reflects the long-established practices of printers and editors in 
breaking words at the end of a line of text.

PRONUNCIATION
The written pronunciation is enclosed in parentheses and appears after the boldface headword. The 
audio pronunciation can be played by clicking the audio icon next to the article headword. 
If a headword and a variant to that headword have the same pronunciation, the pronunciation is given 
immediately after the variant. If the variant or variants do not have the same pronunciation as the 
headword, pronunciations follow the forms to which they apply. Differing or variant pronunciations are 
given wherever necessary. If an entry or a variant requires more than one pronunciation, subsequent 
pronunciations show only those syllables that are different in sound quality or stress from the first 
pronunciation or that are necessary for clarity.
Clicking on any phonetic pronunciation will display the Pronunciation Key.
Pronunciation symbols. The symbols used in this Pronunciation Key enable you to produce a 
satisfactory pronunciation with no more than a quick reference. All pronunciations given here are 
acceptable in all circumstances. When more than one pronunciation is given, the first is assumed to be 
the most common, but the difference in frequency may be insignificant.
For most words a single set of symbols can represent the pronunciation found in each regional variety of 
American English. You will supply those features of your own regional speech that are called forth by the 
pronunciation key in this Dictionary. The pronunciations are exclusively those of educated speech.
Explanation of the schwa. Most symbols in the pronunciation key are self-explanatory, but one requires 
brief discussion. The nonalphabetical symbol (e) is called a schwa. It is used in this Dictionary to 
represent a reduced vowel, a vowel that receives the weakest level of stress within a word. The schwa 
sound varies, sometimes according to the vowel it is representing and often according to the sounds 
surrounding it:    

sis·ter (sîs¹ter)

a·bun·dant (e-bùn¹dent)

Stress. The relative emphasis with which the syllables of a word or phrase are spoken, called stress, is 
indicated in three different ways. The strongest, or primary, stress is marked with a bold mark (¹). An 
intermediate, or secondary, level of stress is marked with a similar but lighter mark (´). The weakest 
stress is unmarked. Words of one syllable show no stress mark.    

VARIANTS
Though standardization of English in the United States is more extensive than at any earlier time, many 
variant spellings and stylings remain in common use. All variants shown in this Dictionary are acceptable 
in any context unless indicated otherwise by a restrictive label, such as a dialect label. Variants, set in 
boldface type, are of two kinds: equal and unequal.    
Equal variants. The word or joining a headword and its variant form or forms indicates that these forms 
occur with virtually equal frequency in edited sources, based on our electronic and printed citational 
evidence:      

ar·chae·ol·o·gy or ar·che·ol·o·gy (är´kê-òl¹e-jê) noun

Unequal variants. The word also joining a headword and its variant form or forms indicates that the 
variant form occurs less frequently:      

am·bi·ance also am·bi·ence (àm¹bê-ens, äN-byäNs¹) noun

Variants that are not adjacent to their headwords in alphabetical order are entered as separate cross-
references at the appropriate places in the alphabetical word list:

me·di·e·val also me·di·ae·val (mê´dê-ê¹vel, mèd´ê-) adjective



me·di·ae·val (mê´dê-ê¹vel, mèd´ê-) adjective      Variant of medieval.

British variants. A number of variants consist of spellings preferred in British English. These variants, 
such as defence and colour, are labeled Chiefly British. They are entered at their own alphabetical places 
but are not given at the entries to which they relate:

de·fence (dî-fèns¹) noun & verb.      Chiefly British.      Variant of defense.

One exception to this general rule has to do with words, such as realize, that end with the suffix -ize. The 
British spelling ending in -ise is not entered in this Dictionary unless it also commonly occurs in the United
States. When a word that has a chiefly British variant occurs in compounds, the variant is not repeated at 
the compound. For example, the chiefly British variant colour is given for color but not for colorblind, color 
guard, and other such compounds.    

PART-OF-SPEECH LABELS
The following italicized labels indicate parts of speech: adjective, adverb, conjunction, definite article, 
indefinite article, interjection, noun, preposition, pronoun, verb.
These italicized labels indicate inflected forms: plural    singular 
Words such as cattle that occur only in the plural are labeled plural noun.    
These italicized labels are used for the traditional classification of verbs: transitive, intransitive, auxiliary.
The labels for word elements are: prefix    suffix.
Entries that are abbreviations, such as A.M. and blvd., are labeled abbreviation or Abbr.  Nouns that are 
often used to modify other nouns are labeled attributive. 
Certain entries do not carry labels. They include contractions, symbols, trademarks, and the word 
elements    -i- and -o-, which never occur in initial or final position in a word: 

I'll (íl)     1. I will.      2. I shall.

I2 The symbol for the element iodine (sense 1).

Walk·man (wôk¹màn´, -men)      A trademark used for a pocket-sized audiocassette player, radio, 
or combined unit with lightweight earphones. 

Sometimes a headword fulfills more than one grammatical function. For example, current can be an 
adjective (current pricing; current negotiations) and a noun (a current of air; the swift current of a river; 
electric current). In such cases the different parts of speech are defined within a single entry called a 
combined entry. The shift in grammatical function is indicated by the appropriate part-of-speech label.
If the syllabication or pronunciation differs from one part of speech to another, then the shift in 
grammatical function is indicated by the part-of-speech label followed by a boldface dash, followed by the 
boldface headword divided into syllables, followed by the pronunciation in parentheses. Inflected forms 
are given if necessary and are followed by definitions:

re·bel (rî-bèl¹) intransitive verb     re-belled, re-bel·ling, re--bels.
1. To refuse allegiance to and oppose by force an established government or ruling authority.
2. To resist or defy an authority or a generally accepted convention.
3. To feel or express strong unwillingness or repugnance: She rebelled at the unwelcome 
suggestion.
noun ¾ reb·el (rèb¹el)
One who rebels or is in rebellion: "He is the perfect recruit for fascist movements: a rebel not a 
revolutionary, contemptuous yet envious of the rich and involved with them"    (Stanley Hoffman).
noun, attributive.
Often used to modify another noun: rebel troops; a rebel army.

INFLECTED FORMS



An inflected form of a word differs from the main entry form by the addition of a suffix or by a change in its
base form to indicate grammatical features such as number, person, mood, or tense. In this Dictionary the
following inflected forms appear with headwords:
1. Principal parts of all verbs, whether regular or irregular
2. All degrees of comparison of adjectives and adverbs formed by inflection
3. Irregular plurals of nouns and plurals whose formation might cause a spelling problem 
Inflected forms follow the part-of-speech label. They are set in boldface type, divided into syllables, and 
given pronunciations as necessary. 
Principal parts of verbs. The principal parts of verbs are entered in this order: past tense, past participle,
present participle, and third person singular present tense. When the past tense and the past participle 
are identical, one form represents both:    

fly1 (flì) verb      flew (fl¡) flown (flon) fly·ing, flies (flìz)

walk (wôk) verb      walked, walk·ing, walks
Comparison of adjectives and adverbs. Adjectives and adverbs whose comparative and superlative 
degrees are formed by adding -er and -est to the unchanged word show these comparative and 
superlative suffixes immediately after the part-of-speech label:    

high (hì) adjective     high·er, high·est

Irregular comparative and superlative forms are given in full, as in bad, worse, worst. 
The existence of -er and -est forms does not preclude the use of more and most with a simple adjective 
or adverb to express the comparative and superlative degrees. Often the comparative and superlative can
be expressed either way, as in cloudier or more cloudy, cloudiest or most cloudy.

Plurals of nouns. Plurals of nouns other than those formed regularly by adding the suffixes -s or -es are 
shown and labeled plural: 

mouse    (mous) noun        plural mice (mìs)

When a noun has a regular and an irregular plural form, both forms appear, with the most common shown
first:      

a·quar·i·um (e-kwâr¹ê-em) noun        plural a·quar·i·ums or a·quar·i·a (-ê-e)

Regular plurals are also shown when spelling might be a problem:

ra·di·o (râ¹dê-o) noun        plural ra·di·os      Abbr. rad.

hon·ey (hùn¹ê) noun        plural hon·eys

A noun that is chiefly or exclusively plural in both form and meaning is labeled plural noun. 

cat·tle (kàt¹l) plural noun        1. Any of various mammals of the genus Bos, including cows, 
steers, bulls, and oxen, often raised for meat and dairy products.

A noun that is always plural in form but is not necessarily used with a plural verb is labeled like this: 

aer·o·bics (â-ro¹bîks) noun (used with a sing. or pl. verb).      1. A system of physical conditioning 
designed to enhance circulatory and respiratory efficiency that involves vigorous, sustained 
exercise, such as jogging, swimming, or cycling, thereby improving the body's utilization of 
oxygen.    2. A program of physical fitness that involves such exercise.      [From AEROBIC.]

pol·i·tics (pòl¹î-tîks) noun      Abbr. pol., polit       1. (used with a sing. verb).    a. The art or 
science of government or governing, especially the governing of a political entity, such as a 
nation, and the administration and control of its internal and external affairs.    Political science.      
2. (used with a sing. or pl. verb). a. The activities or affairs engaged in by a government, 
politician, or political party: "All politics is local" (Thomas P. O'Neill, Jr.). "Politics have appealed to
me since I was at Oxford because they are exciting morning, noon, and night."    (Jeffrey Archer).



Separate entries for inflected forms. Irregular inflected forms are entered separately in the Dictionary 
when they occur more than one entry away from the main headword:      

men (mèn) noun      Plural of man

went (wènt) verb      1. Past tense of go1
Such entries carry a part-of-speech label and are given pronunciations as necessary.    
Inflected forms are not shown at variant spellings that are cross-references to main entries: 

par·a·lyse (pàr¹e-lìz´) verb      Chiefly British.      Variant of paralyze.

Some verbs, such as do, be, and have, have archaic inflected forms, such as dost, art, and hadst, that 
occur frequently enough to justify their inclusion in this Dictionary. These forms are also entered 
separately:

dost (dùst) verb      Archaic.      A second person singular present tense of do1.

LABELS
This Dictionary uses various labels to indicate entries related to particular subject areas, to provide 
guidance regarding various levels of usage, and to indicate words indigenous to specific geographic 
areas.

Subject labels. A subject label identifies the special area of knowledge to which a headword or a 
definition applies:      

e·qui·mo·lar (ê´kwe-mo¹ler, èk´we-) adjective      Chemistry.      Having an equal number of 
moles.

tri·mor·phic (trì-môr¹fîk) also tri·mor·phous (-fes) adjective
1. Biology. Having or occurring in three differing forms.
2. Chemistry. Crystallizing in three distinct forms.

Status labels. Status labels indicate that a headword or a definition is limited to a particular level or style 
of usage. All words and definitions not restricted by such a label should be regarded as appropriate for 
use in all contexts.    
Non-standard. This, the most restrictive label in the Dictionary, is applied to forms and usages that 
educated speakers and writers consider unacceptable:

an·y·ways (èn¹ê-wâz´) adverb.      Non-Standard.      In any case.

Usage problem. The label Usage Problem warns of possible difficulties involving grammar, diction, and 
writing style. A word or definition so labeled is discussed in a Usage Note:

snuck (snùk) verb.      Usage Problem.      A past tense and a past participle of sneak. See Usage 
Note at sneak.

well·ness (wèl¹nîs) noun      Usage Problem. The condition of good physical and mental health, 
especially when maintained by proper diet, exercise, and habits.
noun, attributive    Usage Problem. Often used to modify another noun: wellness programs; a 
wellness clinic. 
Usage Note: It can be argued that wellness serves a useful function as a means of describing a 
state that includes not just physical health but fitness and emotional well-being. The word is first 
recorded in 1654 but has never been given the acceptance of its antonym illness. In the most 
recent survey 68 percent of the Usage Panel found the word unacceptable in the sentence A 
number of corporations have implemented employee wellness programs, aimed at enhancing 
spiritual values, emotional stability, fitness, and nutrition.



Offensive. This label is reserved for words and expressions such as racial, ethnic, or gender slurs that 
are not only derogatory and insulting to the person to whom they are directed but also a discredit to the 
one using them. This label may occur alone or in combination as Offensive Slang.
Vulgar. This label warns of social taboos attached to a word; it may appear alone or in combination as 
Vulgar Slang.
Obscene. A word that violates accepted standards of decency carries the label Obscene.    
Slang. This label indicates a style of language that is distinguished by a striving for rhetorical effect 
through the use of extravagant, often facetious figures of speech. Slang either dies out or is eventually 
incorporated into the standard language as its rhetorical effect is lost. Some forms of slang occur in most 
cultivated speech but not in formal discourse. An example of a word labeled Slang is:

white-knuck·le (hwìt¹nùk¹el, wìt¹-) adjective      Slang.      Characterized by tense nervousness or 
apprehension: a white-knuckle emergency landing; white-knuckle time in the hospital waiting 
room.

Informal. Those whose speech is standard use not only the language of formal discourse but also the 
language of conversation. The great majority of words are acceptable at both levels, though many words 
that are acceptable in conversation with friends and colleagues would be unsuitable in the formal prose of
an article written for publication in the journal of a learned society, for example. An example of an entry 
labeled Informal is:

wish list    noun.      Informal.      An often mental list of things wanted. 

Temporal labels. Temporal labels. such as Archaic and Obsolete, signal words or senses whose use in 
modern English is uncommon.    
Archaic. The label Archaic is applied to words and senses that once were common but are now rare, 
though they may be familiar because of their occurrence in certain contexts, such as the literature of an 
earlier time. Specifically, this label is attached to headwords and senses for which there is only sporadic 
evidence in print after 1755:

en·ter·tain·ment (èn´ter-tân¹ment) noun      ¼5. Archaic. Maintenance; support.      6. Obsolete. 
Employment.

Obsolete.    The label Obsolete is used with headwords and senses no longer in active use, except, for 
example, in literary quotations. Specifically, this label is attached to headwords and senses for which 
there is little or no printed evidence since 1755. Sense 6 of entertainment above is an example.

English-language labels. This Dictionary contains a number of labels noting the restriction of particular 
headwords and senses to specific areas of the English-speaking world. Among them is Chiefly British, 
which acknowledges that words are seldom restricted exclusively to the British or American vocabulary 
and in fact are often in use elsewhere in the world, as in New Zealand. Here is a typical example of a 
word labeled Chiefly British: 

win·kle2 (wîng¹kel) verb, transitive      win·kled, win·kling, win·kles      Chiefly British.      To pry, 
extract, or force from a place or position. Often used with out.

Other English-language labels are: Australian, Irish, Canadian, Scots, Caribbean, South African    

Dialect labels. When a word or sense is commonly used in a specific area of the United States and little 
used¾even if known¾in other areas, it has been given a dialect label.
This Dictionary uses dialect labels singly and in various combinations ranging from the very general 
(Regional) to the very specific (Cincinnati). The very specific labels, which are self-explanatory, serve as 
descriptors of geographic regions such as cities, states, and interstate areas.
Major areas of distribution. Major, generalized areas of dialect distribution are labeled as follows and 
can occur in any number of combinations:
Northern U.S. - from New Jersey and Pennsylvania north to New England and west to Washington and 
Oregon.



Southern U.S. - from southern Maryland along the coastal plains of Virginia, North and South Carolina, 
Georgia, Florida, Alabama, Mississippi, and Louisiana to eastern Texas and also including the "Upper 
South" as defined in the section "Midwestern and Midland."
Eastern U.S. - the Atlantic states from Maine to Florida, also including Vermont, New Hampshire, and 
upstate New York.
Western U.S. - west of the 100th parallel, which extends southward from the Dakotas to western 
Oklahoma and Texas. 
Subcategories of distribution. Within the major areas are these subcategories, the labels for which also
can occur in various combinations: 
For the north:
New England - Maine, New Hampshire, Vermont, Massachusetts, Connecticut, and Rhode Island.
Northeastern U.S. - New England, New York State, Pennsylvania, and New Jersey.
Upper Northern or Inland Northern U.S. - western upstate New York; northwest Pennsylvania; northern 
Ohio, Indiana, and Illinois; Michigan; Wisconsin; and Minnesota.
Lower Northern or North Midland U.S. - southern New Jersey and Pennsylvania; northern Delaware, 
Maryland, and West Virginia; Ohio; Indiana; Illinois; Iowa; and Nebraska.
Upper Midwest - Minnesota, Iowa, North and South Dakota, and Nebraska.
Northwestern U.S. or Pacific Northwest - Washington, Oregon, Idaho, Montana, and Wyoming.    
For the south:
Southeastern U.S. - North and South Carolina, Georgia, Florida, Tennessee, Alabama, and Mississippi.
Upper Southern or South Midland U.S. - southern Delaware, Maryland, West Virginia, Ohio, Indiana, and 
Illinois; western Virginia and North Carolina; northern Georgia, Alabama, Mississippi, and Louisiana; 
Tennessee; Kentucky; Arkansas; and eastern Oklahoma.
Lower Southern U.S. - Florida, Georgia, Alabama, Mississippi, Louisiana, and eastern Texas.
Eastern Lower Southern or South Atlantic U.S. - North and South Carolina, Georgia, and Florida.
For the east: 
Central Atlantic U.S. - Delaware; Washington, D.C.; eastern Virginia, Maryland, and Pennsylvania; and 
southern New Jersey.
North Atlantic Coast - Maine, Massachusetts, Rhode Island, Connecticut, southeast New York State, and 
northern New Jersey.
For the west:
Southwestern U.S. - Oklahoma, Texas, New Mexico, Arizona, and southern California.
Midwestern and Midland.    In addition to the labels just described, two labels are used that overlap with 
but lie outside the overall scheme. Midwestern U.S. designates regional terms that occur throughout the 
area from Michigan westward to the Dakotas and from Ohio westward to Kansas, an area that includes 
parts of several dialect areas. Midland U.S., a term previously used in American dialect geography, 
includes the Lower North and the Upper South. The collective label Midland is distinguished from 
Midwestern, which does not include the South. Two Midland words are Indian turnip for jack-in-the-pulpit 
and Italian for submarine.    
Gullah. The label Gullah refers not to a region but to the distinctive dialect of English spoken by American
Black people who live on the coast and coastal islands of Georgia, South Carolina, and northern Florida.

CROSS-REFERENCES
A cross-reference signals that additional information about one entry can be found at another entry. 
Cross-references have two main functions: to avoid needless duplication of information and to indicate 
where further discussion of a word occurs. Cross-references are hot, so clicking on the word will jump you
to the cross-referenced article.
The entry referred to is preceded by a brief descriptive or instructional phrase, and is colored as jump 
text.



bade (bàd, bâd) verb,      A past tense of bid.

The cross-reference indicates that bade is a past tense at the entry bid, where further information about 
the entry can be found.    
The word See is also used to introduce certain cross-references:

feath·er·edge (fèth¹er-èj´) noun      ¼2. See deckle edge.

A full definition is given at the entry referred to, in this case deckle edge. At the end of the definition of 
deckle edge the phrase Also called appears followed by one or more words, here, featheredge, that have 
the same meaning:    

deckle edge noun      The rough edge of handmade paper formed in a deckle. Also called 
featheredge.

ORDER OF SENSES
Entries containing more than one sense are arranged for the convenience of contemporary dictionary 
users with the central and often the most commonly sought meanings first. Senses and subsenses are 
grouped to show their relationships with each other. For example, in the entry for fatal shown below, the 
commonly sought meaning "Causing or capable of causing death" appears first and the now obsolete 
sense "Having been destined; fated" comes last in the series of five: 

fa·tal (fât¹l) adjective      1. Causing or capable of causing death. 
...5. Obsolete. Having been destined; fated.

Electronic and printed citations have been used to determine how all words should be defined. 

Division of senses. Boldface letters before senses indicate that two or more subsenses are closely 
related: 

phe·nom·e·non (fî-nòm¹e-nòn´, -nen) noun      plural phe·nom·e·na (-ne)      1.      ¼ 2. plural 
phe·nom·e·nons a. An unusual, significant, or unaccountable fact or occurrence; a marvel. b. A 
remarkable or outstanding person; a paragon. See Synonyms at wonder. 
3. Philosophy. a. That which appears real to the mind, regardless of whether its underlying 
existence is proved or its nature understood. b. In Kantian philosophy, the appearance of an 
object to the mind as opposed to its existence in and of itself, independent of the mind.

In a combined entry the senses are numbered in separate sequences after each part of speech:

ber·ry (bèr¹ê) noun      plural ber·ries      1. a. Botany. An indehiscent fruit derived from a single 
ovary and having the whole wall fleshy, such as the grape or tomato. b. A small, juicy, fleshy fruit, 
such as a blackberry or raspberry, regardless of its botanical structure.
2. The small, dark egg of certain crustaceans or fishes.

verb, intransitive      ber·ried, ber·ry·ing, ber·ries      1. To hunt for or gather berries: went berrying 
in July.      2. To bear or produce berries.

Information applicable only to a particular sense or subsense is shown after the number or letter of that 
sense or subsense:      

ra·dix (râ¹dîks) noun      plural rad·i·ces (ràd¹î-sêz´, râ¹dî-) or ra·dix·es      1. Biology. A root or 
point of origin.      2. Abbr. rad. Mathematics. The base of a system of numbers, such as 2 in the 
binary system and 10 in the decimal system. 

In this entry the subject label Biology applies only to the first sense. The subject label Mathematics and 
the abbreviation rad. apply only to the second sense. The same principles hold with respect to information
about capitalization and plural use:

lam·en·ta·tion (làm´en-tâ¹shen) noun
1. The act of lamenting.



2. A lament.
3. Lamentations (used with a sing. verb) Abbr. Lam., Lm Bible. 

In this entry the form Lamentations at sense 3 indicates that only the capitalized plural form is used to 
refer to the biblical book. The usage label used with a sing. verb means that this form, with this meaning, 
is used only with a singular verb. The abbreviations Lam. and Lm and the subject label Bible apply only to
sense 3.    
Labels and other information applicable to all senses in an entry with more than one part of speech 
appear before the first part of speech in that entry:

kedge (kèj) Nautical. noun      A light anchor used for warping a vessel.
verb      kedged, kedg·ing, kedg·es verb, transitive      To warp (a vessel) by means of a light 
anchor.
verb, intransitive To move by means of a light anchor.

The positioning of the label Nautical before the noun part-of-speech label, the first such label in the entry, 
indicates that Nautical applies to the entire combined entry-in this case, the noun and the verb. 

SPECIAL WORDING OF SOME DEFINITIONS
Information that is essential to the accurate presentation of a meaning of a word is included in a phrasal 
definition. In certain instances, however, the defining language varies.
Full-sentence expanders. Supplementary information is sometimes included in a full sentence after the 
phrasal definition if, on the basis of citational and other evidence, it is considered to be of special import:   

me·ter2 (mê¹ter) noun      Abbr. m      The international standard unit of length, approximately 
equivalent to 39.37 inches. It was redefined in 1983 as the distance traveled by light in a vacuum 
in 1/299,792,458 of a second.

Explanatory notes. Words whose meanings do not permit standard definitions have explanatory notes, 
beginning with Used or Often used. Words requiring notes of this kind include function words, 
interjections, intensives, some auxiliary verbs, and words labeled Offensive and Offensive Slang. An 
example is the explanatory note at the interjection ugh:    

Used to express horror, disgust, or repugnance.

ATTRIBUTIVES
It has long been a characteristic feature of English that nouns, like adjectives, can be used to modify other
nouns. Nouns used in this way are labeled attributives in this Dictionary. An attributive is a word that freely
occurs as a modifier of a broad group of other nouns, does not undergo comparison in the manner of true 
adjectives, cannot be modified by very, and does not regularly occur in the predicate after be.    
Attributives are included as subsections of some noun entries. Verbal illustrations exemplify typical 
contexts of their usage:    

gas (gàs) noun      plural gas·es or gas·ses      1.    a. The state of matter distinguished from the 
solid and liquid states by relatively low density and viscosity, relatively great expansion and 
contraction with changes in pressure and temperature, the ability to diffuse readily, and the 
spontaneous tendency to become distributed uniformly throughout any container. b. A substance 
in the gaseous state.
2.    A gaseous fuel, such as natural gas. 3. Gasoline.      4. The speed control of a gasoline 
engine: Step on the gas.      5. A gaseous asphyxiant, irritant, or poison.      6. A gaseous 
anesthetic, such as nitrous oxide.      7. a. Flatulence. b. Flatus.      8. Slang. Idle or boastful talk.     
9. Slang. Someone or something exceptionally exciting or entertaining: The party was a gas. 
noun, attributive    Often used to modify another noun: gas tanks; gas stoves.



ILLUSTRATIVE EXAMPLES
In this Dictionary there are tens of thousands of illustrative examples, of which more than 4,000 are 
quoted from over 2,000 separate sources. These illustrative examples, which follow the definitions and 
are set in italic type, show the headwords in typical contexts. The examples are taken from our files of 
electronic and printed citations showing patterns of word usage by a broad group of educated speakers in
a wide array of publications. Such examples are especially helpful in showing changing usage, attesting 
to the existence of new words and meanings, illustrating transi- tive and intransitive verbs, revealing 
figurative uses of words, and exemplifying levels and styles of usage. Here are some instances of the use
of quoted illustrations:      

self-con·fi·dence (sèlf¹kòn¹fî-dens) noun      Confidence in oneself or one's own abilities: 
"Without self-confidence we are as babes in the cradle" (Virginia Woolf). 

wis·dom (wîz¹dem) noun      1. Understanding of what is true, right, or lasting; insight: "One 
cannot have wisdom without living life" (Dorothy McCall).      2. Common sense; good judgment: "It
is a characteristic of wisdom not to do desperate things" (Henry David Thoreau).

Illustrative examples that are not direct quotations appear in entries such as the verb speak: 

speak (spêk) verb      spoke (spok) spo·ken (spo¹ken) speak·ing, speaks verb, intransitive      ¼
4. a. To make a statement in writing: The biography speaks of great loneliness. b. To act as 
spokesperson: spoke for the entire staff.      5. a. To convey a message by nonverbal means: 
Actions speak louder than words. b. To be expressive: spoke with her eyes. c. To be appealing: 
His poetry speaks to one's heart.

PHRASAL VERBS
A phrasal verb is an expression consisting of a verb and an adverb or a preposition with a unitary 
meaning that cannot be deduced from the sum total of the meanings of its constituent parts. Phrasal 
verbs, set in boldface type and introduced by the heading phrasal verbs, follow the main definitions and 
precede the idioms, if any are present. Phrasal verbs are listed in alphabetical order:    

set (sèt) verb      set, set·ting, sets verb, transitive      1. To put in a specified position; place: set a 
book on a table.
... ¾phrasal verb.
set about      To begin or start: set about solving the problem.
set apart      1. To reserve for a specific use.      2. To make noticeable: character traits that set her 
apart.
set aside      1. To separate and reserve for a special purpose.      2. To discard or reject.
3. To declare invalid; annul or overrule: The court has set aside the conviction.
set at      To attack or assail: The 13 dogs set at the fox.
set back      1. To slow down the progress of; hinder.      2. Informal.. To cost: That coat set me 
back $1,000.
set by      To reserve for future use: It is wise to set food and money by in case of a future 
emergency. 

IDIOMS
An idiom is an expression consisting of two or more words having a meaning that cannot be deduced 
from the sum total of the meanings of its constituent parts. Idioms, set in boldface type and introduced by
the heading idioms, are fully defined in the last part of an entry. Idioms are listed in alphabetical order: 

take (tâk) verb      took (t¢k) tak·en (tâ¹ken) tak·ing, takes verb, transitive      1. To get into one's 
possession by force, skill, or artifice...
 ¾ idiom.      on the take Informal. Taking or seeking to take bribes or illegal income: "There were
policemen on the take" (Scott Turow).      take a bath Informal. To experience serious financial 
loss: "Small investors who latched on to hot new issues took a bath in Wall Street" (Paul A. 
Samuelson).      take account of To take into consideration.      take away from    To detract: Her 



stringy hair takes away from her lovely face.      take care To be careful: Take care or you will slip 
on the ice.      take care of To assume responsibility for the maintenance, support, or treatment of. 
take charge To assume control or command.

ETYMOLOGIES
Etymologies appear in square brackets following the definitions. An etymology traces the history of a word
from one language to another as far back in time as can be determined with reasonable certainty. The 
most recent stage before Modern English is given first, with each earlier stage following in sequence: 

cab·in (kàb¹în) noun      1. A small, roughly built house; a cottage      [Middle English caban, from 
Old French cabane, from Old Provençal cabana, from Late Latin capanna.]

A language name, linguistic form, and brief definition, or gloss, of that form are given for each stage of the
derivation. In order to avoid redundancy, however, a language, form, or gloss is not repeated if it is 
identical to the corresponding item in the immediately preceding stage. In the example shown for cabin, 
the different Middle English, Old French, and Late Latin forms have the same gloss, which is the same as 
the first definition of the Modern English word cabin: "small, roughly built house".
Content of etymologies. The etymologies in this Dictionary are designed to be as readable as possible. 
They rarely use abbreviations, symbols, or highly technical terms. The traditional language of descriptive 
grammar is used to identify parts of speech and various grammatical and morphological forms and 
processes, such as diminutive, frequentative, variant, stem, past participle, and metathesis. All of these 
terms are fully defined entries in the Dictionary. Likewise, every language that is cited in an etymology is 
either a Dictionary entry or is glossed in the etymology itself.    
Sometimes a stage in the history of the word is not attested, yet there is reasonable certainty from 
comparative evidence about what the missing linguistic form looked like and what language it belonged 
to. These unattested forms are preceded by an asterisk indicating their hypothetical nature:      

cer·tain (sûr¹tn) adjective
1. Definite; fixed: set aside a certain sum each week.
2. Sure to come or happen; inevitable: certain success.
3. Established beyond doubt or question; indisputable: What is certain is that every effect must 
have a cause    ¼ [Middle English, from Old French, from Vulgar Latin *certânus, from Latin 
certus, past participle of cernere, to determine.]

If a word is taken from the name of a person or place, such names are identified with pertinent information
as to time or place. The etymology usually stops there, although a further etymology of the name itself is 
occasionally given.
Some words are not given etymologies. These include interjections, trademarks, and ethnic names that 
are Anglicizations of the group's name for itself. A large and important group of words not given explicit 
etymologies consists of compounds and derivatives, such as sodium chloride, emergence, and euploid, 
formed in English from words or word elements that are themselves entries in the Dictionary. If only a 
portion of an entry is used in an etymology, the unused portion of the entry is enclosed within 
parentheses:      

bal·lis·to·car·di·o·gram (be-lîs´to-kär¹dê-e-gràm´) noun      A recording made by a 
ballistocardiograph. [BALLIST(IC) + CARDIOGRAM.]

Derivatives such as emergence, from emerge, in which only the final vowel of one constituent has been 
deleted, are assumed to be sufficiently understandable not to need etymologies.    
Style of etymologies. The etymologies present a great deal of complex information in a small space, and
for this reason certain typographic and stylistic conventions are used. The word from indicates origin of 
any kind-by inheritance, borrowing, derivation, or composition. When a compound word is split into its 
component elements, a colon introduces them. Each element is traced in turn to its further origins. 
Parentheses enclose the further history of a part of a compound:

pseud·e·pig·ra·pha (s¡´dî-pîg¹re-fe) plural noun      1. Spurious writings, especially writings 
falsely attributed to biblical characters or times.      2. A body of texts written between 200 B.C. and



A.D. 200 and spuriously ascribed to various prophets and kings of Hebrew Scriptures.      [Greek, 
from neuter pl. of pseudepigraphos, falsely ascribed : pseudês, false. See PSEUDO- + 
epigraphein, to inscribe (epi-, epi- + graphein, to write).] 

At times it is necessary to cross-refer from one etymology to another, either to avoid repeating part of a 
lengthy and complex derivation or to indicate the close relationship between two different Modern English 
words: 

bat (bàt) verb, transitive      bat·ted, bat·ting, bats      To wink or flutter: bat one's eyelashes. 
[Probably a variant of BATE2.]

A word or word element in an etymology printed in small capitals is an entry in the Dictionary and should 
be referred to for more etymological information. Linguistic forms that are not Modern English words 
appear in italics, and glosses and language names appear in roman type.    
The transliterations of Greek, Russian, Arabic, and Hebrew are as shown in tables in the article for 
alphabet. Old English thorn (r) and edh (s) are both given as th, whereas Old Norse thorn is spelled as 
th and the phonemically distinct edh as dh. In Latin all long vowels are marked with macrons. Mandarin 
Chinese forms are given in the Pinyin system. The transcription of African and Native American 
languages occasionally requires the use of symbols-usually drawn from the International Phonetic 
Alphabet-whose values will be apparent to specialists but are not discussed here.    

UNDEFINED FORMS
At the end of many entries additional boldface words appear without definitions¾words either formed from
the headwords by the addition of suffixes or otherwise closely and clearly related to the headwords. 
These run-on entries are related in basic meaning to the headword but have different grammatical 
functions, as indicated by their part-of-speech labels. Multisyllabic run-ons are divided into syllables and 
show primary and secondary stresses as needed. Pronunciations are included as required:    

ex·cuse (îk-sky¡z¹) verb, transitive      ex·cused, ex·cus·ing, ex·cus·es      ¼ [Middle English 
excusen, from Old French excuser, from Latin excúsâre : ex-, ex- + causa, accusation. See 
cause.] ¾ ex·cus¹a·ble adjective      ¾ ex·cus¹a·ble·ness noun    
¾ ex·cus¹a·bly adverb      ¾ ex·cus¹er noun

Undefined run-ons are usually entered in alphabetical order. However, when different run-ons have the 
same grammatical function and the same meaning, they are separated by a comma and share a single 
part-of-speech label. For instance, at the entry lampoon the variants lampooner and lampoonist have the 
same meaning and function and are therefore run on together:
lam·poon (làm-p¡n¹) noun      ¼ [French lampon, perhaps from lampons, let us drink (from a common 
refrain in drinking songs), first person pl. imperative of lamper, to gulp down, of Germanic origin.] ¾ 
lam·poon¹er or lam·poon¹ist noun      ¾lam·poon¹er·y noun     

In other instances, undefined run-ons have the same grammatical function but different meanings. These 
appear separately, as is the case with excusableness and excuser at the entry excuse.
In some cases a headword appears unchanged as a run-on at the end of that entry with a different part-
of-speech label. This indicates that the word is related in basic meaning to the headword but has a 
different grammatical function.    

SYNONYM PARAGRAPHS
Synonyms of special interest are listed after the entry for the central word in the group. Synonym 
paragraphs are introduced by the heading Synonyms. There are two kinds of synonym paragraphs. The 
first consists of a group of undiscriminated, alphabetically ordered words sharing a single, irreducible 
meaning. Antonyms, if applicable, appear at the end of the paragraph, as seen at the entry for the 
adjective plentiful:      

Synonyms: plentiful, abundant, ample, copious, plenteous. The central meaning shared by these
adjectives is "being fully as much as one needs or desires": a plentiful supply of stationery; her 



abundant talent; ample space; copious provisions; a plenteous crop of wheat.

Antonyms: scant.

The second kind, exemplified at the adjective entry real1, consists of fully discriminated synonyms 
ordered in a way that reflects their interrelationship. A brief sentence explaining the initial point of 
comparison of the words is given, followed by explanations of connotations and varying shades of 
meaning:      

Synonyms: real, actual, true, existent. These adjectives are compared as they mean not 
imaginary but having verifiable existence. Real implies that something is genuine or authentic or 
that what it seems or purports to be tallies with fact: Don't lose the bracelet; it's made of real gold. 
My mother showed real sympathy for my predicament. "The general, in a well-feigned or real 
ecstasy, embraced him" (William Hickling Prescott). Actual means existing and not merely 
potential or possible: "rocks, trees ¼the actual world" (Henry David Thoreau); "what the actual 
things were which produced the emotion that you experienced" (Ernest Hemingway). True implies
that something is consistent with fact, reality, or the actual state of things: "It is undesirable to 
believe a proposition when there is no ground whatever for supposing it true" (Bertrand Russell). 
Existent applies to what has life or being: Much of the beluga caviar existent in the world is found 
in the Soviet Union and Iran. See also Synonyms at authentic

In both kinds of paragraphs the synonyms are set in lightface italic type. Illustrative examples, many of 
them quoted, exemplify the use of the synonyms in context.    
Synonym cross-references. Every synonym in a synonym paragraph is itself cross-referenced to that 
synonym paragraph. For instance, the word true is discussed in the synonym paragraph at the entry real. 
Therefore, definition 1a of the entry true ¾the definition directly tied in with the synonym paragraph at 
real ¾contains a cross-reference to the synonym paragraph at real:      

true (tr¡) adjective tru·er, tru·est    1. a. Consistent with fact or reality; not false or erroneous. See
Synonyms at real1.

Sometimes a word is discussed in more than one synonym paragraph. Cross-references are given to all 
the synonym paragraphs that include this word. An example is unaffected, which appears in synonym 
paragraphs at both naive and sincere:      

un·af·fect·ed (ùn´e-fèk¹tîd) adjective      1. Not changed, modified, or affected.
2. Marked by lack of affectation; genuine. See Synonyms at naive, sincere.

At times the headword central to one synonym group is a synonym in a group of synonyms at another 
entry. Such is the case with the entry real. At the end of the synonym paragraph at real, a cross-reference
directs you to another synonym paragraph at the entry authentic.

USAGE NOTES
Usage Notes following many entries present important information and guidance on matters of grammar, 
diction, pronunciation, and registers and nuances of usage.
Some Notes, such as the one at world-class, contain opinions of the Usage Panel: 

world-class (wûrld¹klàs¹) adjective      1. Ranking among the foremost in the world; of an 
international standard of excellence; of the highest order: a world-class figure skater.            2. 
Usage Problem. Great, as in importance, concern, or notoriety.

Usage Note: The adjective world-class became current as a result of its original use to describe 
athletes capable of performing at an international level of competition, as in A ten-second time 
would put him in the first rank of world-class sprinters. In recent years it has been extended to 
mean "of an international standard of excellence" and has been applied to a wide variety of 
categories. When used of things that naturally admit such comparison, the extended use of the 
word is generally acceptable to the Usage Panel. In the most recent survey 65 percent accepted 
the description world-class restaurant, and 53 percent accepted world-class sports car. But the 
expression is not generally accepted as a vague way of emphasizing magnitude or degree. The 



sentence Johann Sebastian Bach's 300th birthday will rank as a world-class anniversary was 
acceptable to only 7 percent, and only 4 percent accepted a newspaper's description of AIDS as 
a world-class tragedy.

An example of a Usage Note without an opinion of the Usage Panel is found at the entry criterion:      

Usage Note: Like the analogous etymological plurals agenda and data, criteria is widely used as 
a singular form. Unlike them, however, it is not yet acceptable in that use.

Usage Note cross-references. A Note containing information related to the content of another Note ends
with a cross-reference:      

well2 (wèl) adverb bet·ter (bèt¹er) best (bèst)
...Usage Note: Used as an adjective applied to people, well usually refers to a state of health, 
whereas good has a much wider range of senses. It has always been a first principle of 
grammatical criticism that there should be no difference without a distinction, and perhaps for this 
reason, some critics have insisted that the expression feel good cannot be used in reference to 
health. It is true that there is a distinction between feel well and feel good, but both can be applied
to a state of health. Thus a patient suffering from a chronic disease might appropriately say to a 
doctor I feel good today, which implies a relative lack of physical discomfort. By contrast, I feel 
well today would be appropriate if the patient believes that the ailment has disappeared. See 
Usage Note at good.

The Note at well2 concludes with a cross-reference to related information in the Note at the entry good. 
Similarly, the Note at good concludes with a cross-reference to the Note at well2:    

good (g¢d) Abbr. gd., G, G. adjective bet·ter (bèt¹er) best (bèst)
...Usage Note: Good is properly used as an adjective with linking verbs such as be, seem, or 
appear: The future looks good. The soup tastes good. It should not be used as an adverb with 
other verbs: The car runs well (not good). Thus, The dress fits well and looks good. See Usage 
Note at well2

If an entry without a Note is discussed in a Note elsewhere, that entry contains a cross-reference to the 
Note where a full discussion is to be found. For example, the entry -ess contains a Usage Note. The 
content of this Note has direct bearing on the use of the word stewardess. Consequently, the entry 
stewardess has a cross-reference directing the reader to the Note at -ess:

stew·ard·ess (st¡¹er-dîs, sty¡¹-) noun      A woman flight attendant.      See Usage Note at -ess.

REGIONAL NOTES
This Dictionary contains hundreds of words and meanings whose occurrence is restricted to certain areas
of the United States. Many entries contain Regional Notes explaining in detail a point of dialect. For 
example, the word dragonfly is widespread in American English, but dialect terms for the insect abound. 
These dialect terms, listed at the entry for dragonfly, are discussed in the Regional Note at the end of the 
entry: 

drag·on·fly (dràg¹en-flì´) noun      plural drag·on·flies      Any of various large insects of the order 
Odonata or suborder Anisoptera, having a long slender body and two pairs of narrow, net-veined 
wings that are usually held outstretched while the insect is at rest. Also called Regional. darning 
needle Regional. devil's darning needle Regional. ear sewer Regional. mosquito hawk Regional. 
skeeter hawk Regional. snake doctor Regional. snake feeder Regional. spindle.

Regional Note: Regional terms for the dragonfly are numerous, providing good evidence for 
dialect boundaries in the United States. The greatest variety of terms is to be found in the South, 
where the most widespread term is snake doctor (a name based on a folk belief that dragonflies 
take care of snakes). The Midland equivalent is snake feeder. Speakers from the Lower South, on
the other hand, are more likely to refer to the same insect as a mosquito hawk or, in the South 
Atlantic states, a skeeter hawk. The imagery outside the South alludes more to the insect's shape
than to its behavior or diet: Upper Northern speakers call it a darning needle or a devil's darning 
needle; those in Coastal New Jersey, a spindle; and Northern Californians, an ear sewer.



Regional Note cross-references. Regional Notes are fully cross-referenced. In the case of snake doctor,
a term appropriately labeled to reflect its use in the South, the entry contains two cross-references¾a 
"See" cross-reference directing the reader to the main entry at dragonfly, where the full definition and a 
list of synonymous terms are found, and a "Regional Note" cross-reference directing the reader to the 
Regional Note at dragonfly for full discussion of the distribution of these terms:

snake doctor noun      1. Chiefly Southern U.S.    .See dragonfly. See Regional Note at dragonfly.
2. See hellgrammite.

WORD HISTORIES
In addition to etymologies, which necessarily contain information in a compressed form, this Dictionary 
provides word history paragraphs at entries whose etymologies are of particular interest. In these 
paragraphs the bare facts of the etymology are expanded to give a fuller understanding of how important 
linguistic processes operate, how words move from one language to another, and how the history of an 
individual word can be related to historical and cultural developments. For example, the history of the 
word alligator involves borrowing from Spanish into English, as its etymology reveals, but the word history
also describes the role of taboo deformation in the history of the word alligator and in that of crocodile as 
well. Usually the word history also contains the date at which the word was first recorded in English:      

al·li·ga·tor (àl¹î-gâ´ter) noun      1. Either of two large reptiles, Alligator mississipiensis of the 
southeast United States or A. sinensis of China, having sharp teeth and powerful jaws. They differ
from crocodiles in having a broader, shorter snout.      2. Leather made from the hide of one of 
these reptiles.      3. A tool or fastener having strong, adjustable, often toothed jaws. noun, 
attributive Often used to modify another noun: an alligator pond; an alligator handbag.      
[Alteration of Spanish el lagarto, the lizard : el, the (from Latin ille, that) + lagarto, lizard (from 
Latin lacertus). 

Word History: In The Travailes of an Englishman, published in 1568, Job Hortop says that "in 
this river we killed a monstrous Lagarto or Crocodile." This killing gives rise to the first recorded 
instance of alligator in English, obviously in a different form from the one familiar to modern 
speakers. Alligator, which comes to us from Spanish el lagarto, "the lizard," was modified in 
pronunciation and form in several ways before taking on the form alligator. Such changes, 
referred to by linguists as taboo deformation, are not uncommon in a name for something that is 
feared and include, for example, the change in sequence of the r and t that occurred between el 
lagarto and alligator. An interesting parallel case is crocodile, which appears in Spanish, for 
example, as cocodrilo, with a similar difference in the sequence of the r. The earliest recorded 
form of alligator that is similar to ours appears in Shakespeare's Romeo and Juliet (First Folio, 
1623): "In his needie shop a tortoyrs hung,/An Allegater stuft."

Yet another example showing how the facts of etymology are expanded in a word history paragraph to 
give the reader a better understanding of the historical and social forces shaping word and sense 
development is found at the entry holocaust, where meaning, usage, and history are clearly delineated by
the definitions, the Usage Note, and the word history paragraph: 

hol·o·caust (hòl¹e-kôst´, ho¹le-) noun      1. Great or total destruction, especially by fire.      2. a. 
Widespread destruction. b. A great disaster.      3. a. Holocaust. The genocide of European Jews 
and others by the Nazis during World War II: "Israel emerged from the Holocaust and is defined in
relation to that catastrophe" (Emanuel Litvinoff). b. A massive slaughter: "an important document 
in the so-far sketchy annals of the Cambodian holocaust" (Rod Nordland).      4. A sacrificial 
offering that is consumed entirely by flames.      [Middle English, burnt offering, from Old French 
holocauste, from Latin holocaustum, from Greek holokauston, from neuter of holokaustos, burnt 
whole : holo-, holo- + kaustos, burnt (from kaiein, to burn). ¾ hol´o·caus¹tal or hol´o·caus¹tic 
adjective

Usage Note: When referring to the massive destruction of human beings by other human beings,
holocaust has a secure place in the language. Fully 99 percent of the Usage Panel accepts the 
use of holocaust in the phrase nuclear holocaust. Sixty percent accepts the sentence As many as



two million people may have died in the holocaust that followed the Khmer Rouge takeover in 
Cambodia. But because of its associations with genocide, extended applications of holocaust 
may not always be received with equanimity. When the word is used to refer to death brought 
about by natural causes, the percentage of the Panel's acceptance drops sharply. Only 31 
percent of the Panel accepts the sentence In East Africa five years of drought have brought about
a holocaust in which millions have died. Just 11 percent approved the use of holocaust to 
summarize the effects of the AIDS epidemic. This suggests that other figurative usages such as 
the huge losses in the Savings and Loan holocaust may be viewed as overblown or in poor taste.

Word History: Totality of destruction has been central to the meaning of holocaust since it first 
appeared in Middle English in the 14th century and referred to the biblical sacrifice in which a 
male animal was wholly burnt on the altar in worship of God. Holocaust comes from Greek 
holokauston (that which is completely burnt"), which was a translation of Hebrew ôlâ (literally "that
which goes up," that is, in smoke). In this sense of "burnt sacrifice," holocaust is still used in some
versions of the Bible. In the 17th century the meaning of holocaust broadened to "something 
totally consumed by fire," and the word eventually was applied to fires of extreme 
destructiveness. In the 20th century holocaust has taken on a variety of figurative meanings, 
summarizing the effects of war, rioting, storms, epidemic diseases, and even economic failures. 
Most of these usages arose after World War II, but it is unclear whether they permitted or resulted
from the use of holocaust in reference to the mass murder of European Jews and others by the 
Nazis. This application of the word occurred as early as 1942, but the phrase the Holocaust did 
not become established until the late 1950's. Here it parallels and may have been influenced by 
another Hebrew word, sho'ah ("catastrophe"). In the Bible sho'ah has a range of meanings 
including "personal ruin or devastation" and "a wasteland or desert." Sho'ah was first used to 
refer to the Nazi slaughter of Jews in 1939, but its phrase ha-sho'ah ("the catastrophe") only 
became established after World War II. Holocaust has also been used to translate hurban 
("destruction"), another Hebrew word used to summarize the genocide of Jews by the Nazis. This
sense of holocaust has since broadened to include the mass slaughter of other peoples, but 
when capitalized it refers specifically to the destruction of Jews and other Europeans by the Nazis
and may also encompass the Nazi persecution of Jews that preceded the outbreak of the war.



Guide to the Indo-European Roots: Conventions Used to Present and Define 
Roots
This Dictionary carries the etymology of the English language to its logical and natural conclusion, for if 
the documentary history of words is of interest and value, so is their reconstructed prehistory. The 
historical component is given in the etymologies, after the definitions in the Dictionary articles. Indo-
European roots supply the prehistoric component, tracing the ultimate Indo-European derivations of those
English words that are descended from a selected group of Indo-European roots.    
Bookshelf 1995 includes each Indo-European root as a separate article listed alphabetically among the 
definition articles in the Dictionary Table of Contents found on the Contents tab.
In each Indo-European root article, the boldface headword is, unless otherwise identified, an Indo-
European root in its basic form. This basic root form is followed by a list of italicized words that are some 
of its more important Modern English descendants. 
The beginning of the article body may list one or more boldface variants of the root preceeded by the 
word "Also." The rest of the article body provides the basic meaning or meanings of the root.
Meanings that are different parts of speech are separated by a semicolon:

Examples:
kei-1. To lie; bed, couch; beloved, dear.
pele-2. Flat; to spread.
leg-. To collect; with derivatives meaning to "speak."

After the basic meaning there may appear further information about the phonological shape or nature of 
the root:

Examples:
skei-. To cut, split. Extension of sek-.
kwRmi-. Worm. Rhyme word to *wRmi-, worm (see wer-2).
pâ-. To protect, feed. Contracted from *pa¶-.
lìk-. Body, form; like, same. Germanic root.

Most, but not all, of the additional information is self-explanatory. In the first two examples above, the 
forms sek- and wer-2 are cross-references to those roots, which have their own articles in the Dictionary. 
In the example pâ- the form *pa¶- represents an older root form. (The nature of these contractions is 
explained in an essay by Calvert Watkins titled "Indo-European and the Indo-Europeans" under the 
section "Speech Sounds and their Alternations." This essay can be found in the back of the print version 
of The American Heritage Dictionary, Third Edition.) The articles lìk-, nêhw-iz, and re- are not, strictly 
speaking, Indo-European, since they are represented in only one branch of the family, but they are each 
included because of the number of English words among their descendants.
The text of each article describes in detail the development of Modern English words from the root. Each 
section of an entry begins with a list, in SMALL CAPITALS, of the Modern English words derived from a 
particular form of the root. The simple (uncompounded) derivatives are given first; the compounds follow, 
separated from them by a semicolon. Parentheses indicate that the etymology of a word in the main body 
of the Dictionary contains a cross-reference to the etymology at another entry. In some cases no further 
semantic or morphological development needs to be explained, and the lemma, the historically attested 
representative of the root, is immediately given:

Example: 
awi-. Bird. I. 1. AVIAN…from Latin avis, bird. 

Much more commonly, however, intermediate developments require explanation. These intermediate 
stages are reconstructions representing a word stem in Indo-European that is necessary to explain the 
lemma following it. (For more information see the section "Grammatical Forms and Syntax" in an essay 
by Calvert Watkins titled "Indo-European and the Indo-Europeans." This essay can be found in the back 
of the print version of The American Heritage Dictionary, Third Edition.) The reconstructed forms are not 
historically attested; they are preceded by an asterisk (*) to note this fact. Sometimes earlier or later 



developments of the intermediate forms are given in parentheses, as in the example of stâ- below. In 
these cases the symbol < is used to mean "derived from" and the symbol > is used to mean "developed 
into." The following terms are used to describe typical morphological processes of Indo-European:
Full-grade form: A form with e-vocalism (the basic form); so identified for descriptive contrast.

O-grade form: A form with o-vocalism: 
nekw-t-…O-grade form *nokw -t-.

Zero-grade form: A form with zero-vocalism: 
men-1…I. Zero-grade form *mn-.

Lengthened-grade form: A form with lengthened vocalism: 
ked-…1. Lengthened-grade form *kêd-.

Secondary full-grade form: A new full-grade form created by inserting the fundamental vowel e in the 
zero-grade form of an extended root: 

stâ-…V. Zero-grade extended root *stú- (< *stu¶-).… VI. Secondary full-grade form *steu¶-.

Basic form: The unchanged root; so identified for descriptive contrast. 

Suffixed form: A form with one or more suffixes, written with an internal hyphen: 
laks-…Suffixed form *laks-o-.
maghu-…Suffixed form *magho-ti-.
mel-2…1. Suffixed (comparative) form *mel-yos.

Prefixed form: A form with a prefix, written with an internal hyphen:
op-…6.…from prefixed form *co-op-.

Extended form: A form with an extension or enlargement, written without internal hyphens:
pel-5…II. Extended form *pel¶-.

Nasalized form: A form with a nasal infix, written with internal hyphens: 
tag-…1. Nasalized form *ta-n-g-.

Reduplicated form: A form prefixed by its own initial consonant followed by a vowel: 
segh-…5. Reduplicated form *si-sgh-.

Expressive form: A form with "expressive gemination" (doubling of the final consonant), written without 
internal hyphens: 

gal-…3. Expressive form *gall-.

Compound form: A form compounded with a form of another root, written with internal hyphens: 
dem-…3. Compound *dems-pot-.

Shortened form: A form with shortened vocalism: 
syú-…III. Suffix shortened form *syu-men-.



Reduced form: A form with loss of one or more sounds: 
ghesor-…Reduced form *ghesr-.

Oldest root form: A root form showing a laryngeal (¶) in a position, typically at the beginning or end of a 
root, where it is preserved in only a few Indo-European languages, such as Greek or Hittite: 

ster-3…3. Oldest root form *¶ster-.

Variant form: A form altered in any way other than those described in the above categories: 
deru-…2. Variant form dreu-.

These terms can be combined freely to describe in as much detail as necessary the development from 
the root to the lemma. 

dhê(i)-…1. Suffixed reduced form *dhê-mnâ-.FEMALE, FEMININE; EFFEMINATE from Latin fêmina, 
woman (< "she who suckles").

gere-1…1. Suffixed lengthened-grade form *gêr¶-s-. AGERATUM, GERIATRICS, from Greek gêras, old 
age.

pete-…2. Suffixed (stative) variant zero-grade form *pat-ê -. PATENT, PATULOUS, from Latin patêre, to 
be open.

In order to emphasize the fact that English belongs to the Germanic branch of Indo-European and give 
precedence to directly inherited words in contrast to words borrowed from other branches, the 
intermediate stages in Germanic etymologies are covered in fuller detail. The Common or Proto-
Germanic (here called simply Germanic) forms underlying English words are always given. Where no 
other considerations intervene, Germanic is given first of the Indo-European groups, and Old English is 
given first within Germanic, although this order of precedence is not rigidly applied. 
The final item in most entries is an abbreviated reference, in brackets, to Julius Pokorny's 
Indogermanisches Etymologisches Wörterbuch (Bern, 1959). This, the standard work of reference and 
synthesis in the Indo-European field, carries a full range of the actual comparative material on which the 
roots are reconstructed. The Indo-European root articles present only those aspects of the material that 
are directly relevant to English. For example, the English word MANY is found at the root menegh-, 
"copious." This entry describes the transition of the Indo-European form through Germanic *managa- to 
Old English manig, mænig, "many." It does not cite the evidence on which this assertion is based, but it 
refers to "Porkorny men(e)gh- 730." The entry men(e)gh- on page 730 in Pokorny's dictionary cites, in 
addition to the Old English word, the forms attested in Sanskrit, Celtic, Gothic, Old High German, Old 
Norse, Slavic, and Lithuanian, from which the reconstruction of the root was made. These references 
should serve as a reminder that the information given in the Indo-European root articles is assertive rather
than expository and that the evidence and evaluation upon which its assertions are based are not 
presented here. 



Understanding Roget's Thesaurus
The Thesaurus is divided into six Classes. The first three Classes cover the external world: Abstract 
Relations deals with such ideas as number, order and time; Space is concerned with movement, shapes 
and sizes, while Matter covers the physical world and humankind's perception of it by means of the five 
senses. The last three Classes deal with the internal world of human beings: the human mind (Intellect); 
the human will (Volition); and the human heart and soul (Emotion, religion and morality). There is a logical
progression from abstract concepts, through the material universe, to mankind itself, culminating in what 
Roget saw as humankind's highest achievements: morality and religion.
Roget borrowed his scheme from natural history, with its hierarchy of Phyla, Classes, Orders and 
Families. His system has also been compared to a tree, with ever smaller ramifications diverging from the
main branches. This is a workable way of dividing up human experience, as can be seen from the way 
Roget's system has survived intact through numerous revisions. But life, as Roget himself points out, is 
not easily compartmentalized. "Choice," for example, involves both the will (Volition) and the intellect 
(Intellect). The language that reflects our experience is equally complex, more like a web than a tree, for it
interconnects at all points. Also, one word may have many meanings depending on its context. Roget was
aware of this problem. His solution was to use copious cross-references to link related groups of words, a 
method which succeeded in both reflecting the complexity of language and coming to terms with it.
For an overview of Roget's system, see Roget's Plan of Classification. This shows the six Classes, further
subdivided into Sections. Each Section deals with a particular aspect of the Class within which it is found. 
So under Class One, Abstract Relations, we find Sections for Quantity, Order, Time and so on. The 
Sections themselves are further subdivided into Heads and Keywords. Under Abstract Relations, in the 
Section called Time, for instance, there are 35 Heads dealing with, among others, the ideas of Present 
Time, Past Time, Transience, and Age. (In the Bookshelf Thesaurus, you can see the complete branching
of Roget's Plan by clicking the Outline button when any Thesaurus article is open in the Article window. 
The Outline breaks down each Class into Sections, Heads, and Keywords.) There are 990 Heads in the 
present edition, a slight reduction from Roget's original 1,000. It is the Heads that form the basic units of 
the Thesaurus, and they follow each other in a logical progression. It is a sign of Roget's skill in compiling 
the Thesaurus that this basic framework has remained virtually intact through edition after edition of the 
copyright version, of which this is the most recent. The reader should bear in mind that a Head expresses 
a given idea or ideas; it really does not matter whether you look up a noun, a verb, or an adjective, as 
once you have found the right Head, all the parts of speech conveying that idea will be available to you.
The Heads themselves are divided into separate articles, grouped together according to their Keyword 
and part of speech (in parentheses). The Head Hope, for example, has three Keywords that are nouns, 
two that are adjectives, two that are verbs, one that is an adverb and one that is an interjection. Not all 
Heads have a full complement of parts of speech, nor are the labels themselves applied too strictly, words
and phrases being allocated to the part of speech that most closely describes their function. The Keyword
is both a clue to the kind of words found in that article, and also itself part of the vocabulary. It is not a 
synonym of the words which follow: it was Roget's intention to offer words that express every aspect of an
idea, rather than to list the synonyms. It is called the Keyword because it is both the "key" to the rest of 
the article, and the "open sesame" to the whole Thesaurus, being used to identify the position of other 
words in the Table of Contents and cross-references.
Within the articles, words are grouped according to their meaning, context or level of usage (i.e. 
colloquial, formal, etc.). These groups follow one another in a logical sequence, exploring every aspect of 
the idea under consideration. By comparing, whether consciously or not, the words and phrases offered, 
you can now select the most appropriate. It was Roget's expectation that his readers would "recognize" 
the word they wanted, guided by "an instinctive tact." On this assumption, words having more than one 
meaning or context are not usually repeated within articles, nor are transitive and intransitive verbs listed 
separately. Where the right word is not immediately apparent, but an unfamiliar one seems from the 
context as if it might answer, it is advisable, especially for non-English speakers, to check the American 
Heritage Dictionary in Bookshelf. Yet more ideas can be obtained by clicking the colored hot words in 
Bookshelf Thesaurus articles. Each hot word, besides being an item of vocabulary in its own right, is also 
the Keyword of an article within the given Head. It is also worth consulting the Outline for the Heads 
before and after the one originally looked up. Most Heads are in pairs, representing the positive and 
negative aspects of an idea, e.g. Hope and Hopelessness. Sometimes several Heads between them 



cover an idea¾"education" is dealt with in Teaching, Misteaching, Learning, Teacher, Learner and School.
A few conventions should be explained. These have mainly been designed to avoid repetition and save 
space. Conjugate forms are often indicated by the use of "etc. adj." For instance, under the Head 
Content, the article for the Keyword be content shows "be content, -satisfied etc. adj.," suggesting that 
readers can form further verbs for themselves on the same pattern. Where consecutive expressions use 
the same word, the phrases may be linked by the word "or", as in "countryman or -woman." Parentheses 
within the text are occasionally used to clarify the context of a word, as in "dissolve (a marriage)" found in 
the article for the Keyword not retain. The symbol ™ following a noun indicates a registered trade mark. 
An "e" in parentheses added to the end of a word means that it is of French origin and requires a final "e" 
if applied to a woman. "See..." is used to refer the reader to another article within the same Head, where 
the idea under consideration is dealt with more thoroughly. This often happens where a general article, 
such as "killing" under the Head Killing: destruction of life, is followed by more specific articles, in this 
case homicide and slaughter.
Spelling and hyphenation is uniform with Longman dictionaries. It should be born in mind, however, that a 
living language takes many shapes, and these are not the only correct or permitted orthographies. For the
benefit of crossword puzzle enthusiasts and others, alternative current spellings are listed in the Table of 
Contents for the Bookshelf Thesaurus.
The Table of Contents for the Bookshelf Thesaurus
Once familiar with the Plan of Classification and the Outline, readers will be able to find their own way 
around the book, and this is certainly the most rewarding method of using the Thesaurus. However, 
another method of navigation is the Table of Contents.
Where several references are given, choose the most appropriate Keyword. For instance, suppose you 
need another expression for "feeling happy." Look up happy in the Table of Contents, and you will find a 
list of Heads and Keywords. The Keywords given include apt and willing which refer to other uses of the 
word "happy." But the Keywords cheerful and happy are obviously relevant, and looking up those words 
will offer you an abundance of suitable terms.
Some points to note
1) Items are listed in alphabetical order, whether they are words or phrases.
2) References to the same Head are not always repeated under different grammatical forms of the same 
word. For example: "abundance" has references to the following Heads: Vegetable life, Diffuseness, 
Greatness, Increase, Production, Productiveness, Store, Sufficiency and Redundance, while ÒabundantÓ
has references to Diffuseness, Greatness, Multitude, Sufficiency, Wealth, and Liberality. This means that 
the adjective is found in three Heads which do not list the noun form: the idea of "abundance," however, is
present in all the Heads listed. It is a good idea to check other forms of the word you are looking up, to 
obtain the fullest list of references to suitable Heads.
3) General expressions such as "good example," "bad health," "no meaning," and "not mind" have been 
retained in the Table of Contents as useful guides for the reader.



Roget's Plan of Classification
Dr. Roget divided words and phrases into six main Classes. He then divided the words within each class 
into Sections.

CLASS SECTION
1. Abstract relations Existence

Relation
Quantity
Order
Number
Time

 Change
 Causation

2. Space Space in general
Dimensions
Form
Motion

3. Matter Matter in general
Inorganic matter

 Organic matter

4. Intellect: the exercise of the mind 
            Division one:
            Formation of ideas General
 Precursory conditions and operations

Materials for reasoning
Reasoning processes
Results of reasoning
Extension of thought

 Creative thought

            Division two:
            Communication of ideas Nature of ideas communicated

Modes of communication
Means of communicating ideas

5. Volition: the exercise of the will
            Division one:
            Individual volition Volition in general

Prospective volition
Voluntary action
Antagonism
Results of action

            Division two:
            Social volition General social volition



Special social volition
Conditional social volition
Possessive relations

6. Emotion, religion, and morality General
Personal emotion
Interpersonal emotion 
Morality
Religion 



Evolution of Cartography
Digital geographic databases are revolutionizing mapmaking in ways that the ancient Greeks never 
dreamed of. As this brief history of cartography reveals, maps can now be created and updated with 
greater accuracy and speed than ever before. 
Maps extend our world, and our sense of place and direction within it. From humankind's earliest cave 
markings, people have drawn lines and sought to define their place within them. Indeed, maps have 
always been utilitarian tools. As far back as 2300 B.C., Babylonian officials used maps to aid in the 
collection of taxes.
The foundation of modern-day cartography was laid by the ancient Greeks, who recognized the spherical 
shape of the earth, developed our system of longitude and latitude, designed the first map projections and
calculated the size of the earth¾with surprising accuracy. Claudius Ptolemy's Geographia, produced in 
the 2nd century A.D., was the first bound collection of maps designed to serve both scholarship and 
administration. 
During the Middle Ages, mapmakers made little attempt to show the world as it was. The typical medieval 
map represented a Christian ideal, usually placing Jerusalem in the center of the world. At the same time, 
however, Arab scholars were improving on Ptolemy's work, making significant advances in map 
presentation and accuracy. 
At the end of the 13th century, the compass came into general use, and with it came a new kind of map, 
called a portolan chart, created by the Genovese fleet for navigational purposes. Based on compass 
surveys, these outline maps depicted the Mediterranean and Black seas with great accuracy. An 
elaborate system of lines indicating compass directions crisscrossed the maps' surfaces. In 1375, the 
Catalan Atlas used portolans to depict most of the world, following the text of Marco Polo. 
Three key events contributed to the renaissance of cartography. First was the rediscovery of Ptolemy's 
Geographia in the West. Carefully preserved by devotees, the text eventually reached the Moorish rulers 
in Spain. 
Second was the invention of printing, which greatly increased the number of available maps, and brought 
them within reach of the average person. In 1478, Ptolemy's Geographia became the first of the classical 
Greek works to be printed. 
Third, and perhaps most important, was the age of the great discoveries, which was itself made possible 
by the development of new three-masted sailing vessels.
The Age of Exploration
European mariners set sail across the Atlantic beginning in the late 15th century. The great sea-going 
explorers of this era¾Columbus, Cabot, Amerigo Vespucci, Magellan and Sir Francis Drake¾all owed 
much to Ptolemy's ancient text, and to the refinements made at the navigational school founded by Prince
Henry the Navigator. Ptolemy and others, however, considerably exaggerated the Eurasian landmass, 
showing it to occupy nearly half the globe. This error led Columbus to underestimate the distance to Asia; 
thus he failed to realize that he had reached the new world.
Gerardus Mercator, an important cartographer of his age, was the first to produce a true world 
navigational chart on a flat surface. It became the favored depiction among map publishers. 
Many new maps followed as great explorers, and later traders, returned to correct and fill in the blank 
spaces of the expanding world. The first modern atlas, Theatrum Orbis Terrarum, was published in 1570. 
The first successful marine chronometer, in use by 1761, offered a reliable means of measuring longitude.
By the late 18th century, mapmakers were already producing a reasonable picture of the world as we 
know it today. With the invention of photography in the 19th century, cartographers could at last record the
landscape with photo-realistic precision and detail.Then, in the early 1900's, airplanes dramatically 
extended the scope of our view. Advances in photography kept pace, permitting crisp images of ever 
expanding areas. Aerial reconnaissance became the standard method for gathering cartographic data. 
Infrared and ultra-violet photography extended the range of perception beyond the visible spectrum, while
radar penetrated visual obstacles such as clouds and fog.
Images from Space
But a quantum leap forward occurred in the 1970's, when remote sensing satellites launched a new age 
of cartography, giving us a vantage point beyond the earth's atmosphere. Satellites provided the first 



exact measurements of the earth's diameter and the distances between continents, and showed the earth
to be flattened at the poles by precisely 26.6 miles (42.8 km.).
Today, satellites are mapping the globe. Landsat digital images of the earth are systematically broadcast 
from space to sophisticated computers, where the images are assembled and enhanced. This marriage of
computers and satellites has given birth to radically new geographic information systems.
Computer-Assisted Maps
Computers were quickly employed in the everyday production of maps. In computer-assisted mapmaking 
systems, computers function as electronic versions of traditional drafting tools. Hand-drawn maps are 
scanned into a computer, where revisions such as name and color changes can be made quickly and 
easily. However, because these systems must use existing maps as their source material, their ability to 
output maps at various scales, projections or with different levels of detail is seriously limited. 
Creating a Digital Database
The Hammond Atlas of the World is the first world atlas created directly from a digital database, and its 
computer-generated maps represent a new phase in mapmaking technology. 
To build the database capable of generating this world atlas, the latitude and longitude of every significant
town, river, coastline, natural and political border, transportation network and peak elevation was 
researched and digitized. 
Engineering the complex data structure was critical to the success of the system, which relies on powerful
computers and enormous data storage capacity. Hundreds of millions of data points describing nearly 
every important geographic feature on earth are organized into over 1,000 different map feature codes. 
Keeping the database current is a never-ending task. Every day, just as mapmakers have done for 
centuries, researchers pore over government publications, maps, international journals and newspapers 
in search of geographic changes. They record renamed cities, new roads, revamped borders, diverted 
rivers, and hundreds of other constantly evolving political and topographic details.
How Computer-Generated Maps Are Made
There are no maps in this unique system. Rather, it consists entirely of coded points, lines and polygons. 
To create a map, cartographers determine what city, region or continent they want to show and select 
specific information to include, based on editorial considerations such as scale, town size, population 
density, and the relative importance of different features. How does a computer plot irregular rivers and 
mountains¾at many different scales? Using fractal geometry to describe natural forms such as coastlines,
mathematical physicist Mitchell Feigenbaum developed software capable of re-configuring coastlines, 
borders and mountain ranges to fit a multitude of map scales and projections. 
Even map labeling has finally given way to new technology. Dr. Feigenbaum also created a new 
computerized type placement program which places thousands of map labels in minutes, a task which 
previously required days of tedious labor. The program insures that the type carefully follows the curve of 
the graticule, or map grid, for maximum legibility and aesthetic appeal. After these steps have been 
completed, the computer then draws the final map. The benefits of such a system go far beyond 
producing more timely and accurate maps. For the first time, geographers possess a uniquely creative 
mapmaking tool. Map projections can be changed at whim. Revisions that once took months can be 
completed in hours. Because the maps are digitally created, they can be utilized in a wide variety of 
electronic media.
The Hammond database is also the beginning of a unique historical record. Every new town, every 
redrawn political boundary and reshaped geographic feature will be permanently stored in the digital 
database, exceeding the predictable life span of printed maps or even archival films.



Map Projections
(Edited for use in Microsoft Bookshelf 1995)

Simply stated, the mapmaker's challenge is to project the earth's curved surface onto a flat plane. To 
achieve this elusive goal, cartographers have developed map projections¾equations which govern this 
conversion of geographic data. 
Since the Age of Exploration, literally hundreds of projections have been created, all attempting to present
a view of the world which maintains true geographic relationships across the whole of the Earth. All have 
failed, for the goal is an impossible one. Yet some projections have achieved a remarkable degree of 
success. 
This article explores some of the most widely used projections. It also introduces a new projection, 
Hammond's Optimal Conformal.
General Principles and Terms
The earth rotates around its axis once a day. Its end points are the North and South poles; the line circling
the earth midway between the poles is the equator. The arc from the equator to either pole is divided into 
90 degrees of latitude. The equator represents 0 degress latitude. Circles of equal latitude, called 
parallels, are traditionally shown at every fifth or tenth degree.
The equator is divided into 360 degrees. Lines circling the globe from pole to pole through the degree 
points on the equator are called meridians, or great circles. All meridians are equal in length, but by 
international agreement the meridian passing through the Greenwich Observatory near London has been 
chosen as the prime meridian or 0 degrees longitude. The distance in degrees from the prime meridian to 
any point east or west is its longitude.    
While meridians are all equal in length, parallels become shorter as they approach the poles. Whereas 
one degree of latitude represents approximately 69 miles (112 km.) anywhere on the globe, a degree of 
longitude varies from 69 miles (112 km.) at the equator to zero at the poles. Each degree of latitude and 
longitude is divided into 60 minutes. One minute of latitude equals one nautical mile (1.15 land miles or 
1.85 km.). 
How to Flatten a Sphere: The Art of Controlling Distortion
There is only one way to represent a sphere with absolute precision: on a globe. All attempts to project 
our planet's surface onto a plane unevenly stretch or tear the sphere as it flattens, inevitably distorting 
shapes, distances, area (sizes appear larger or smaller than actual size), angles or direction. 
Since representing a sphere on a flat plane always creates distortion, only the parallels or the meridians 
(or some other set of lines) can maintain the same length as on a globe of corresponding scale. All other 
lines must be either too long or too short. Accordingly, the scale on a flat map cannot be true everywhere; 
there will always be different scales in different parts of a map. On world maps or very large areas, 
variations in scale may be extreme. The cartographer's concern in creating or selecting a map projection 
is this: how to distort the map in order to maintain the accuracy of a specific kind of geographic 
information. Most maps seek to preserve either true area relationships (equal area projections) or true 
angles and shapes (conformal projections); some attempt to achieve overall balance.    
Projections: Four Examples
Mercator Projection: This projection is especially useful because all compass directions appear as 
straight lines, making it a valuable navigational tool. Moreover, every small region conforms to its shape 
on a globe¾hence the name conformal. But because its meridians are evenly-spaced vertical lines which 
never converge (unlike the globe), the horizontal parallels must be drawn farther and farther apart at 
higher latitudes to maintain a correct relationship. Only the equator is true to scale, and the size of areas 
in the higher latitudes is dramatically distorted.
Lambert Azimuthal Equal-Area Projection: This projection is commonly used to plot maps of the 
continents because it shows correct areas with relatively little distortion of shapes. 
Robinson Projection: This projection combines elements of both conformal and equal area projections 
to show the whole earth with relatively true shapes and reasonably equal areas.    
Conic Projection: This projection has been used frequently for air navigation charts and to create most 
of the national and regional maps in this atlas. The original idea of a conic projection is to cap the globe 
with a cone, and then project onto the cone from the planet's center the lines of latitude and longitude (the



parallels and meridians). To produce a working map, the cone is simply cut open and laid flat.
Hammond's Optimal Conformal
As its name implies, this new conformal projection presents the optimal view of an area by reducing shifts 
in scale over an entire region to the minimum degree possible. While conformal maps generally preserve 
all small shapes, large shapes can become very distorted because of varying scales, causing 
considerable inaccuracy in distance measurements. The concept underlying the Optimal Conformal is 
that for any region on the globe, there is an ideal projection for which scale variation can be made as 
small as possible. Consequently, unlike other projections, the Optimal Conformal does not use one 
standard formula to construct a map. Each map is a unique projection¾the optimal projection for that 
particular area. 
In practice, the cartographer first defines the map subject, then, working on a computer, draws a band 
around the region to be mapped. Next, a sophisticated software program evaluates the size and shape of 
the region to determine the most accurate way to project it. The result is the most distortion-free 
conformal map possible, and the most accurate projections that have ever been made. All of the 
continents maps in this atlas (with the exception of Antarctica) have been drawn using this projection.



Abbreviations Used in the Encyclopedia
The following abbreviations are used in some articles in the Bookshelf Encyclopedia.

Abbreviation Meaning
Å angstrom
abbr. abbreviation(s), abbreviated
A.D. anno Domini [in the year of the Lord]
Adm. Admiral
Afrik. Afrikaans
alt. altitude
Alta. Alberta
Arab. Arabic
AU astronomical unit(s)
AV Authorized Version (King James Version)
b. born, born in
B.C. Before Christ
B.C. British Columbia
Brig. Gen. Brigadier General
BuIg. Bulgarian
C Celsius (centigrade)
c. circa [about]
cal calorie(s)
cant. Canticles (Song of Solomon)
Capt. Captain
cc cubic centimeter(s)
Cent. century, centuries
Chin. Chinese
Chron. Chronicles
cm centimeter(s)
cm/sec2 centimeter(s) per second per second
Co. Company, County
Col. Colonel, Colossians
Coll. Collection
Comdr. Commander
Cor. Corinthians
Cpl. Corporal
cu cubic
d. died, died in
Dan. Daniel; Danish
Deut. Deuteronomy
dist. district
Du. Dutch
E east, eastern
Eccles. Ecclesiastes
Ecclus. Ecclesiasticus
e.g. exempli gratia [for example]
Eng. English
Eph. Ephesians



est. established; estimated
eV electron volts
Ex. Exodus
Ezek. Ezekiel
F Fahrenheit; farad
Finn. Finnish
fl. floruit [flourished]
Fr. French
ft foot, feet
ft/sec2 feet per second per second
G gram
Gal. Galatians
gal. gallon(s)
Gall. Gallery
Gen. General, Genesis
Ger. German
Gov. Governor
Gr. Greek
h hour(s)
Hab. Habakkuk
Hag. Haggai
Heb. Hebrew; Hebrews (New Testament)
H.M.S. His (Her) Majesty's Ship; His (Her) Majesty's Service
Hon. the Honorable
hr hour(s)
Hung. Hungarian
Hz hertz or cycle(s) per second
Icel. Icelandic
i.e. id est [that is]
in. inch(es)
inc. incorporated
Isa. Isaiah
Ital. Italian
j joule(s)
Jap. Japanese
Jer. Jeremiah
K Kelvin
kg kilogram(s)
km kilometer(s)
kw kilowatt(s)
Lam. Lamentations
Lat. Latin
lat. latitude
Lev. Leviticus
Lib. Library
lim limit
Lith. Lithuanian
long. longitude
Lt. Lieutenant



m meter(s)
m minute(s)
m/sec2 meters per second per second
Mac. Maccabees
Mal. Malachi
Man. Manitoba
Mat. Matthew
MeV million electron volts
Mex. Mexican
mg milligram(s)
mi mile(s)
min minute(s)
mm milimeter(s)
Mod. Modern
mph miles per hour
Msgr Monsignor
Mus. Museum
Mw megawatt(s)
N north; northern
N.B. New Brunswick
Neh. Nehemiah
N.F. Newfoundland
Nor. Norwegian
N.S. New Style; Nova Scotia
Num. Numbers
N.Y.C. New York City
Obad. Obadiah
O.E. Old English
O.N. Old Norse
Ont. Ontario
O.S. Old Style
oz ounce(s)
P.E.I. Prince Edward Island
Pers. Persian
Philip. Philippians
pI. plural
Pol. Polish
pop. population
Port. Portuguese
Pres. President
Prime Min. Prime Minister
Prov. Proverbs
prov(s). province(s)
pseud. pseudonym
Pss. Psalms
pt pint(s)
pt. part(s)
pub. published
qt quart(s)



Que. Quebec
R river
r. reigned
Rep. Representative
Rev. Revelation; the Reverend
Rom. Romans
rpm revolution(s) per minute
RSV Revised Standard Version
Rum. Rumanian
Rus. Russian
RV Revised Version
S south, southern
s second(s)
Sam. Samuel
Sask. Saskatchewan
Secy. Secretary
Sen. Senator
Sgt. Sergeant
Skt. Sanskrit
Song. Song of Solomon
Span. Spanish
sq square
S.S. Steamship
SSR Soviet Socialist Republic
Swed. Swedish
Thess. Thessalonians
Tim. Timothy
tr. translation
Turk. Turkish
Ukr. Ukrainian
UN United Nations
uninc. unincorporated
U.S. United States
U.S.S. United States Ship
USSR Union of Soviet Socialist Republics
v. versus
V volt(s)
var. variety (in botany)
Vice Pres. Vice President
vol. volume(s)
W west; western; watt(s)
wt. weight
yd yard(s)
Zech. Zechariah
Zeph. Zephaniah





Glossary of Bookshelf Terms
Bookshelf terms are listed below in alphabetical order. To pop up a description of the term, click the term 
or press TAB to highlight the term, then press ENTER. Use the scroll bar or press the PAGE DOWN key to 
view terms not visible on your screen. To return to the Help topic you were previously reading, click Back 
on the button bar above or press CRTL+ B on your keyboard.

A
active
Address Builder
Advanced Find
Animation & Video button
Arrow button
arrow keys
article
article title
Article window
Audio icon
Audio button

B
Back button
Back list
Back List Tab
Book bar
Book icon
box

C
check box
choose
click
Clipboard
command button
Contents list
Contents Tab
Control menu
Control-menu box
copyright
cross-reference

D
default
desktop
dialog box
dimmed
double-click
drag
drop-down list box



F
Find list
Find Tab
full-text search

G
Gallery list
Gallery Tab

H
Help menu
Help button
highlight
hot

I
icon
Information box
interface sounds

J
jump
jump text

L
list box

M
Main window
maximize
Maximize button
media button
media controller
Menu bar
minimize
Minimize button
mouse pointer
Multimedia group window

N
NEAR
Next button
Note command
Note icon

O
option buttons
Outline button

P
<Page button



>Page button
Play/Pause button
pointer
pop up
pop-up text
pop-up window
Previous button
Program Manager

Q
QuickShelf

R
Restore button
right-click

S
scroll arrow
scroll bar
scroll box
search operator
Section-menu button
See Also button
select
shortcut menu
slider
Spelling button
Stop button
stop-word list

T
Tabbed Lists
text box
title bar
Tools menu
ToolTips
track bar

W
window

Y
Year in Review Tab

Z
Zoom In button
Zoom Out button



active
Refers to a screen device or feature that is open or available. For example, when you are using the 
Contents Tab to locate articles, it is the active tab. Click any other Tab and it becomes the active Tab.



Address Builder
Located on the Tools menu and on the QuickShelf toolbar, Address Builder can help you locate address 
information and build addresses for most U.S. locations.



Advanced Find
Located on the Tools menu, Advanced Find performs a precisely focused full-text search according to 
criteria you select. Unlike the Find Tab search feature, Advanced Find can search any number or 
combination of books, as well as narrow the search to a single article or to articles that contain specific 
media.



Animation & Video button
Located on the Gallery Tab, you choose this button to display a list of all the Bookshelf articles in the open
book that contain animations or videos.



Arrow button
The small button with an arrow located in front of some article titles in the Tabbed Lists. This button 
indicates that the title has two or more related articles. When you choose a title preceded by this button, a
list of related articles opens. When the list is closed, the arrow points up. When you open the list, the 
arrow points down.



arrow keys
Keys you can use to control the movement of the insertion point on the screen. Some keyboards have 
two sets of arrow keys: one on the numeric keypad and another set to the left of that area. If you use the 
arrow keys on the numeric keypad, be sure to turn off NUMLOCK.



article
A single entry in a book. An article might be a quotation, the definition of a word, a map in the Atlas, a 
topic in the Encyclopedia, or an entry in the Chronology, Thesaurus, or Almanac. You display and read 
articles in the Article window.



article title
An item in a Tabbed List. You choose an article title in order to display the article in the Article window. 
Each book's article titles are listed alphabetically.



Article window
The part of the Bookshelf Main window where you display and read an article from a book. The article 
window is always open to the right of the Tabbed Lists area. When you choose an article title in a Tabbed 
List, the article displays in the Article window. For articles that are too long to fit on one screen, a scroll 
bar will border the right side of the window. You can expand the Article window by resizing the Tabbed 
Lists or by closing them entirely. When you close the Tabbed Lists, the five tabs remain visible. The 
bottom of the Article window has a bar containing buttons for copying, printing, displaying a previously 
viewed article, and paging backward and forward in a set browse order through articles. Several books 
have an additional button (See Also, Outline, Zoom Out/In) that displays information related to open 
article.



Audio button
Located on the Gallery Tab, you choose this button to see a list of all the Bookshelf articles in the open 
book that contain audio clips.



Audio icon 
Located in many Bookshelf articles, you choose this icon to hear a pronunciation or a musical example. 
(To stop a musical example, for instance an anthem in the Atlas, click the Audio icon or press ENTER.) An 
Audio icon in the lower-left corner of an animation image indicates that the animation is accompanied by 
narration.



Back button
Located at the bottom of the Article window, you choose this button to display the last article you opened.



Back list 
Located on the Back List Tab, this list shows all the articles you've displayed (up to 40) since you started 
the current session of Bookshelf. The title of the most recently displayed article is listed first. If the list is 
long, use the scroll bar to move up and down the list, or use the Previous and Next buttons at the bottom 
of the list to move up and down one article at a time. Choose any article title on the list to display the 
article again.



Back List Tab
One of five tabs in the Tabbed List area. The Back List Tab contains a list of all the Bookshelf articles 
you've displayed (up to 40) since you started the current session of Bookshelf, with the most recently 
viewed article listed first.
Open the Back list by either clicking the Back List Tab, pressing CTRL+ L, or choosing Back List on the 
Tools menu.



Book bar
Located near the top of the Bookshelf Main window, the Book bar is a convenient "shelf" of eight Book 
icons. The first icon, the All Books icon, opens all seven books at once. The remaining seven icons each 
open one specific book. When you position the mouse pointer on an icon without clicking, a ToolTips label
displays that tells you which book it is. To open a specific book, or all seven books at once, click the 
appropriate icon. When a book is open, the Book icon looks like an open book. You can always tell which 
book(s) you have open by glancing at the Book bar. Each time you start Bookshelf, All Books will 
automatically be open.



Book icon
A miniature representation of a Bookshelf book. Book icons are located on the Book bar near the top of 
the Bookshelf Main window; in front of article titles in the Tabbed Lists; and on the QuickShelf toolbar 
buttons. When you position the mouse pointer on an icon without clicking, a ToolTips label displays that 
identifies the book.



check box 
A check box is used to turn an option or feature on and off. You use check boxes to customize an 
application to suit your needs. When a check box contains an X, the option or feature is on, or active. 
When a check box is blank, the option or feature is off, or inactive. Click the box to either add or remove 
the X, or press TAB until the check box is selected, then press the SPACEBAR to add or remove the X.



choose
Point and click with the mouse or press the appropriate keys on the keyboard to carry out a command.



click
To press once and release the left mouse button.



Clipboard
The Microsoft Windows application that holds text, graphics, or multimedia elements that you cut or copy. 
Whenever you use a Cut, Copy, or Paste command, you are using the Clipboard.



command button
A button that carries out or cancels an action in a window or box. Commonly seen command buttons are 
OK, Cancel, and Help. The OK button carries out the task and closes the dialog box. The Cancel button 
cancels the task associated with the box. The Help button displays a Help topic that provides instructions 
on the specific dialog box and task at hand. Other command buttons offer additional options.



Contents list
Located on the Contents Tab, this list is an alphabetical Table of Contents for the open book. When All 
Books is open, the Contents list is a comprehensive Table of Contents for all seven books in Bookshelf. 
You move up and down the list by using either the scroll bar or the Previous and Next buttons located at 
the bottom of the list box. You can also use the text box above the list to type a word or phrase. Your word
will scroll to the top of the Contents list box as you type. 



Contents Tab
One of five tabs in the Tabbed List area. The Contents Tab contains a complete list of all articles (Table of 
Contents) in the open book(s). The article titles display in the Contents list box.
Open Contents by either clicking the Contents Tab, pressing CTRL+ T, or choosing Table of Contents from 
the Tools menu.



Control menu    
Located in the upper-left corner on the title bar of a window or box, the Control menu is represented by a 
SPACEBAR icon. This menu contains commands for resizing, moving, and closing the open window or box. 
It also has the Switch To command, which displays a dialog box listing all applications that are currently 
running.



Control-menu box    
The icon located in the upper-left corner of a window or box. You can double-click the Control-menu box 
to close the window, or click it once to display the various commands offered on the Control menu.



Copyright
The copyright dates and names of the legal owners of Bookshelf and the sources that contributed to 
Bookshelf's content.
To display copyright information for any book
1. Open the book by clicking its icon on the Book bar, or choose the book from the Books menu.
2. Click the >Page button at the bottom-right corner of the Main window, or choose Copyright Information 

from the Help menu.



cross-reference
Found within articles, cross-references are words in colored text that indicate a related article. To display 
the related article, click the colored word, or press TAB to highlight the word, then press ENTER.



default
The predefined setting of a feature or option in an application. In many cases, you can change a default 
setting to suit your needs.



desktop
The background of your screen when Microsoft Windows is running. Windows, icons, and boxes appear 
on the desktop.



dialog box (frequently shortened to "box")
A box or window that opens when you choose a command, offering various options. On menus, 
commands with ellipses (...) display dialog boxes (for example, the Options command on the Tools 
menu). Some dialog boxes have a Help button you can choose to display instructions specific to using the
dialog box.



dimmed
Buttons and commands are dimmed, or grayed-out, when a feature or function is not available.



double-click
Point to a word or object with the mouse pointer then click twice in rapid succession, usually with the left 
mouse button.



drag
To hold down the left mouse button while you move the mouse to affect something on the screen. For 
example, dragging is used to resize and move windows and boxes, and to select text.



drop-down list box
A list box that opens and closes in a dialog box. A down-arrow button at the end of a text box indicates the
presence of a drop-down list. Click the button to open the list.



Find list
Located on the Find Tab, this list is all the articles in the open book(s) that contain the word, number, or 
phrase for which you searched. If the list is long, use the scroll bar to move up and down the list, or use 
the Previous and Next buttons at the bottom of the list box to move up and down one article at a time.



Find Tab
One of five tabs in the Tabbed List area. The Find Tab activates a search feature. Find will perform a full-
text search through all articles in the open book(s). Type the word, phrase, or number you wish to search 
for in the Find text box, then click the Find! button or press ENTER to start the search. The titles of all 
articles that contain the search text display in the Find list box.
Open Find by either clicking the Find Tab, pressing CTRL+ F, or choosing Find on the Tools menu.



full-text search
A search for a word, phrase, or number through the entire text of every article in the open book(s). When 
you search using the Find Tab or the Advanced Find command on the Tools menu, you perform a full-text 
search. All articles that contain the word, phrase, or number for which you searched will appear in the 
Find Tab's list box.



Gallery list
Located on the Gallery Tab, this list is all articles in the open book(s) that contain the media elements you 
specify by choosing one of the four media buttons: All Media, Audio, Animation & Video, or Picture. If the 
list is long, use the scroll bar to move up and down the list, or use the Previous and Next buttons at the 
bottom of the list box to move up and down one article at a time.



Gallery Tab
One of five tabs in the Tabbed List area. The Gallery Tab sorts the articles in the open book(s) according 
to the media elements they contain. When you choose one of the four media buttons, Gallery displays a 
list of all articles that qualify. The All Media button provides a list of all articles that contain any kind of 
media. The Audio, Animation & Video, and Picture buttons list only those articles that contain that specific 
media. The titles of the qualifying articles display in the Gallery list box.
Open the Gallery by either clicking the Gallery Tab, pressing CTRL+ G, or choosing Gallery on the Tools 
menu.



Help menu
Located on the Menu bar, the Help menu has commands for such things as opening Bookshelf Help, 
displaying copyright information, and opening instructions for using Help.



Help button
Located in many dialog boxes, the Help button displays a Help topic that provides instructions on the 
specific dialog box and task at hand.



highlight (or select)
To use the mouse or keyboard to indicate text or graphics on which you want a command to act. For 
example, in order to copy text or a picture to the Clipboard, you must first highlight it. Text that is 
highlighted appears inside a colored block. Pictures that are highlighted appear "inverted," and some 
highlighted pictures also appear inside a dark block.



hot
The term "hot" is used to describe text or graphics that allow you to jump to new articles; pop up 
definitions or information boxes; play audio clips; activate animations and videos; and enlarge pictures. 
Hot text is one of two colors--words that pop up information are a different color than words that jump to a 
new article. You can use either the mouse or the keyboard to activate hot text and graphics. Simply click 
the mouse when the mouse pointer changes into a hand, or use the TAB key to select the hot word or 
graphic, then press ENTER.



icon
Icons are miniature pictures that represent an application, function, or feature. Bookshelf has a number of 
different icons, including the books on the Book bar and the books next to article titles; the speaker icon 
you click to hear audio clips; and the books on the QuickShelf toolbar buttons.



Information box
Located on each of Bookshelf's five tabs, this box is located above the list of article titles. The look and 
purpose of this box is different on each tab.



interface sounds
Sound effects you hear when you perform certain tasks, such as opening and changing books, opening 
Tabs, paging forward or backward through articles, and right-clicking to display shortcut menus. Interface 
sounds can be turned off in the Options dialog box that displays when you choose Options from the Tools 
menu.



jump
To quickly open a new but related article. When you jump to a new article, the original article closes. In 
Bookshelf articles, jump text is a particular color (jump text and pop-up text are different colors). To 
choose jump text (also referred to as "hot" text) either point to it with the mouse and click, or highlight it 
using the TAB key, then press ENTER.



jump text
Colored text that you can choose to display a new but related article. When you jump to a new article, the 
original article closes. Jump text (also referred to as "hot" text) is distinguished from pop-up text by its 
color. To choose jump text, either point to it with the mouse and click, or highlight it using the TAB key, then
press ENTER. To change the color of jump text, choose Options from the Tools menu.



list box
A box that displays a list of items from which you can choose. If the list is long, a scroll bar borders the 
right edge of the box so you can move up and down in the list. For example, the list box on the Contents 
Tab is where the titles of all the articles in the open book(s) are found. You choose an article title from the 
list in order to display it in the Article window.



Main window

The Main window of Bookshelf is where you open books; locate and read articles; copy and print 
information from articles; and get Help on using Bookshelf. The features of the Main window include, from
top to bottom, the Menu bar, the Book bar, the Tabbed Lists, and the Article window with a Button bar 
along the bottom. The QuickShelf toolbar displays on the left side of the title bar unless you move it to 
another location in the window. These features are consistent and easy to use no matter which book you 
have open.



maximize
To enlarge a window to its maximum size by clicking the Maximize button in the upper-right corner of the 
window, or by choosing Maximize from the Control menu.



Maximize button
Located in the upper-right corner of a window, this button enlarges a window to take up the full screen. It 
is unlabeled and has an arrow that points up.



media button
A general term for any of the four buttons located on the Gallery Tab: All Media, Animation & Video, Audio,
and Picture. Choose a media button to see a list of all the articles in the open book(s) that contain that 
media type.



media controller
The screen device used to start, pause, and stop the action of media elements in Bookshelf, including 
audio clips, animations, and videos. The media controller has a track bar with a slider, a Play/Pause 
button and a Stop button. Some media controllers have a Section-menu button that displays the sections 
the media is divided into.

Play/Pause                                Stop    



Menu bar
The part of the Main window, located between the title bar and the Book bar, that contains commands that
help you use Bookshelf.
These commands perform a variety of functions such as opening a book; printing an article; copying an 
article, a picture, or a sound; setting options; keeping notes about articles; performing a focused full-text 
search; switching to a different book; or opening Help.



minimize
To reduce a window to an icon by clicking the Minimize button in the upper-right corner of the window, or 
by choosing the Minimize command from the Control menu.



Minimize button
Located in the upper-right corner of a window, this button reduces a window to an icon. It is unlabeled and
has an arrow that points down.



Multimedia group window
The window in Program Manager that contains the Bookshelf icon.



NEAR
NEAR is a word you use to make a full-text search more precise. (This is what is known as a search 
operator.) When you use the Find Tab or Advanced Find feature to perform a full-text search for a word or
phrase, and you use the word NEAR (for example, read NEAR books), Bookshelf searches each article 
for all occurrences of the word "read" located within 8 words of the word "books." In other words, "read" 
and "books" can be separated in the text by 8 or fewer words. The search range is automatically set to 8 
but you can increase or decrease this number in the Options dialog box.



Next button
Located at the bottom of the Tabbed List area, you click this button to open the next article in the list (the 
article below the currently highlighted article).



Note command
Located on the Edit menu, the Note command opens the Note dialog box where you can keep a list of 
articles of special interest and make annotations to articles as needed. Any article listed in the Note box 
can be opened directly from Note.



Note icon
Located in the upper-right corner of articles that are added to the Note dialog box. Click the Note icon to 
open the Note dialog box where you can add or delete annotations about the article.



option buttons 
Located in some dialog boxes, such as Advanced Find, options buttons are selected one at a time. The 
selected option is indicated by a black dot.



Outline button
Located at the bottom of the Article window in the Thesaurus, Quotations book, and Almanac, this button 
displays information related specifically to the open article.



<Page button
Located at the bottom of the Article window, this button displays the previous topic in the open book 
according to its browse order. Each book has its own organization for browsing.



>Page button
Locate at the bottom of the Article window, this button displays the next topic in the open book according 
to its browse order. Each book has its own organization for browsing.



Play/Pause button    
Located on the media controller used to play animations, videos, and some audio clips, you click this 
button to start or pause the action.



pointer or mouse pointer
The arrow-shaped cursor on your screen that you control with a mouse. Use the arrow to point to words, 
menus, buttons, icons, and boxes you wish to choose or activate. The pointer turns into a hand when it 
touches "hot" text or graphics.



pop-up text
Colored text that you can choose to display more information in a pop-up box or window. Pop-up text 
(also referred to as "hot" text) is distinguished from jump text by its color. To choose pop-up text, either 
point to it with the mouse and click, or highlight it using the TAB key, then press ENTER To change the color 
of pop-up text, choose Options from the Tools menu.



pop-up box or window; pop up (the verb)
The box or window that appears, or pops up, when you choose hot text of a certain color or, in some 
cases, hot graphics. The pop-up box or window provides more information about the word or graphic. To 
close this or any pop-up box or window, click once or press any key.



Previous button
Located at the bottom of the Tabbed List area, you click this button to open the previous article in the list 
(the article above the currently highlighted article).



Program Manager
Your home base for using Windows and starting applications. When you start Windows, the Program 
Manager window is open on the desktop.



QuickShelf
The handy way to access Bookshelf from any program in Windows. Once Bookshelf is set up on your 
computer, QuickShelf automatically opens whenever you start Windows. The QuickShelf floating toolbar 
is always visible, unless you minimize it or exit QuickShelf entirely. The toolbar normally appears in the 
upper-left corner of your screen, unless you drag it to another location in the window. When you're 
working in other applications, you can select a word or phrase, click a book button on the QuickShelf 
toolbar, and Bookshelf goes to that book and looks up your word or phrase for you. You can also access 
Address Builder from QuickShelf. You can customize the QuickShelf toolbar to include book buttons for 
one, several, or all the books in Bookshelf.



Restore button
Replaces the Maximize button in the upper-right corner of a window that has been maximized to take up 
the full screen. It is an unlabeled button and has two arrows, one pointing up and the other pointing down.
Click this button to restore the window to its previous size.



right-click
Press once and release the right mouse button. When you right-click, a shortcut menu opens. The 
shortcut menu allows you to look up a word's definition from the Bookshelf Dictionary, copy a selected 
item to the Clipboard, copy a selection into a Word document, or perform a full-text search for a word or 
phrase in any or all of the Bookshelf books.



scroll arrow
An arrow on either end of a scroll bar. Clicking a scroll arrow brings another line into view. Pointing to a 
scroll arrow and holding down the left mouse button scrolls through the contents of a window or list box 
continuously.



scroll bar
A bar that appears at the right edge of a list box or at the right or bottom edge of a window whose 
contents aren't completely visible on the screen. Scroll bars are used for moving vertically and 
horizontally in a list box or window. Scroll bars have a scroll arrow at each end. They also have a marker, 
called a scroll box, that can be positioned any place along the bar by dragging it with the mouse.
To scroll Do this
Up or down one line Click one of the scroll arrows.
One window Click the scroll bar above or below the scroll box on vertical scroll bars, or to the 

left or right of the scroll box on horizontal scroll bars.
Continuously Point to one of the scroll arrows and hold down the mouse button until the 

information you want comes into view.
To any position Drag the scroll box to a position in the scroll bar that corresponds to the general 

location you want to be in the topic or list (beginning, middle, or end). For 
example, if you position the scroll box halfway down the vertical scroll bar, the 
text halfway through the topic or list appears.



scroll box
The square marker that moves up and down the scroll bar. The position of the scroll box indicates the 
general location of the information on the screen in relation to the rest of the topic or list. You can drag the
scroll box up or down to quickly scroll through a long topic or list.



search operator

A word or character you use when you enter search text in order to narrow the scope of a full-text search. 
The following search operators can be used with both the Find Tab and Advanced Find features: AND, 
OR, NOT, and NEAR. You can enter an operator in either lowercase or uppercase letters (for example, 
"and" is the same as "AND"). If you use multiple search operators they are evaluated, by default, from left 
to right. You can use parentheses ( ) to specify a different order--operators within parentheses are 
evaluated first.



Section-menu button
Located at the left end of the media controller for some narrated animations, this button displays a 
Section menu. Point to the button and hold down the left mouse button to display the Section menu. 
Choose a menu item in order to jump the animation to that section and continue playing.



See Also button
Located at the bottom of the Encyclopedia Article window, this button displays a list of Encyclopedia 
articles that contain information related to that in the open article. Choose any article title on the list to 
display that article in the Article window. If a list of related articles is not available, the See Also button will 
be dimmed.



select (or highlight)
To use the mouse or keyboard to indicate text or graphics on which you want a command to act. For 
example, in order to copy text or a picture to the Clipboard, you must first select it. Text that is selected 
appears inside a colored block. Pictures that are selected appear "inverted," and some selected pictures 
also appear inside a dark block.



shortcut menu
A shortcut menu opens when you right-click any word, selected phrase, or image in any Bookshelf article. 
Choose the appropriate command from the menu to display a definition from the Bookshelf Dictionary, 
copy a selection to the Clipboard or to a Word document, or perform a full-text search through all articles 
in one or all of the Bookshelf books. Right-clicking on the QuickShelf toolbar also opens a shortcut menu 
with commands for customizing the look of the toolbar and for getting Help on using QuickShelf.



slider
A part of the media controller used to play animations, videos, and some audio clips, the slider is the 
device that moves along the track bar while the media plays. The slider helps you keep track of the 
progress of the media as it plays. You can drag the slider to any point on the track bar to play the media 
from that point.



Spelling button
Located on the Contents and Find Tabs, the Spelling button is to the left of the text box. If you're not sure 
how to spell the word you wish to search for, type it in the text box the best you can, then click the 
Spelling button. The Bookshelf spelling feature analyzes your word and opens a box with suggested 
words from which you can choose.



Stop button    
Located on the media controller used to play animations, videos, and some audio clips, you click this 
button to stop the action and "rewind" the media to the beginning.



stop-word list
The list of words that Bookshelf will not search for. These words appear so often within the books that 
searching for them would result in a useless list of topics. The words in the stop-word list are:

1, 2, 3, a, an, and, as, at, be, but, by, do, for, from, have, he, in, is, it, not, of, on, or, she, that, 
the, there, they, this, to, we, which, with, you



Tabbed Lists
The Tabbed Lists occupy the area to the left of the Article window and include the Contents, Find, Gallery,
Back List, and Year In Review Tabs. The Tabbed Lists are the primary tool you use to locate articles in an 
open book. You can increase or decrease the width of the Tabbed Lists or you can close them altogether. 
The size of the Article window changes accordingly. When you close the Tabbed Lists, the five Tabs 
remain visible. Click any Tab to reopen the Tabbed Lists.



text box
A box in which you can type or edit text.



title bar
The horizontal bar at the top of a window or box that contains the name of the window or box. In 
Bookshelf, the title bar is at the very top of the Main window and contains the Bookshelf title and the 
name of the open book. The title bar has a Control-menu box at the far left and Maximize and Minimize 
buttons at the far right.



Tools menu
Located on the Menu bar, the Tools menu has commands for opening Tabs, using the Advance Find 
feature and Address Builder, displaying Bookshelf Daily, and changing Bookshelf options. Several books 
have commands on the Tools menu that are specific to the book.



ToolTips
Small identifying labels that display when you pause the mouse pointer on most icons and unlabeled 
buttons. When you move the mouse pointer off the icon or button, the label disappears. The ToolTips 
feature can be turned on and off in the Bookshelf Options dialog box that displays when you choose 
Options from the Tools menu.



track bar
A part of the media controller used to play animations, videos, and some audio clips, the track bar is what 
the slider moves along as the media plays. Some track bars have tick marks that correspond with 
sections of the media.



window
The rectangular area on your screen in which you view an application or a file. You can have several 
windows open at one time and arrange them to suit your needs. You can move them and resize them, 
and you can view more than one window at a time.



Year in Review Tab
One of five Tabs in the Tabbed List area. The Year in Review Tab contains a categorized list of articles 
about noteworthy events, facts, people and places of 1994. In addition, the Year in Review Tab displays a 
video that recaps selected highlights of 1994.
Open the Year in Review list and video by clicking the Year in Review Tab, pressing CTRL+ R, or choosing 
Year in Review on the Tools menu.



Zoom In button
Located at the bottom of the Article window when the Atlas first opens to its Contents screen. Click this 
button to display the World map.



Zoom Out button
Located at the bottom of the Article window when an Atlas article is open. Click this button to display an 
"expanded-view" map of the area currently displayed in the Article window. For example, if the map of the 
New England states is open in the Article window, clicking Zoom Out will display the map of the entire 
United States. If there is no expanded-view map available for the open map, the Zoom Out button will be 
dimmed.





Keyboard Shortcuts
You can perform most tasks in Bookshelf using either the mouse or the keyboard.
The following topics list Bookshelf keyboard shortcuts:

Choosing Hot Text and Graphics with Keys
Choosing Menus, Commands, Buttons, and Tabs with Keys
Selecting Windows with Keys
Resizing, Moving, and Closing Windows with Keys
Scrolling and Moving the Insertion Point with Keys
Choosing Dialog Box Options with Keys
Selecting and Editing in Text Boxes with Keys
Copying and Pasting with Keys
Using the Shortcut Menu with Keys

WARNING    If you assign a QuickShelf Key the same key combination as one of the keyboard shortcuts, 
such as CTRL+ C (for copying) or CTRL+ P (for printing), the QuickShelf Key will override the keyboard 
shortcut.



Choosing Hot Text and Graphics with Keys
G  LOSSARY  

When you choose hot text, you either jump to a new window of related information or pop up a box of 
related information without leaving the current window. Choosing hot graphics pops up an information box
or activates media.

Press To
TAB Select hot text or graphics. Tab again to select the 

next hot item.

SHIFT+ TAB Select hot text or graphics, moving in reverse order.

ENTER Activate the selected hot text or graphics.

ENTER or ESC Close a pop up box or window.

Choosing Menus, Commands, Buttons, and Tabs with Keys
G  LOSSARY  

The following lists the keyboard shortcuts for the various menus, commands, buttons, and tabs in 
Bookshelf.
WARNING    If you assign a QuickShelf Key the same key combination as one of the keyboard shortcuts, 
such as CTRL+ C (for copying) or CTRL+ P (for printing), the QuickShelf Key will override the keyboard 
shortcut.
For menus, commands, and buttons

Press To
ALT + letter key Choose the menu whose underlined letter 

matches the one you type. 

letter key Choose the menu command whose underlined 
letter matches the one you type (when a menu 
is open). 

F1 Open Help. 

LEFT or RIGHT ARROW Move among menus (when a menu is open). 

UP or DOWN ARROW Move among commands (when a menu is 
open). 

ENTER Choose the selected menu command. 

ESC Cancel the selected menu. 

Press To
CTRL+ X Choose the Cut command.

CTRL+ V Choose the Paste command.

CTRL+ C Choose the Copy button or Copy command.

CTRL+ P Choose the Print button or Print command.

CTRL+ B Choose the Back button.

CTRL+ SHIFT+ < Choose the <Page button.



CTRL+ SHIFT+ > Choose the >Page button.

CTRL+ N Choose the Note command.

CTRL+ W Copy to Word command.

CTRL+ A Select all (if the focus is in the Article window).

ALT+ N Choose the Next button.

ALT+ P Choose the Previous button.

ALT+ A Choose the article list (in the Tabbed Lists 
area).

For Tabs in the Tabbed Lists area
Press To open
CTRL+ T Contents Tab.

CTRL+ F Find Tab.

CTRL+ G Gallery Tab.

CTRL+ L Back List Tab.

CTRL+ R Year in Review Tab. 



Selecting Windows with Keys
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When you have more than one application running, for example Bookshelf, QuickShelf, and Word, you 
can switch from one application's window to another with keys. The selected window becomes the active 
window. It appears on top of all other windows and its title bar is highlighted.

Press To
ALT + ESC Switch to the next application window or, in the 

case of minimized applications, the application 
icon (once you see the icon, press ENTER to 
restore the application window).

ALT + TAB Switch to the next application window, restoring 
applications that are running as icons.

CTRL + ESC Display the Task List dialog box.

Resizing, Moving, and Closing Windows with Keys
G  LOSSARY  

Use the commands on the Control menu to resize, move, or close a window with the keyboard.
To resize, move, or close a window with the keyboard
1. Select the window you want to resize, move, or close.
2. Press ALT + SPACEBAR to open the Control menu.
3. Do the following:

Press To
R    (Restore) Restore a maximized window to its previous 

size, or restore a window that has been 
minimized into an icon.

M    (Move) Move the window to a different location on the 
screen. Use the arrow keys to move the 
window to the desired location, then press 
ENTER.

S    (Size) Customize the size of the window. Use the 
arrow keys to move the window borders to the 
desired size, then press ENTER.

N    (Minimize) Shrink the window to an icon.

X    (Maximize) Enlarge the window so that it takes up the full 
screen.

C    (Close) or ALT + F4 Close the window.

 You must restore a maximized window to its previous size before you can move it or customize its size.

See also
Selecting Windows with Keys



Scrolling and Moving the Insertion Point with Keys
G  LOSSARY  

For scrolling and moving the insertion point in articles or lists
Press To
UP ARROW or DOWN ARROW key Move the insertion point up or down 

one line in an article.

UP ARROW or DOWN ARROW key Scroll up or down articles in a 
Tabbed List one article at a time.

RIGHT ARROW or LEFT ARROW key Move the insertion point right or left 
in an article. 

PAGE UP or PAGE DOWN Scroll up or down one full window. 

CTRL+ PAGE UP or CTRL+ PAGE DOWN Scroll left or right one window. 
HOME Move the insertion point to the 

beginning of a line.
END Move the insertion point to the end of

a line.

Choosing Dialog Box Options with Keys
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For moving around in dialog boxes and windows

Press To
TAB Move from option to option.

SHIFT+ TAB Move from option to option in reverse 
order.

ALT + underlined letter of label Move to an option or group.

For entering text in text boxes
Press To
Arrow keys Move the insertion point left, right, up, or

down.

SHIFT + Arrow key Select text.

BACKSPACE Delete the character to the left of the 
insertion point, or delete selected text.

DELETE Delete the character to the right of the 
insertion point, or delete selected text.

CTRL+ X Cut text from a text box. 

CTRL+ V Paste text into a text box. 

For selecting option buttons and check boxes
Press To
Arrow keys Select an option button within a group of

options.



SPACEBAR Select or clear a check box (add or 
remove an X).

For selecting an item from a list box or drop-down list box
Press To
ALT + DOWN ARROW Open a drop-down list box.

Arrow keys Select an item in a list box.

HOME Move to the first item in a list box.
END Move to the last item in a list box.

PAGE UP or PAGE DOWN Scroll up or down in a list box, one 
window at a time.

ENTER Choose the selected item in the list box 
and carry out the command.

For choosing command buttons
Press To
ENTER Carry out the command of a selected 

button, or carry out the command of the 
default button (the button with the 
heaviest border).

ESC or ALT + F4 Close a box without completing the 
command (same as Cancel button).

See also
Selecting and Editing in Text Boxes with Keys



Selecting and Editing in Text Boxes with Keys
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For selecting and editing text in a text box

Press To
Arrow keys Move the insertion point left, right, 

up, or down.
HOME Move the insertion point to the 

beginning of the line.
END Move the insertion point to the end 

of the line.

CTRL+ RIGHT or LEFT ARROW key Move the insertion point right or left 
one word.

CTRL+ HOME Move the insertion point to the first 
character in a text box.

CTRL+ END Move the insertion point to the last 
character in a text box.

PAGE UP or PAGE DOWN Scroll up or down a window at a 
time.

SHIFT+ Arrow key Select text.
BACKSPACE Delete the character to the left of 

the insertion point, or delete 
selected text.

DELETE Delete the character to the right of 
the insertion point, or delete 
selected text.

Copying and Pasting with Keys
G  LOSSARY  
For copying and pasting

Press To
CTRL + C Copy a selected portion of the displayed article onto 

the Clipboard.

CTRL+ V Paste the contents of the Clipboard into the 
Bookshelf Note dialog box, or into another Windows 
application.

See also
Copying and Pasting into Note



Using the Shortcut Menu with Keys
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In order to use the commands on the shortcut menu, you must select a word or phrase in any Bookshelf 
article, open the shortcut menu, then choose a menu command.
To use the shortcut menu with the keyboard, open the article, then follow the steps below:

Press To
1. Arrow keys Move the insertion point to the 

word or phrase you want to 
select.

2. SHIFT + RIGHT or LEFT ARROW key Select the word or phrase.

3. ENTER Open the shortcut menu.

4. DOWN ARROW key Choose Define, Copy, Copy to 
Word, or Find in.

5. ENTER Carry out the selected menu 
command.

If you choose Define, a definition box pops up with the Dictionary definition for the word you selected. 
Press any key to close the definition box.
If you choose Copy, the selected text is saved to the Clipboard. You can then paste it into the Bookshelf 
Note dialog box or into another application, such as Word, by opening the dialog box or application, then 
pressing CTRL+ V (be sure, when you are pasting into an application, that the insertion point is where you 
want the copied item to appear).
If you choose Copy to Word, a dialog box opens. Press TAB to select one of the three buttons--Copy, 
Cancel, or Help. Press the UP ARROW or DOWN ARROW key to select a document from the list box (i.e. the 
document in which you want the copied item pasted). Press ENTER to activate the selected button.
If you choose Find in, a book menu opens. Use the UP ARROW or DOWN ARROW key to select a book, then 
press ENTER. Bookshelf does a full-text search for the selected word or phrase and opens the Find Tab for
the book you selected. The Find list displays all the articles in the book that contain your word or phrase. 
The first article on the list is open in the Article window, with all occurrences of the selected text 
highlighted.



Using QuickShelf
QuickShelf is a floating toolbar that provides access to Bookshelf from any application in Windows. 
Whenever you start Windows, QuickShelf automatically opens, even if you have not opened Bookshelf. 
The QuickShelf toolbar is always present on your screen, unless you minimize it or exit QuickShelf 
entirely.

The following topics will help you understand and use QuickShelf:
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Guide to the QuickShelf Toolbar
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The QuickShelf toolbar is a floating "shelf" of books that opens whenever you start Windows, even if you 
have not yet started Bookshelf. You use this toolbar to access Bookshelf articles when you are working in 
other Windows applications. The default location of the toolbar is at the top left of your screen, but you 
can move it to any other location. The toolbar then occupies this new location in every Windows 
application.
When you first install Bookshelf, the QuickShelf toolbar automatically displays in its smallest form and 
consists of book buttons for Dictionary Contents, Thesaurus Contents, Address Builder Find, and All 
Books Find. You can customize the toolbar to suit your needs with any combination of Contents and/or 
Find buttons for any or all of Bookshelf's books, plus Address Builder. You can also change the size of the
toolbar's book buttons from Small to either Regular or Large. When the buttons are either of the larger 
sizes, they reside in a small window with a title bar, Control-menu button, and Minimize button.

 When you move the mouse pointer slowly over the QuickShelf toolbar, Tooltips appear that identify 
the book buttons.
The arrow button at the right end of the toolbar opens the QuickShelf menu, which has the following 
commands:
 Customize opens the tabbed Customize dialog box. Use the Toolbar Tab to add or change books on the

QuickShelf toolbar. Use the View Tab to change QuickShelf settings, such as the size of the toolbar 
buttons.
 QuickShelf Keys opens the QuickShelf Keys dialog box, where custom keyboard shortcuts can be set 

up by those who prefer using keyboard commands.
 Help opens Help topics specific to QuickShelf.
 About Microsoft QuickShelf gives basic information about the product, including copyright information.
 Exit closes QuickShelf.
 When you right-click anywhere along the QuickShelf toolbar, a shortcut menu displays. Use this menu to

open the Customize dialog box; change the size of your QuickShelf buttons; minimize QuickShelf to an 
icon; or open QuickShelf Help.

See also
Customizing QuickShelf
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Setting Up QuickShelf Keys
Using the QuickShelf Shortcut Menu
Closing QuickShelf



Using QuickShelf to Access Bookshelf from Other Applications
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QuickShelf is the handy way to access Bookshelf from any application in Windows. The QuickShelf 
toolbar is always visible, unless you minimize it or exit QuickShelf entirely.
To use QuickShelf to access Bookshelf from another Windows application
1. In another Windows program, such as Word, select a word or phrase.
2. Decide which book you want to access and whether you want to search using Contents or Find.
3. Click the appropriate book button on the QuickShelf Toolbar.

-Or-
Press your QuickShelf Keys command, if you've created one in the QuickShelf Keys option box.
Bookshelf opens to the book you chose.
If you search using a book's Contents button, the book's Contents Tab opens with your word or phrase 
in the text box and the article containing your word or phrase displayed in the Article window.
If you search using a book's Find button, the book's Find Tab opens with your word or phrase in the 
text box, and the list of articles that contain your word or phrase in the list box. The first article on the 
list is displayed in the Article window.

To switch from Bookshelf back to the other application
Press ALT+ TAB.
-Or-
1. Click the Control-menu box.
2. From the Control menu, click Switch To.
3. From the Task List box, select the name of the application you want to switch to.
4. Click the Switch To button.

See also
Using QuickShelf to Access Address Builder from Other Applications
Setting Up QuickShelf Keys
Customizing QuickShelf
Guide to the QuickShelf Toolbar
Using the QuickShelf Shortcut Menu
Closing QuickShelf



Using QuickShelf to Access Address Builder from Other Applications
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QuickShelf is the handy way to access Address Builder from any application in Windows. Address Builder 
will help you build a complete address or check the accuracy of a known address.
To use QuickShelf to access Address Builder from another Windows application
1. In another Windows application, such as Word, select the primary street line of a U.S. address, or the 

city, or the state, or the zip code.
2. Press CTRL+ C or choose Copy from the application's Edit menu to copy the selection to the Clipboard.
3. Click the Address Builder button on the QuickShelf toolbar.

The Address Builder dialog box opens.
4. Put the insertion point in the correct text box for the item you copied, then press CTRL+ V.

The selection is pasted into the text box.
5. Click the Find button or press ENTER.
6. Address Builder displays all city/state/zip codes for that particular search item.
 You can also access Address Builder without selecting any information from the other application. 

Simply click the Address Builder button on the QuickShelf toolbar to open the Address Builder dialog box. 
You can then enter text in any text box to search for various combinations of address information.
To copy address information from Address Builder and paste it into the other application
1. Click the correct city/state/zip code combination to select it.
2. Click the Copy Address button or press ENTER to copy the address to the Clipboard.
 When you copy from Address Builder, all address lines displayed in the Address Builder dialog box are 

copied. If you wish to copy just the city/state/zip code information, delete the street address line(s) 
BEFORE you click Copy Address or press ENTER.
3. Press ALT+ TAB to return to the other application.
4. With the insertion point in the correct location in the document, press CTRL+ V or choose Paste from 

the Edit menu.
The address information is pasted into the document exactly as it appeared in Address Builder.

See also
Using Address Builder
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Customizing QuickShelf
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You can customize the QuickShelf toolbar to look and function in ways that suit your particular needs. The
QuickShelf Customize feature lets you put any number or combination of book buttons on the toolbar, and
allows access to each book through Contents, Find, or both. In addition, you can reset QuickShelf's 
default options to make the toolbar buttons larger, hide the toolbar, and turn off ToolTips. You can also 
change the shape of the toolbar window and move it to any location on your screen. In addition, you can 
minimize QuickShelf to an icon or close it entirely.
The following topics provide instructions for customizing QuickShelf:

Adding or Changing Book Buttons on the QuickShelf Toolbar
Setting QuickShelf Toolbar Options
Moving the QuickShelf Toolbar to Another Location on the Screen
Changing the Shape of the QuickShelf Toolbar
Minimizing and Restoring QuickShelf



Adding or Changing Book Buttons on the QuickShelf Toolbar
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The default setting for the QuickShelf toolbar displays buttons for the Dictionary Contents, Thesaurus 
Contents, Address Builder Find, and All Books Find. You can add or change the book buttons on the 
toolbar to suit your needs.
To add or change book buttons on the QuickShelf toolbar
1. Click the arrow button at the right end of the toolbar to open the QuickShelf menu.

-Or-
Right-click the QuickShelf toolbar to open a shortcut menu.

2. On either menu, click Customize.
The Customize dialog box opens. There are two tabs--Toolbar and View.

3. Click the Toolbar Tab if it is not already open.
4. Decide which books you want on the QuickShelf toolbar, and whether you want to locate information in

each book using Contents, Find, or both.
5. Click the check box of each book you want on the QuickShelf toolbar.

An X in the check box means the book will appear on the toolbar. Click a check box containing an X to 
clear it and remove the book from the toolbar.

6. Click OK to save your book settings and close the dialog box. (If you decide you don't want to make 
changes, click Cancel.)
The QuickShelf toolbar will now have book buttons for those books you selected.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Setting QuickShelf Toolbar Options
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When you install Bookshelf, the QuickShelf toolbar automatically displays in its smallest form, with the 
ToolTips labels active, and the toolbar visible at all times at the top of every Windows application. You can
change any of these options to suit your needs.
To reset QuickShelf toolbar options
1. Click the arrow button at the right end of the toolbar to open the QuickShelf menu.

-Or-
Right-click the QuickShelf toolbar to open a shortcut menu.

2. On either menu, click Customize.
The Customize dialog box opens. There are two tabs--Toolbar and View.

3. Click the View Tab if it is not already open.
4. Decide which option(s) you want to change, then following the corresponding steps below:

To change the size of the toolbar buttons
1. Click one of the three size options under "Toolbar Button Size." A dot indicates which button size is 

selected.
2. Click OK to save the size setting and close the dialog box.
-Or-
1. Right-click the QuickShelf toolbar to open the QuickShelf shortcut menu.
2. Click one of the button sizes to instantly change the size of the toolbar and close the menu. 

When the toolbar buttons are Regular or Large, the toolbar resides in a small window with a title 
bar, Control-menu button, and Minimize button.

To hide the QuickShelf toolbar
1. Click the check box next to "Toolbar is Always Visible" to remove the X.
2. Click OK to save the change and close the dialog box.

 The toolbar will not disappear until you switch to another application; the toolbar will then be hidden 
behind the active window. You can redisplay the QuickShelf toolbar by holding down the ALT key and 
pressing TAB until the QuickShelf name appears. Release the ALT key to display the QuickShelf toolbar.

To turn off the QuickShelf ToolTips
1. Click the check box next to "Show ToolTips" to remove the X.
2. Click OK to save the change and close the dialog box.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Moving the QuickShelf Toolbar to Another Location on the Screen
G  LOSSARY  

When you install Bookshelf, the QuickShelf toolbar automatically displays in its smallest form near the top
left of your screen, on the title bar of the active window.
To move the QuickShelf toolbar to another part of the screen
1. Change the size of the book buttons from Small to either Regular or Large.
 Use either the QuickShelf shortcut menu or the Customize feature to change the button size.

2. Put the mouse pointer on the QuickShelf title bar.
3. Hold down the left mouse button and drag the toolbar to any part of the screen that suits you.
4. Release the mouse button.
-Or-
1. With the toolbar button size set at either Regular or Large, click the Control-menu box in the upper-left 

corner of the toolbar. 
The QuickShelf Control menu opens.

2. On the Control menu, click Move.
A four-headed arrow displays.

3. With the four-headed arrow positioned on the toolbar, hold down the left mouse button and drag the 
toolbar to any part of the screen that suits you.

4. Release the mouse button.
The toolbar will occupy this new location in every Windows application.

 If you change the button size back to Small, the toolbar snaps back to its default position at the top left 
of the screen.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Changing the Shape of the QuickShelf Toolbar
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When you install Bookshelf, the QuickShelf toolbar automatically takes the shape of a horizontal bar. You 
can reshape the toolbar to a square, a vertical bar, or a variety of rectangles. The more book buttons you 
have on the bar, the more rectangular shapes you can create.
To change the shape of the QuickShelf toolbar
1. Change the size of the book buttons from Small to either Regular or Large.

The toolbar now resides in a small window.
 Use either the QuickShelf shortcut menu or the Customize feature to change the button size.

2. Move the mouse pointer along any of the four sides of the toolbar window until the pointer turns into a 
double-headed arrow. 
-Or-
Click the Control-menu box in the upper-left corner of the toolbar window to open the Control menu.
On the Control menu, click Size.
A four-headed arrow displays.
Move this arrow along any of the four sides of the small toolbar window until it turns into a double-
headed arrow.

3. Hold down the left mouse button and move the double-headed arrow in one direction. 
As you move the arrow, an outline of the window shows an example of the shape the toolbar will take 
should you release the mouse button. 

4. When the outline is the shape you want, release the mouse button.
The toolbar buttons align themselves in the shape of the new window.

 If you change the button size back to Small, the toolbar changes back to the horizontal shape.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Minimizing and Restoring QuickShelf
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The QuickShelf toolbar is always visible in every open Windows application unless you minimize it to an 
icon or exit QuickShelf entirely.
To minimize the QuickShelf toolbar to an icon
1. Right-click the QuickShelf toolbar to open the QuickShelf shortcut menu.
2. Click Minimize.
-Or-
1. Change the size of the book buttons from Small to either Regular or Large.
 Use either the QuickShelf shortcut menu or the Customize feature to change the button size.

2. Click the Minimize button at the right end of the QuickShelf title bar.
-Or-
Click the Control-menu button at the left end of the QuickShelf title bar, then click Minimize.
The toolbar reduces to an icon.

To restore the QuickShelf toolbar, do one of the following:
Double-click the QuickShelf icon.
Click the QuickShelf icon to display a shortcut menu, then click Restore.
Hold down the ALT key and press TAB until the QuickShelf name appears on your screen, then 

release the ALT key.
The toolbar reappears on your screen in the size, shape, and location it was before you minimized it.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys
Closing QuickShelf



Using the QuickShelf Shortcut Menu
G  LOSSARY  

To use the QuickShelf shortcut menu
1. Right-click the QuickShelf toolbar.

A shortcut menu opens. 
2. On the shortcut menu, click any of the following:
    Customize to open the QuickShelf Customize dialog box.
    One of the Button sizes to change the size of the toolbar buttons (a check mark next to a Button size 

means the toolbar buttons are currently that size).
    Help to open a Help topic specific to using QuickShelf.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Setting Up QuickShelf Keys
Closing QuickShelf



Setting Up QuickShelf Keys
G  LOSSARY  

You can set up custom key commands to quickly access any book's Contents or Find functions from any 
Windows application.
WARNING    If you assign a QuickShelf Key the same key combination as one of the standard keyboard 
commands, such as CTRL+ C (for copying) or CTRL+ P (for printing), the QuickShelf Key will override the 
standard keyboard command.
To set up QuickShelf Key commands
1. Click the arrow button on the QuickShelf toolbar.

The QuickShelf menu opens.
2. On the QuickShelf menu, click QuickShelf Keys.

The QuickShelf Keys dialog box opens. The dialog box has a list of all the Bookshelf books, with each 
book having text boxes for both Contents and Find functions. Any box that has not been assigned a 
Key command will contain the word None.

3. Put the insertion point in the text box in which you want to assign a Key command, then press the key 
combination for the command you want to use.
Key combinations need at least one modifier, such as CTRL, SHIFT, or ALT, although SHIFT and ALT by 
themselves are not valid commands. If you choose a key or a key combination that isn't valid because 
it doesn't have a valid modifier, Bookshelf will automatically add the CTRL key as a modifier. For 
example, if you just press X, Bookshelf will assign CTRL+ X as the command for that text box. Or, if you 
assign SHIFT+ F2, then CTRL+ SHIFT+ F2 will appear in the text box.

The following keys and key combinations cannot be used as valid QuickShelf Key commands:
    F1 and F10
    SHIFT in combination with another key
    ALT in combination with another key
    CTRL+ ALT+ DEL
    CTRL+ ALT+ SHIFT+ DEL
    ESC, PRINT SCREEN, PAUSE, ENTER, SPACEBAR, TAB
    The following characters: (      )    '    -    +    [ ]    \    ;    ,    /

4. If you need to clear a key combination, put the insertion point in the text box, then press the SPACEBAR.
The key combination is replaced with the word None.

5. When you are finished assigning Key commands, click the Enable QuickShelf Keys check box in the 
lower-left corner of the dialog box so there is an X in it (to disable Key commands, click the X to clear 
the check box).

6. Click Close to save your changes and close the dialog box.

See also 
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Closing QuickShelf



Closing QuickShelf
G  LOSSARY  

Once Bookshelf is installed, QuickShelf opens every time you start Windows. The QuickShelf toolbar is 
always visible in every Windows application, unless you close it entirely.
To close QuickShelf entirely, do one of the following:

Click the arrow button at the right end of the toolbar to open the QuickShelf menu, then click Exit.
With the book buttons sized to Regular or Large, double-click the Control-menu button.

-Or-
Click the Control-menu button to open the Control menu, then click Close.

See also
Guide to the QuickShelf Toolbar
Using QuickShelf to Access Bookshelf from Other Applications
Using QuickShelf to Access Address Builder from Other Applications
Customizing QuickShelf
Using the QuickShelf Shortcut Menu
Setting Up QuickShelf Keys



Using Address Builder
G  LOSSARY  

The Bookshelf Address Builder, located on both the Tools menu and the QuickShelf toolbar, provides a 
quick, easy way to locate address information and build a complete address for most U.S. locations. 
Address Builder is also a handy tool for checking the accuracy of a known address. In addition, you can 
use Address Builder to locate interesting information about U.S. addresses, such as the number of cities 
with a street address that matches your own; states that have cities of the same name; and cities that 
share a particular zip code. Once you've located the address information you need, you can copy it to the 
Clipboard and paste it into another application. 
 The city/state/zip code combinations that Address Builder provides for any given street address are in 

accordance with the postal addressing standards of the United States Postal Service. If you have 
occasions where your search results are not what you expect, it may be due to a discrepancy between 
what you believe is a correct address and what the U.S. Postal Service considers a correct address.
The following topics will help you use Address Builder:

Locating Address Information with Address Builder
Copying from Address Builder
Address Builder: Suggestions for Success
Using QuickShelf to Access Address Builder from Other Applications



Locating Address Information with Address Builder
G  LOSSARY  

There are many ways to use Address Builder to locate address information. You can use Address Builder 
to help you build a complete address; check the accuracy of a known address; or just locate interesting 
information about U.S. addresses, such as the number of cities with a street address that matches your 
own.
 The city/state/zip code combinations that Address Builder provides for any given street address are in 

accordance with the postal addressing standards of the United States Postal Service. If you have 
occasions where your search results are not what you expect, it may be due to a discrepancy between 
what you believe is a correct address and what the U.S. Postal Service considers a correct address.
To locate address information
1. From the Tools menu, choose Address Builder.

-Or-
Click the Address Builder button on the QuickShelf toolbar.
The Address Builder dialog box opens.

2. Type known address information in one or more text boxes.
 If you don't know the correct 2-letter abbreviation for a state, just type the first four or five letters of 

the state name and Address Builder will locate the state that most closely matches what you typed.
 Use the line 2 Street Address text box for secondary unit designators (APT- apartment, STE - suite, 

BLDG - building, DEPT - department, etc.).
3. Click the Find button.

All cities, states, and zip codes that match the search text will display in the Address Builder list box. If 
the list is long, use the scroll bar to browse through the selections.

Type in To find
Street and city All states and zip codes for that street/city 

combination.

Street All cities, states, and zip codes with that street 
address.

Street and state All cities and zip codes in that state for that street
address.

Street and zip code The exact city and state for that street/zip 
combination.

City All states and zip codes for cities with that name.

City and state All zip codes for that city/state combination.

City and zip The exact state.

State All cities in the state and all zip codes for each 
city.

State and zip code All cities in that state with that zip code.

Zip code All cities (and, in some cases, sections of cities) 
with that zip code.

See also
Two-Letter State Abbreviations
Copying from Address Builder



Address Builder: Suggestions for Success
Using QuickShelf to Access Address Builder from Other Applications



Copying from Address Builder
G  LOSSARY  

You can copy information from Address Builder to the Clipboard, then paste it into other applications.
To copy address information from Address Builder and paste it into another application
1. Be sure all the information you want to copy is correctly displayed in the Address Builder text boxes. 
2. If more than one city/state/zip code is listed in the list box, click the city/state/zip code combination you 

want.
3. Click the Copy Address button to copy the address to the Clipboard.
 When you copy from Address Builder, all lines of the address are copied. If you wish to copy just the 

city/state/zip code information, delete the street address line(s) BEFORE you click Copy Address.
4. Open the application you want to paste into.
5. With the insertion point in the correct location in the document, press CTRL+ V or choose Paste from 

the Edit menu.
The address information is pasted into the document exactly as it appeared in Address Builder. 

See also
Locating Address Information with Address Builder
Address Builder: Suggestions for Success
Using QuickShelf to Access Address Builder from Other Applications
Two-Letter State Abbreviations



Address Builder: Suggestions for Success
G  LOSSARY  

The city/state/zip code combinations that Address Builder provides for any given street address are in 
accordance with the postal addressing standards of the United States Postal Service. If you have 
occasions where your search results are not what you expect, it may be due to a discrepancy between 
what you believe is a correct address and what the U.S. Postal Service considers a correct address.

If Address Builder is unable to find the address information you need, try the following suggestions:
Check to see that the street name and/or city name is spelled correctly.
If an address has a directional (N, S, E, W, NE, NW, SE, or SW) be sure to include it.
Be sure the directional is typed in the correct location in relation to the street name or number.

Example: If an address is 101 Main St. NW and you type 101 NW Main St., you will get either no 
results or incorrect results. 

Try deleting information you have typed in one of the text boxes. Sometimes you will get better 
results if you don't narrow your search too much. 

Example: You type in a street address and a state, but the state you type is wrong. Your search will fail.
If you delete the state, Address Builder will provide all the city/state/zip codes that match the street 
address. You can then pick the correct information from the list.

See also
Two-Letter State Abbreviations
Locating Address Information with Address Builder
Copying from Address Builder
Using QuickShelf to Access Address Builder from other Applications



Two-Letter State Abbreviations
The following lists the two-letter abbreviations for U.S. states, territories, and military stations. 
U.S. State, Territory, or Military Station Abbreviation
Armed Forces Americas, except Canada AA
Armed Forces Europe, Middle East, & Canada AE
Armed Forces Pacific AP
Alaska AK
Alabama AL
Arkansas AR
American Samoa AS
Arizona AZ
California CA
Colorado CO
Connecticut CT
District of Columbia DC
Delaware DE
Florida FL
Federated States of Micronesia FM
Georgia GA
Guam GU
Hawaii HI
Iowa IA
Idaho ID
Illinois IL
Indiana IN
Kansas KS
Kentucky KY
Louisiana LA
Massachusetts MA
Maryland MD
Maine ME
Marshall Islands MH
Michigan MI
Minnesota MN
Missouri MO
Northern Mariana Islands MP
Mississippi MS
Montana MT
North Carolina NC
North Dakota ND
Nebraska NE
New Hampshire NH
New Jersey NJ
New Mexico NM
Nevada NV
New York NY
Ohio OH
Oklahoma OK
Oregon OR
Pennsylvania PA
Puerto Rico PR
Palau PW
Rhode Island RI
South Carolina SC
South Dakota SD



Tennessee TN
Texas TX
Utah UT
Virginia VA
Virgin Islands VI
Vermont VT
Washington WA
Wisconsin WI
Wyoming WY





Glossary of Error Messages
If Bookshelf is unable to carry out a command or function, an error message will display on your screen. 
Listed below are messages you might see while working in Bookshelf. They are listed in alphabetical 
order by the first word of the message. Click the number of the message to display a pop-up description 
of the cause and/or suggested action. Use the scroll bar or press the PAGE DOWN key to view messages 
not visible on your screen.

1. An invalid argument was passed to a search function.
2. An unknown problem occurred.
3. A part of the search query contains stop words or begins or ends with a search operator.
4. A subexpression was used as an operand to the THRU operator. The THRU operator supports 

only simple terms as operands.
5. A word in the search query is too long. Search words can have a maximum of 255 characters.
6. Bookshelf cannot find the CD-ROM disc. Please insert the Bookshelf disc and press OK to 

continue.
7. Bookshelf could not find WINWORD.EXE.
8. Bookshelf could not open the specified multimedia device.
9. Bookshelf could not play the movie.
10. Bookshelf could not play the video.
11. Bookshelf was unable to paste into Word. Please check your document.
12. Bookshelf was unable to start Word.
13. Cannot read the Bookshelf Note file.
14. Copy to Word is unavailable. Bookshelf was unable to locate the necessary files.
15. Could not open MCI device.
16. Could not open multimedia-controller window.
17. Could not open multimedia-element window.
18. Could not open multimedia window.
19. Could not open the document.
20. Filename extension of the specified multimedia file is not associated with any installed MCI 

devices.
21. Insufficient disk space to perform search. Delete some files to free disk space and try again.
22. Invalid value for NEAR. Enter a number from 1 to 999.
23. Multimedia controller failed because there is not enough memory available.
24. Multimedia controller requires windows with multimedia.
25. No articles were found that match the criteria you selected.
26. No associated topics found.
27. No See Also articles found.
28. The operands to the THRU operator are of different data-types.
29. There is not enough memory to complete the operation.
30. There is not enough memory to load this annotation.
31. There is not enough memory to save this annotation.
32. There was an undetectable problem in loading the specified device driver.
33. The search failed. Bookshelf could not open a required file because too many files are open.



34. The search failed. The Bookshelf disc cannot be read.
35. The search failed. The Bookshelf disc was not found.
36. The search query contains an improper data value (for example, an invalid date or out-of-range 

number).
37. The search query contains a word consisting of only a wildcard (*). Search words cannot begin 

with a wildcard, and the wildcard must be the last character in the word. 
38. The search query has too many terms.
39. The search query is empty or has no searchable words. You cannot search for words marked as 

stop words (for example, "the," "that," or "a").
40. The search query is missing a left parenthesis mark.
41. The search query is missing a quotation mark.
42. The search query is missing a right parenthesis mark.
43. The search query is too complex. Do not nest parentheses more than five levels deep.
44. The search query is too long or too complex.
45. The search query or a subexpression within parentheses begins or ends with a search operator.
46. This topic is too large to send.
47. This version of Bookshelf is incompatible with the multimedia controller.
48. Unable to search.
49. You cannot enter any more text in the annotation. The annotation cannot be more than 30,000 

characters in length.
50. Your search word or phrase, [    ],    was not found.
51. You will not be able to make changes. The Bookshelf Note file may be read-only, or memory may 

be low.



You are trying to play an animation, a video, or an audio clip when there is not enough memory available, 
or there is a problem with Windows. If you are using other multimedia elements, close them to free 
memory, or save your work and close one or more applications, and then try again. If you still cannot play 
the animation, video, or audio, close and restart Windows. If you still have problems, check your 
installation of Windows. To use all the features in Bookshelf, you need at least 4 MB (megabytes) of 
memory. If necessary, quit and restart Windows.



The topic (Bookshelf article) text is on the Clipboard. Try pasting it into Word.



You have used the asterisk wildcard character (*) incorrectly in your Find query. The asterisk may be used
only at the end of a word.



Bookshelf may not be installed properly. Try reinstalling.



Your search query or a part of your query includes stop words (a, an, and, as, at, be, but, by, do, for, from,
have, he, in, is, it, not, of, on, or, she, that, the, there, they, this, to, we, which, with, you, 1, 2, 3) for which 
Bookshelf will not search. Or your query or a subexpression within parentheses either begins or ends with
a search operator (AND, OR, NOT, NEAR), which is not allowed. Type the Find request again, eliminating
stop words and making sure that the query or any subexpression within parentheses does not begin or 
end with an operator.



Please call the Product Support phone number listed in the booklet that came with your disc. Be prepared
to tell what the message box said and what you were doing when it appeared.



Your Find query contains parentheses nested more than five levels deep. This is not allowed in Bookshelf.
Revise your query and try again.



You are trying to play an animation or audio clip that is not compatible with any of the installed MCI 
devices. The appropriate files are identified by the filename extension, .mmm for an animation or .wav for 
an audio clip. Choose another animation or audio clip.



Make sure the WordPath option in the Word section of the BSHELF95.INI file in the Windows directory 
contains a full path to WINWORD.EXE. If necessary, reinstall Word and Bookshelf.



Check the Word document. If necessary, quit and restart Windows.



A new document window can't be opened in Word until you close the other open document windows.



Try again. If necessary, reinstall Word and Bookshelf.



You have selected a word in another application and used QuickShelf to look it up in Bookshelf, but the 
Contents for the book you are looking in does not contain that word.



Check your drive to be sure you're using the Bookshelf disc. Make sure the disc is inserted properly. 
Check your disc and CD-ROM drive to be sure they are functioning properly.



Try setting up a different search query. For some suggestions on how to use search operators see the 
following Help topic: Find Hints: How to Narrow the Scope of a Search."



Your Find query failed. Try closing one or more applications or features. Keep your query simple or type 
fewer words in the text box. Avoid using very common words in your query.



Try setting up a different search query. Remember to keep it simple. THRU can be used to search for 
things like "aa THRU z" or "1 THRU 4" but not "aa THRU (dog and cat)".



Try setting up a different search query. Remember to keep it simple. THRU can be used to search for 
things like "aa THRU z" or "1 THRU 4" but not "aa THRU (dog and cat)".



You entered a NEAR value that was outside of the accepted range. Try again.



Your disk may be full, the temporary directory may have too many files, or the temporary directory may be
on a read-only drive. Try restarting Windows.



The query failed because you have too many files open. Close one or more applications or features, then 
try again.



The Find feature cannot complete the query because of a disk problem. Check the CD-ROM and your 
hard disk drive for errors.



Your Find query is too long. Type fewer words or operators in the text box, and then try again.



You either failed to enter search text in the text box or your search query contains only stop words. Stop 
words are common words for which Bookshelf will not search and include the following: a, an, and, as, at, 
be, but, by, do, for, from, have, he, in, is, it, not, of, on, or, she, that, the, there, they, this, to, we, which, 
with, you, 1, 2, 3. Type a new query in the text box using the specific words you want to find.



A Find query cannot begin or end with an operator (AND, OR, NOT, or NEAR). You did not type a word 
either before or after the operator, or you typed a word that is too common to search for. Try typing a 
specific word before or after the operator.



Your Find query is missing either an opening or a closing quotation mark. Add the quotation mark and try 
again.



Your Find query is missing    an opening parenthesis mark. Add the parenthesis mark and try again.



Your Find query is missing a closing parenthesis mark. Add the parenthesis mark and try again.



You have typed a word in your Find query that is too long to search for. Keep words in queries under 255 
characters.



Check your search query to make sure the date or number you have typed is a proper value.



You are trying to start Bookshelf, but Bookshelf is having a problem finding the files. Either there is no 
disc in the CD-ROM drive, or your Bookshelf files are corrupt. Make sure that the Bookshelf disc is in the 
CD-ROM drive, and try again. If you still have a problem, run Setup again.



You are trying to play an animation, video, or audio clip, but there is a problem with the respective driver 
in your Windows installation. In the Windows Main program group, double-click the Control Panel icon, 
and then check the driver settings to make sure the device is correctly installed. Try closing and then 
restarting Windows. If you still have problems with the feature, check your installation of Windows.



Your annotation is too long. Please shorten it, and try again. If you are copying text from a Bookshelf 
article into your annotation, try being more selective.



Your disk may be full. Some changes may not be reflected. Delete some files and try again.



Please close the Note dialog box and try again. If this does not work, try closing other applications to free 
up memory.



The file may be corrupt. Please cancel the Note dialog box.



Cancel the Note dialog box. Try closing other applications to free up memory.



There is no list of related articles for this article.



You are trying to use the Find feature to do a full-text search in Bookshelf when there is not enough disk 
space available.



You are trying to play an animation or video, but there is no memory available, or there is a problem with 
Windows. If you are using other multimedia elements, close them to free memory, then try again. If you 
still cannot play the animation or video, close one or more applications or features and try again. If the 
problem continues, try closing and then restarting Windows. If you still have problems with the animation 
or video, check your installation of Windows. 



There are no articles that meet all the criteria you selected. You may want to change your search 
selections or your search text and try again.



The Copy to Word feature is not available because the necessary files have either been moved or 
deleted. Please reinstall Bookshelf '95.



Troubleshooting
The following topics cover some common technical problems that you may encounter while using 
Bookshelf. If this information does not solve your particular problem, check the Bookshelf '95 ReadMe file,
or contact the Microsoft Support Network as described in the jewel case insert that came with your 
Bookshelf disc.

Audio Problems
CD-ROM Drives
Improving Performance
Printing Problems
Video Display Problems



Troubleshooting: Audio Problems
The following topics present solutions for some common audio problems.

No Sound
Sound is Distorted
Sound Breaks Up
Sounds are Cut Off
MIDI with Media Player Problems
MIDI Anthems and Musical Examples Fail to Play



Troubleshooting: Audio Problems - No Sound
If sound does not play at all
1. Be sure a sound card is installed.
2. Check that a speaker is connected to the jack on your sound card (not to the CD-ROM drive).
3. Check the volume to be sure it is set at an audible level.
4. If the volume is turned up and you still hear no sounds, something may be wrong with your sound 

board installation. Check to see that the sound board drivers and necessary Windows drivers are 
installed correctly and reinstall if necessary.
To check the installed drivers, open the Windows Control Panel and click the Drivers icon.
Windows drivers necessary for sounds include:

 Timer
 MIDI Mapper
 [MCI] Sound
 [MCI] MIDI Sequencer

If any of these drivers are missing, add them by clicking the Add button.
5. If the software is installed correctly, the sound board may need to be pressed more securely into its 

slot or have a jumper setting changed.
6. If you have both a sound board and special software that bypasses the sound board to play sounds 

through the PC speaker, we suggest you remove or disable the special software (the PC speaker 
driver). Bookshelf requires an MPC-compatible sound board to be installed and is not meant to run 
with the PC internal speaker or any combination of that speaker and special software.



Troubleshooting: Audio Problems - Sound is Distorted
If sound is distorted or "fuzzy"
This is often caused by sending a higher volume, or amplitude of sound, to the speakers than they are 
able to handle, or by turning the volume control on your sound board up too high (distortion from the 
amplifier on the sound board). The quality of your speakers can affect the amount of distortion that 
occurs. Some lower quality speakers will distort at a lower volume than will better speakers (compare a 
clock radio speaker to a big stereo system; the stereo speakers can play much louder with no distortion). 
For example, if the volume for your sound board or WAVE file output is set near its maximum, it will 
produce distortion just like a radio that is turned up too loud. Some speakers are better at "filtering out" 
this distortion than others.
To learn how to adjust your sound board settings, check the manuals that came with your sound board. 
Changing sound board settings is normally done with either a volume dial on the back of your sound 
board (in the rear of your computer where the speakers plug in), or with a program that is often called a 
mixer that is usually installed in the Windows Control Panel of the Main program group. Some sound 
boards use both types of controls and they must both be adjusted.



Troubleshooting: Audio Problems - Sound Breaks Up
If sound plays, but the audio breaks up or skips
This is usually an indication that the CD-ROM drive does not fully meet the MPC (Multimedia PC) 
specification for the Data Transfer Rate. The MPC specification states that the CD-ROM drive needs to be
capable of transferring data at a rate of 150 K (kilobytes) per second while utilizing 40% or less of the 
CPU. You can continue to use your CD-ROM drive to run Bookshelf, but will continue to experience this 
choppiness in audio and animation clips.



Troubleshooting: Audio Problems - Sounds are Cut Off
If sounds are cut off
This may be due to other sound-producing programs you have running. Your computer can play only one 
sound at a time, therefore other applications that produce sounds can interrupt the sounds in Bookshelf. 
Some sound-producing programs can take over the audio capability and prevent other Windows 
programs from being able to make sounds. If you suspect you have such a program, do not run it at the 
same time as Bookshelf.



Troubleshooting: Audio Problems - MIDI with Media Player Problems
Media Player is a program that can play MIDI (Musical Instrument Digital Interface) files. It is normally 
located in the Accessories group in Program Manager. It allows you to check the MIDI installation in a 
simple way. After using the File Open command to load a .MID file into Media Player (there should be 
some in the Windows directory) click the Play button. You may get the following message:

"The current MIDI Mapper setup refers to a MIDI device that is not installed on the system. Use MIDI 
Mapper to edit the setup."

If this message appears, it means that your MIDI Mapper is not configured properly. The first thing to do in
this case is to check if your MIDI Mapper configuration was changed:
1. Look for a file called MIDIMAP.OLD in your \windows\system directory. If this file exists, it means that 

your original MIDI Mapper configuration file was replaced.
2. If you see a MIDIMAP.OLD, then rename MIDIMAP.CFG to MIDIMAP.BAK.
3. Now rename MIDIMAP.OLD to MIDIMAP.CFG.
4. Try playing a MIDI file in Media Player.
If this procedure fails or is inapplicable, run Control Panel (usually in the Main group of the Windows 
Program Manager) and check the setup in the MIDI Mapper.
For example, if the Ad Lib driver is installed in the Drivers part of the Control Panel, the MIDI Mapper 
should be set for Ad Lib. If a different MIDI device is installed, choose an appropriate setup for the device.
For more information on setting up the MIDI device drivers, look in the manuals that came with your 
sound board.
To set the MIDI Mapper to use the Ad Lib setup:
1. Run Control Panel.
2. Run MIDI Mapper.
3. Press ALT + S to show setups.
4. Press ALT + A to move to the name field for setups.
5. Use the UP ARROW and DOWN ARROW keys to set the name field to Ad Lib and the description below the 

name field to "Base-level setup."
6. Close the MIDI Mapper to accept this setup.



Troubleshooting: Audio Problems - MIDI Anthems and Musical Examples Fail to 
Play
If anthems or other musical examples fail to play
Perform the following steps as necessary:
1. In Media Player, choose MIDI Sequencer from the Device menu.

An Open dialog box appears with the file CANYON.MID listed in the \WINDOWS directory.
 If MIDI Sequencer is not listed, the sound card or sound card software is not configured correctly for 

MIDI files to play in Windows. Contact the sound card manufacturer for more information.
2. Select CANYON.MID and choose OK. 
3. Select the Play button on the lower left side of Media Player. 
If no sound is heard, try increasing the volume and test again. You may get the following message:

"The current MIDI Mapper setup refers to a MIDI device that is not installed on the system. Use MIDI 
Mapper to edit the setup."

This message means you may have an incorrect "MIDI Mapper"setting in your Control Panel.
To see if your MIDI Mapper settings are correct, do the following:
1. Execute the Control Panel program that is located in your Main group. 
2. Double-click the MIDI Mapper icon. 
3. Click the edit button. 

The third column labeled "Port Name" contains 16 different port names. They should all be set to 
something other than [NONE]. 

4. Update the MIDI Mapper as needed, choose OK, choose Yes, then choose Close. 
You should now be able to exit the Control Panel and play MIDI files, including the anthems. 

Another possible reason anthems or other musical examples may fail to play is a corrupt MIDIMAP.CFG 
file. You may be able to correct this by doing the following:
1. In File Manager, choose Search from the File menu. 
2. In the Search For box, type "midimap.cfg" (without the quotation marks). 
3. In the Start From box, type "<drive>:\" (without the quotation marks), where <drive> is your hard drive. 

For example, if you hard drive is drive C, type "c:\". 
4. Select Search All Subdirectories. 
5. Choose OK.

MIDIMAP.CFG should be in at least the following two places on the hard drive:
- C:\WINDOWS\SYSTEM (this assumes that Windows is in C:\WINDOWS)
- A directory containing your sound card software

6. Make note of the directory location of the copy of MIDIMAP.CFG that came with the sound card, then 
exit Windows to MS-DOS. 

7. Copy MIDIMAP.CFG from the sound card software directory to C:\WINDOWS\SYSTEM. Choose Yes, 
if asked to overwrite the file. 

8. Restart Windows.



Troubleshooting: CD-ROM Drives
If Bookshelf cannot find the data files it needs to run, you will see a message prompting you to correct the
problem. To find the source of the problem, do the following:
    Do not remove the Bookshelf compact disc from your CD-ROM drive while running Bookshelf.

1. Make sure the Bookshelf compact disc is correctly inserted into the CD-ROM drive.
2. Make sure that the Bookshelf program is looking for the compact disc on the correct drive. Check that 

the command line for Bookshelf has the same drive letter as your CD-ROM drive. To check the drive 
letter, go to the Windows Program Manager. Highlight the Bookshelf icon, then from the File menu, 
choose Properties. You can then use the Windows File Manager to determine which drive letter is 
assigned to the CD-ROM drive. The Select Drive command in the Disk menu will say CD-ROM next to 
the drive letter.

3. If you have an external CD-ROM drive, make sure that the drive is connected to your computer, 
plugged in, turned on, and functioning in MS-DOS. This can be done by viewing a directory of the drive
at an MS-DOS prompt. To do this, change to the CD-ROM drive at an MS-DOS prompt, type DIR, then
press ENTER.



Troubleshooting: Improving Performance
Microsoft Bookshelf uses the random-access memory (RAM) of your computer to display pictures and 
play sound, animations, and videos. If Bookshelf runs slowly or you see out-of-memory messages, 
Bookshelf may not have enough memory. The following suggestions may make Bookshelf run faster.
1. Close all unnecessary applications.
2. If your computer is a 386, set up a permanent Windows swap file on your hard drive. Windows usually 

creates a Temporary swap file by default when running in 386 Enhanced Mode. (To determine if 
Windows is running in 386 Enhanced Mode, go to the Windows Program Manager and choose About 
Program Manager from the Help menu). If your disk is full or fragmented, however, this temporary file 
can become unavailable. This can affect performance because Windows works best when it has 
allocated hard disk space to use at any time for swapping a file in or out of the memory of your 
computer. It is therefore best to set up a permanent swap file, and to make the size of the permanent 
swap file at least 2048 K (kilobytes). You will get better performance if the permanent swap file is set to
3072 K or larger. To set up a permanent Windows swap file on your hard disk, open Windows Control 
Panel (usually in the Main program group of Program Manager) and click the 386 Enhanced icon. 
Then click the Virtual Memory button to see whether your current swap file is Temporary or Permanent.

3. Defragment ("clean up") or optimize your hard disk by running a defragmentation program. If you are 
Using MS-DOS 6.0 or higher, use the DEFRAG utility included with MS-DOS. Other popular utilities 
that provide defragmentation are PC Tools, Norton Utilities, and Mace Utilities.

4. Run Bookshelf without the SmartDrive device driver. To disable SmartDrive, do one of the following 
depending on the version of MS-DOS you are running:
If you are running MS-DOS version 5.0 or lower, open the CONFIG.SYS file in Notepad, change the 
DEVICE=SMARTDRV.SYS line to REM DEVICE=SMARTDRV.SYS, then save the edited 
CONFIG.SYS file.
If you are running MS-DOS 6.0 or higher, open the AUTOEXEC.BAT in Notepad, locate both    
SMARTDRV.EXE and MSCDEX.EXE. MSCDEX.EXE needs to be below SMARTDRV.EXE. If 
necessary, highlight the MSCDEX.EXE line and press CTRL+ X (to cut), then place the insertion point in
front of the line directly below SMARTDRV.EXE and press CTRL+ V (to paste).

5. Ensure that your CD-ROM drive is MPC-compatible (that is, that the drive can transfer data from the 
CD at 150 K (kilobytes) per second while using less than 40% of the CPU bandwidth, AND that the 
drive has an average seek time of less than one second). Check the documentation that came with 
your CD-ROM drive.

6. Add more RAM to your computer. To determine how much memory is available, start MS-DOS, type 
mem, then press ENTER. This starts a program that will tell you how much memory you have. To run 
Bookshelf you need at least 4 megabytes (sometimes listed as 4096 kilobytes, KB, or K) of RAM, and 
at least 2 MB (megabytes) in the Windows swap file of your hard disk.

7. For complete details on optimizing the performance of Windows, consult your Windows manual.



Troubleshooting: Printing Problems
Printers differ in their abilities to use fonts, graphics, spacing, alignment, and character formats. The 
appearance of your printed document can vary greatly from printer to printer. The way your document 
looks depends on which formats you assign and which formats your printer can print. If you encounter 
problems when printing from Bookshelf, such as no printout, low print quality, or erratic text being printed, 
there are several ways to troubleshoot or correct the problem. The following topics provide basic 
information about solving problems when printing from Microsoft Bookshelf.

Printer Does Not Print at All
Print Quality is Poor
Only Part of a Page Prints
Printing Tips

 If the printer displays a message or an error indicator, see your printer manual for information about how
to correct the problem.



Troubleshooting: Printing - Printer Does Not Print at All
When a printer will not print at all
The cause is often a simple mechanical problem; that is, the printer may be offline, or not connected to 
the computer.
If you cannot print from Bookshelf, try the following steps. Try printing after each step before attempting 
the next one.
1. Check that the printer is plugged in and turned on.
2. Check that the printer is connected to the computer and is online, as shown on the printer's control 

panel.
3. If you cannot print from Bookshelf, but have printed successfully from other programs, check the 

printer settings. To check settings while in Bookshelf, choose Print Article from the File menu, then 
choose the Setup button in the Print dialog box. You can also check printer settings in the Windows 
Program Manager by choosing Main, then Control Panel. In the Control Panel click the Printers icon or
choose Printers from the Settings menu. If the printer you are using is not listed, use the Windows 
Control Panel to install your printer. For additional information about installing a printer, see your 
Windows documentation.

4. Check that the correct port is specified for your printer. You do this in the Windows Program Manager. 
Choose Main, then choose Control Panel. In the Control Panel, click the Printers icon or choose 
Printers from the Settings menu. In the Printers dialog box, choose the Connect button to see which 
port is selected.

5. If you have a serial printer, check that the settings for your serial port are properly selected. You do this
in the Windows Program Manager. Choose Main, then choose Control Panel. In the Control Panel, 
click the Ports icon or choose Ports from the Settings menu.

6. Make sure that you have the correct cable for your printer and that the cable is connected properly.



Troubleshooting: Printing - Print Quality is Poor
If print quality is poor or "garbled"
Try one or more of the following steps to solve this problem. Try printing after each step before attempting
the next one.
1. Try copying the text you wish to print to a word processor such as Microsoft Word for Windows and 

print from that program. Printing from a word-processing program may, in some cases, produce better 
quality than printing directly from Bookshelf.

2. Check the printer in the Print Setup dialog box (choose Print from the File menu, then click Setup). If 
the wrong printer or the wrong font cartridge is selected, the printer may insert stray characters at the 
beginning of lines or behave in other unpredictable ways.

3. If you are using a serial printer, check that the settings for your serial port are properly selected. You do
this in the Windows Program Manager. Choose Main, then choose Control Panel. In the Control Panel,
click the Ports icon or choose Ports from the Settings menu. In the Settings dialog box, make sure the 
baud rate and printer parameters are set according to the manufacturer's specifications. Decreasing 
the baud rate may cause the printer to print correctly.

4. Reset the printer; turn it off and on again.
5. Try reinstalling the printer driver.



Troubleshooting: Printing - Only Part of a Page Prints
If only part of a page prints 
Try one or more of the following solutions:

Laser printers cannot print all the way to the edge of the page (sometimes called the unprintable 
region), so if you have a laser printer, remember to include the figure (usually 0.25 or 0.5 inch) in your 
calculations for page size.

Your printer may not have enough memory to print the entire page. Try printing at a lower 
resolution. 

If you are printing to a serial port and it prints the document but loses blocks of text, you may 
have a handshake problem. 

Try the following steps to solve a handshake problem.
1. Check the baud rate and other printer parameters to make sure they match the manufacturer's 

specifications. You do this in the Windows Program Manager. Choose Main, then choose Control 
Panel. In the Control Panel, click the Ports icon or choose Ports from the Settings menu. In the 
Settings dialog box, make sure the baud rate and printer parameters are correctly set.

2. If you are still losing text, change to a lower baud rate than the one you are using, and try to print 
again.

3. Check all the manual switches on your printer against the settings described in your printer manual 
to make sure the switch settings are correct.

4. Check to make sure you have the proper cable for your printer.



Troubleshooting: Printing - Printing Tips
The following tips may help you with printing problems

Many printers emulate industry-standard printers such as the Epson LQ, IBM Proprinter, or 
Hewlett-Packard LaserJet series. Consult your printer manual to see if your printer supports an emulation.
If it does, install the driver for the printer it emulates in the Control Panel.

If you have purchased a printer model that has not been on the market for very long, your dealer 
or manufacturer may have a Windows printer driver for your printer. 

To use the TTY.DRV printer driver, select Generic/Text Only from the List of Printers in the Setup 
program or choose Printers from the Control Panel. Install this printer as you would any other printer. The 
TTY.DRV printer driver can direct your printer to print underlines, strike through, bold, or to substitute 
underlining for italic and double underlines. It cannot print graphics. For information on installing a printer, 
see your Windows documentation.



Troubleshooting: Video Display Problems
In some situations, Bookshelf may encounter video display problems when using high resolution video 
drivers from various video card manufacturers. This problem can often be fixed by obtaining updated 
drivers from your video card manufacturer. Make sure the video drivers you are using were designed to 
be compatible with Microsoft Windows version 3.1.
An alternative to obtaining a new or updated display driver is to change your video display driver to use 
the generic SVGA driver located on the Bookshelf CD. You can find these drivers in the D:\AAMSSTP\
VIDEO directory (assuming your CD-ROM drive is drive D:)

Users of video cards with S3 chipsets cannot use the generic SVGA driver. You will find drivers 
located in the D:\AAMSSTP\VIDEO directory for your specific version of the S3 video card.
To use these video drivers, create a temporary subdirectory on your hard disk and copy the specific video 
driver you need from the CD to the temporary directory. Once you have copied the file to the hard disk 
you will need to extract the file by typing the name of the file (for example SVGA.EXE). Once the file is 
extracted you can run Windows setup to install the driver.
For instructions on installing the generic SVGA driver, go to the Windows Program Manager, double-click 
the Main icon, then double-click the Windows Setup icon. In the Windows Setup window, click the Help 
menu, then Contents. Read the topic "Add Windows Components."
To obtain updated drivers from your video card manufacturer
Contact the manufacturer of your video card for updated Windows display drivers. Their phone number 
should be in the manuals that came with your video card or personal computer.



Suggestion Box
Suggestions, Enhancements, and Content Errors
If you have suggestions for features you would like to see in future editions of Microsoft Bookshelf please 
contact our Wish line at:

(206) 936-WISH
Internet:    mswish@microsoft.com

If you have comments about errors, comprehensiveness, or validity of information presented, please send
them to:

Bookshelf Program Manager
Consumer Division
Microsoft Corporation
One Microsoft Way
Redmond, WA    98052-6399

Please note that we receive a large number of suggestions and comments regarding Microsoft Bookshelf 
and are unable to respond directly to each one. However, be assured that your recommendations, ideas, 
and remarks are recorded and help shape future versions of Microsoft Bookshelf.



Bookshelf Tips and Tricks
Here are a few tips and tricks for enjoying "the new way to look it up" in Bookshelf '95. Use these tips as 
springboards for your own discoveries. 

Point out ToolTips
Expand the scope of your discoveries
Paste it perfectly
Gather all the facts
Explore a day in history
Broaden your horizons
Use Bookshelf as a "reverse" dictionary
Take good Notes
Spell it right the first time
Find your way back
Learn about YOUR year
Filter your Finds
Click twice for instant definitions
Cross boundaries with QuickShelf
Customize QuickShelf
Focus on the famous
Color your world
Follow the "right" path to fast information
Enjoy the silence
Please the U.S. Postal Service
Exit, stage left



Bookshelf Tips and Tricks
Point out ToolTips
ToolTips are tiny identifying labels that appear when you pause the mouse pointer on icons and buttons. 
Glide the mouse pointer slowly over the Book icons on the Book bar to see their names pop up. On the 
Tabbed Lists, glide the mouse pointer slowly over the icons in front of the article titles to display ToolTips 
that tell you which books the articles are in. If you see an unlabeled button, glide the mouse pointer over it
to display its ToolTips label. If you'd prefer not to see ToolTips, you can turn them off in the Options dialog 
box that displays when you choose Options from the Tools menu.



Bookshelf Tips and Tricks
Expand the scope of your discoveries
The Contents Tab is a great place for locating an article on a specific subject, but if you want to throw your
net really wide, use the Find feature. Say, for example, you have to write a paper on capital punishment. 
You can look up "capital punishment" in the Encyclopedia to see a good article, but don't stop there. Try a 
search on the word "beheaded," and you will come up with a list of articles that mention famous 
beheadings. If you are looking for a historical perspective on capital punishment, open the Chronology 
Find Tab and try a Find on "executed." You will generate a list of executions that goes back thousands of 
years. Use words and phrases from the articles you read to come up with new ideas for using Find.



Bookshelf Tips and Tricks
Paste it perfectly
You can paste text you copy from any Bookshelf article or other application directly into any text box in 
Bookshelf. Simply copy the text to the Clipboard, place the insertion point in the desired text box, then 
press CTRL+ V. If you are pasting into the text box on a Contents Tab or Find Tab, you can also choose 
Paste from the Bookshelf Edit menu.



Bookshelf Tips and Tricks
Gather all the facts
Browse through a treasure-trove of related information in the Almanac. When you open an article in the 
Almanac, you have just grazed the tip of the iceberg of information. Use the >Page and <Page buttons to 
explore related information in the same subject area. For example, if you look up "Bill of Rights" using the 
Almanac Contents Tab, you'll start with a general article about the Bill of Rights. Click the >Page button at
the bottom of the Article window to display the individual amendments in chronological order.



Bookshelf Tips and Tricks
Explore a day in history
Do you want to know what happened on a particular day in history? Use Bookshelf's All Books Find to 
have fun learning about important and unusual events in world history. In the Find text box, type the 
month and day in quotation marks. For example, to find out what happened on January 12th, simply type 
"January 12" (using quotation marks). You will come up with a lengthy list of interesting events that 
occurred on that date, including Captain Cook's historic crossing of the Antarctic Circle in 1773 and the 
first use of electric lights in London in 1882.



Bookshelf Tips and Tricks
Broaden your horizons
Expand your view of the world using the Atlas window. Bookshelf makes it easy for you to see the Atlas 
maps. If a map is too large to fit on the screen you will see horizontal or vertical scroll bars you can use to
see all the parts of the map. To make more room on the screen for a map, you can close the Tabbed Lists
at the left of the screen. (Click any tab to reopen the Tabbed List area.) 



Bookshelf Tips and Tricks
Use Bookshelf as a "reverse" dictionary
You can use Bookshelf as a reverse dictionary for those times when you know what you want to say but 
just can't think of the word. Use the Dictionary's Find feature to simply type in the key concepts relating to 
the word you want to find. For example, say you want to find a word to describe a friend who tends to use 
long words. Simply type "long words" (use quotation marks) in the Find text box. Bookshelf gives you 
"sesquipedalian" and "mouthful"--two words that apply to people who use long words.



Bookshelf Tips and Tricks
Take good Notes
Create a custom list of Bookshelf articles. Use Bookshelf's Note feature (it's on the Edit menu) to make 
your personal list of important articles. Cull articles from all the books in Bookshelf, type in your comments
on them, and add them to your Note list. For example, if you want to gather information on international 
trade, you can look up Encyclopedia articles on business, law, and economics; use the Atlas to locate 
countries that could be potential trading partners; check the Chronology for important historical events by 
year; browse through the Almanac for lists of important awards and economic trends; and search the 
Quotations book for great quotes on business (like, "Making money is art . . . " from Andy Warhol).



Bookshelf Tips and Tricks
Spell it right the first time
If you're not sure how to spell a word you wish to search for, click the Spelling button before you type 
anything in the Contents Tab, Find Tab, or Advanced Find text box in order to display the Spelling dialog 
box. Type the word as best you can, then click Suggest. The Spelling feature will search its dictionary and
offer a list of suggested words from which you can choose. Click a word on the list and it is automatically 
pasted into the text box.



Bookshelf Tips and Tricks
Find your way back
Sometimes, when you jump from article to article, taking advantage of Bookshelf's many pathways into its
information, you may not remember where you found an article that you would like to see again. 
Bookshelf provides several ways to jog your memory. You can open a list of up to 40 articles that you 
have previously viewed by clicking the Back List Tab. Use this list to go back to articles that you want to 
reread. You can also use the Back button at the bottom of the Article Window. This takes you back to 
articles you have already read, one article at a time.



Bookshelf Tips and Tricks
Learn about YOUR year
Use the Chronology Contents Tab to check out significant events that occurred the year you were born. 
Simply type that famous year in the text box to scroll to the articles covering important events in subjects 
ranging from politics, literature, and medicine, to everyday life, food, and sports.



Bookshelf Tips and Tricks
Filter your Finds
Use Advance Find to filter a search in a variety of ways. Say you want information on the circulatory 
system, but you especially need to see an animation or video. Open the Advanced Find dialog box (it's on
the Tools menu), type in "circulatory system," or some other word associated with circulation, such as 
"blood." First click All Articles, then click one or more books you want to look in. Next click the Animation &
Video button. Finally, click Find!. Bookshelf will display of list of only those articles that contain the search 
text AND have an animation or video. 



Bookshelf Tips and Tricks
Click twice for instant definitions
When you're reading an article in Bookshelf, and you are unsure of the meaning of a word, you can 
double-click the word to instantly display its definition from the Bookshelf Dictionary. When you have 
finished reading the definition, just click outside the definition box or click the Close box in the upper-left 
corner of the definitions box to close it and resume reading the article. 



Bookshelf Tips and Tricks
Cross boundaries with QuickShelf
Use QuickShelf to bring Bookshelf's power to your other applications. Here are just a few ways to use 
QuickShelf from other Windows applications:

If you're reading a document and don't know what a word means, just select the word and click 
the Dictionary Contents button on the QuickShelf toolbar. Bookshelf brings you the definition. For fast 
synonyms, select a word and click the Thesaurus Contents button.

If you are writing about a place and you're not quite sure where it's located, select the place 
name, then click the Atlas Contents button to see a map from the Bookshelf Atlas.

If you're writing about a person and want more information, select the name and use QuickShelf. 
Try Quotations Contents to see if he or she has a quotation you can use. Try Almanac Find, Chronology 
Find, or Encyclopedia Find to get a list of all the articles in which your person's name appears--this way 
you can find out if there are awards, dates, and events that are significant in that person's life.



Bookshelf Tips and Tricks
Customize QuickShelf
It's easy to add the books you use the most to the QuickShelf toolbar. Click the down arrow at the right 
end of the QuickShelf toolbar. Choose Customize on the menu, then click the Toolbar Tab. Click to place 
an X next to any Bookshelf book you want to add. You can choose to access a book's Contents Tab, Find 
Tab, or both. When you are finished, click OK. The QuickShelf toolbar now has book buttons for all the 
books you use. Glide the mouse pointer over the books to see their ToolTips labels.



Bookshelf Tips and Tricks
Focus on the famous
Do you admire a famous person in history? Learn more about him or her by using the All Books Find Tab 
to do a full-text search. Type the person's name in the Find Tab text box, then click the Find button to see 
a list of every Bookshelf article in which your hero's name appears. 



Bookshelf Tips and Tricks
Color your world
Change the color of Bookshelf hot text in the Options dialog box (click Options on the Tools menu). You 
can change the color of both jump text and pop-up text. You can also personalize the colors of the 
Bookshelf window by double-clicking the Color icon in the Windows Control Panel.



Bookshelf Tips and Tricks
Follow the "right" path to fast information
When you're reading a Bookshelf article and want more information on the subject in a hurry, you can 
right-click a word to search through any or all of Bookshelf's books. Say you are reading about Niagara 
Falls in the Encyclopedia. You wonder how Niagara Falls compares to other waterfalls in the world. Right-
click the word waterfall to open the shortcut menu. Now click Find in on the menu, then click Almanac. 
The Almanac opens with a list of the world's famous waterfalls and their elevations. Go back to the 
Encyclopedia article and right-click waterfall again. This time search in the Quotations book to see if there
are any memorable quotes on the subject. You will turn up a quotation from the prolific Oscar Wilde. 
Right-click waterfall again and search the Thesaurus for synonyms to make your writing more lively and to
enlarge your search possibilities.



Bookshelf Tips and Tricks
Enjoy the silence
You can turn off Bookshelf's audio pronunciations and/or interface sounds in the Options dialog box (Click
Options on the Tools menu). Simply click the box next to the feature to remove the X and turn off the 
sounds.



Bookshelf Tips and Tricks
Please the U.S. Postal Service
Use Address Builder to locate correct address information for most U.S. locations. Simply type in a known
street address, click Find, and Address Builder displays all city/state/zip code combinations for that street 
address. The city/state/zip code combinations that Address Builder provides for any given street address 
are in accordance with the postal addressing standards of the United States Postal Service. To copy the 
address information from Address Builder into any other application, simply select the correct city/state/zip
code combination from the list, click the Copy Address button or press ENTER, and the address is copied 
to the Clipboard.



Bookshelf Tips and Tricks
Exit, stage left
Just double-click the Control-menu box in the upper-left corner of any window to quickly close it. If the box
in the left corner of a window does not contain a bar, it takes just a single click to close the window. This 
works in Help, too.



Using Help: The Basics
The overview information and step-by-step procedures here in Help teach you how to use Bookshelf. You 
can open and use Help while you work in Bookshelf, or you can print Help topics for future reference 
(from the File menu, choose Print Topic).
To open Help from anywhere in Bookshelf, do one of the following:

Press F1.
On the menu bar, click Help to open the Help menu, then click Help Contents, or press ALT+ H to 

open the Help menu, then press H.
In any dialog box with a Help button, click the Help button or press F1 to display a Help topic 

specific to the task on which you are working.

The basics for navigating in Help are listed below.
In order to Do this
Jump to a related Help topic Click a topic title with colored text 

and a solid underline OR press 
TAB to highlight the topic title, then 
press ENTER.

Display a pop-up description Click a word or phrase with 
colored text and a dotted 
underline OR press TAB to 
highlight the colored text, then 
press ENTER.

Scroll through text Use the scroll bar or press the 
PAGE DOWN key.

Display the Help Table of Contents Choose the Contents button.

Search for a specific Help topic Choose the Search button, type a 
word or select from the list, 
choose Show Topics, select a 
related Help topic, then choose 
Go To.

Go back to the previous Help topic Choose the Back button. 

Use a list of previous topics Choose the History button, then 
choose a Help topic from the list.

Browse back and forth through 
Help topics

Choose the <<   button   or >> 
button.

To close Help, do one of the following:
Double-click the Control-menu box in the upper-left corner of the Help window.
Press ALT+ F4.
Click the Control-menu box to open the menu, then click Close.
Press ALT+ SPACEBAR, then press C.

To get detailed instructions on using the online Help system
1. Open Help to any topic.
2. Click Help on the menu bar, then click How to Use Help.

-Or-
Press ALT+ H, then press H.





jump
To quickly switch from the current Help topic to a new Help topic. In Help, jump text (also called hot text) 
is colored with a solid underline. 



click
To press once and release the left mouse button.



pop-up
A box or window that displays, or "pops up," on your screen with a definition or description of the colored 
word. In Help, pop-up text is colored with a dotted underline. To close this or any other pop-up box, click 
once outside the pop up or press any key. 



choose
Point and click with the mouse or press the appropriate keys on the keyboard to carry out a command. 



Contents button
Located on the button bar near the top of the Help window, this button displays the Help Table of 
Contents. 



Search button
Located on the button bar near the top of the Help window, this button displays the Search feature, which 
is an index of sorts. In the Search dialog box you can either type a search word or phrase or scroll 
through the list of entries in the top box until you find the one you want. Once you have selected an entry, 
choose Show Topics. The bottom box displays all the Help topics related to that word or phrase. Select 
the topic you want to see, then choose Go To (or double-click the topic) to jump to that topic. 



Back button
Located on the button bar near the top of the Help window, this button displays the last Help topic you 
viewed. 



History button
Located on the button bar near the top of the Help window, this button displays a list of the last 40 Help 
topics you viewed. Choose a topic in the list to display that topic again. 



>> button 
Located on the button bar near the top of the Help window, this Browse button allows you to "page" 
forward through Help topics. 



<< button 
Located on the button bar near the top of the Help window, this Browse button allows you to "page" 
backward through Help topics.





How Bookshelf and Word Work Together
G  LOSSARY  

When you install both Microsoft Bookshelf '95 and Word for Windows 6.0, you'll find the two applications 
are integrated for your convenience. You can enjoy the Quote of the Day, Word of the Day, and Word 6.0 
Tip of the Day provided in Bookshelf Daily whenever you start Word, and you can always display the 
Bookshelf Daily window directly from Word by choosing Bookshelf Daily from the View menu located on 
Word's menu bar. In addition, the integration of the two applications allows you to quickly obtain 
definitions for most words in any Word document, as well as easily copy entire articles, or just selected 
text and images, from Bookshelf directly into a new or existing Word document. 
Choose a topic to learn more about Bookshelf-Word integration.

Using Bookshelf Daily
Displaying Definitions for Words in Any Word Document
Copying from Bookshelf Directly into Word



Using Bookshelf Daily
G  LOSSARY  

Every time you start Bookshelf (and Word 6.0 if you have them both installed) you can enjoy the Quote of 
the Day and Word of the Day that Bookshelf Daily provides. The Bookshelf Daily window appears 
automatically every time you start Bookshelf and/or Word 6.0, unless you turn off this option by removing 
the X from the check box at the bottom of the Bookshelf Daily window. The first time Bookshelf Daily 
opens, a randomly selected Quote of the Day is displayed in the window. Use the drop-down list box to 
display the Word of the Day. (When Bookshelf Daily opens in Word, it also has the Word 6.0 Tip of the 
Day.)
To open Bookshelf Daily (if you have closed it or turned off the automatic display option)
 From Bookshelf, choose Bookshelf Daily from the Tools menu.
 From Word, choose Bookshelf Daily from the View menu.

Bookshelf Daily opens with a randomly selected article displayed in the window. The text box above 
the article indicates the article type.

To display a different article type (for example, to display the Word of the Day when Quote of the 
Day is currently displayed)
1. Click the down-arrow button to open the drop-down list.
2. Click the article type you wish to see.

-Or-
Press TAB to highlight the article type, then press ENTER.
A randomly selected article displays in the window.

To view another article of the same type currently displayed
 Click Another.

A new article displays. You can continue clicking Another to see more articles.
To view more articles of the same type currently displayed
 Click More.

Bookshelf opens to the book that contains the article type--i.e., the Dictionary for more Words of the 
Day and the Quotations book for more Quotes of the Day.
If you opened Bookshelf Daily from Word and have a Tip of the Day displayed, clicking More opens a 
Word Help topic containing more Word 6.0 Tips of the Day.

To close Bookshelf Daily, do one of the following:
 Click Close, or if the Close button is highlighted, press ENTER.
 Double-click the Control-menu box on the Bookshelf Daily window.
 Press ESC or ALT+ F4.
 Click the Control-menu box to open the Control menu, then click Close.



Displaying Definitions for Words in Any Word Document
G  LOSSARY  

Bookshelf-Word integration allows you to quickly display the definition(s) for most words in a Word 
document.
To display the definition of a word in a Word document
1. In the Word document, select the word you want defined.
2. Right-click the selected word to display the shortcut menu, then click Define.

-Or-
Choose Define from the View menu.
The definition from the Dictionary displays in a pop-up box.
If the word has more than one definition, the definition box will have a bar with arrow buttons that tells 
you how many definitions exist. Click the arrows to see additional definitions.

To close the definition box, do one of the following:
Click the close button in the upper-left corner of the definition box.
Click anywhere outside the definition box.
Press any key.



Copying from Bookshelf Directly into Word
G  LOSSARY  

You can copy all or part of a Bookshelf article into a Word for Windows document in a single process. 
When Word is open, Bookshelf will paste copied items into any Word document you choose. If Word is 
not open, Bookshelf will open it for you and paste the copied information into a new document.
To copy from Bookshelf directly into Word
1. Open the article containing the information you want to copy. If you want to copy only a portion of the 

article, select the text and/or image.
2. From the Edit menu, choose Copy to Word or press CTRL+ W.

-Or-
Right-click to open the shortcut menu, then click Copy to Word.
The Copy to Word dialog box displays listing all open Word documents. If Word is not open, Bookshelf 
will open it and paste the copied information directly into a new document.

3. Select a Word document from the list. (Be sure the insertion point in the Word document is where you 
want the copied information pasted.)

4. Click Copy.
Bookshelf copies the article or selection, pastes it into the Word document, and closes the dialog box. 
(Click Cancel if you decide not to copy.)

See also
Using the Shortcut Menu to Copy Directly into Word
Keyboard Shortcuts




